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1 Introduction
● Using this guide
● The printer's main features
● The printer's main components
● The front panel
● Printer software

Using this guide
The User's Guide and Quick Reference Guide are organized into the following
chapters.

Introduction
This chapter provides a brief introduction to the printer and its documentation for new
users.

How do I ...
These chapters help you to carry out various procedures such as loading paper or
changing an ink cartridge. Many of these procedures are illustrated with drawings, and
some are also illustrated with animations (in the User's Guide only).

The problem is ...
These chapters help you to solve problems that may occur while printing.

Tell me about ...
Available in the User's Guide only, these chapters contain reference information,
including the specifications of the printer, and the part numbers of paper types, ink
supplies, and other accessories.

Legal information
This chapter contains HP's limited warranty statement, software license agreement,
open source acknowledgments, regulatory notices, and declaration of conformity.

Index
In addition to the table of contents, there is an alphabetical index to help you to find
topics quickly.
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The printer's main features 
Your printer is a color inkjet printer designed for printing high-quality images on paper
up to 42 in (1.06 m) wide. Some major features of the printer are shown below:

● Production speeds of up to 1.5 m²/min (16 ft²/min), using HP Universal InkJet
Bond Paper with the Fast print quality option and the Optimize for Lines and
Text option

● Print resolution of up to 2400×1200 optimized dpi, from a 1200×1200 dpi input,
using the Best print quality option, the Maximum Detail and Optimize for
Images options, and glossy paper (for more information on print resolution, see
Tell me about functional specifications)

● Unattended printing using 400 cm³ ink cartridges and rolls of paper up to 90 m or
300 ft in length (see Tell me about ink cartridges)

● High productivity features such as multi-file job submitting, job previewing,
queueing, and nesting using the printer's Embedded Web Server (see Tell me
about the Embedded Web Server)

● Ink and paper usage information is available from the front panel, and on the Web
from the Embedded Web Server

● Accurate and consistent color reproduction features:
– Press emulations for U.S., European, and Japanese standards; and color

monitor RGB emulations (see Tell me about color emulation modes)
– Automatic color calibration

Chapter 1
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The printer's main components 
The following front and rear views of the printer illustrate the main components.

Front view

1. Ink cartridge
2. Platen
3. Printhead carriage
4. Printhead
5. Printhead cleaner
6. Front panel
7. Spindle
8. Blue removable paper stop
9. Bin
10. Ink cartridge drawer
11. Spindle lever
12. Paper load lever
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Rear view

1. Quick Reference Guide holder
2. Power socket and on/off switch
3. Sockets for communication cables and optional accessories

The front panel
Your printer's front panel is located on the front of the printer, on the right-hand side. It
has the following important functions:

● It must be used to perform certain operations, such as loading and unloading
paper.

● It can display up-to-date information about the status of the printer, the ink
cartridges, the printheads, the paper, the print jobs, etc.

● It can provide guidance in using the printer.
● It displays warning and error messages when appropriate.
● It can be used to change the values of printer settings and thus change the

operation of the printer. However, settings in the printer are overridden by
settings in the Embedded Web Server or in the driver.

Chapter 1

10

In
tr

od
uc

tio
n



The front panel has the following components:

1. The display area, where information, icons, and menus are displayed.
2. The Power key turns the printer on and off. If the printer is in sleep mode, this

key will wake it up.
3. The Power light is off when the printer is off; amber when the printer is in sleep

mode; green when the printer is on; green and flashing when the printer is in
transition between off and on.

4. The Form Feed and Cut key normally ejects the sheet (if a sheet is loaded) or
advances and cuts the roll (if a roll is loaded). However, if the printer is waiting for
more pages to be nested, this key cancels the waiting time and prints the
available pages immediately.

5. The Reset key restarts the printer (as if it were switched off and switched on
again). You will need an implement with a narrow tip to operate the Reset key.

6. The Cancel key cancels the current operation. It is often used to stop printing the
current print job.

7. The Status light is off when the printer is not ready to print: it may be off, or in
sleep mode. It is green when the printer is ready and idle; green and flashing
when the printer is busy; amber when a serious internal error has occurred;
amber and flashing when awaiting human attention.

8. The Up key moves to the previous item in a list, or increases a numerical value.
9. The Select key selects the item that is currently highlighted.
10. The Back key goes back to the previous menu. If you press it repeatedly, or hold

it down, you will soon return to the main menu.
11. The Down key moves to the next item in a list, or decreases a numerical value.

To highlight an item in the front panel, press the Up or Down key until the item is
highlighted.

To select an item in the front panel, first highlight it and then press the Select key.

11
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The four front-panel icons are all found in the main menu. If you need to select or
highlight an icon, and you don't see the icons in the front panel, press the Back key
until you can see them.

When this guide shows a series of front panel items like this: Item1 > Item2 > Item3,
it means that you should select Item1, then select Item2, then select Item3.

Information about specific uses of the front panel can be found throughout this guide.

Printer software 
The following software is provided with your printer:
● The Embedded Web Server, which runs in the printer and enables you to use a

Web browser on any computer to submit and manage print jobs, and check ink
levels and printer status

● The HP-GL/2 and RTL driver for Windows
● The PostScript driver for Windows
● The PostScript driver for Mac OS 9 and Mac OS X
● The ADI driver for AutoCAD 14

Chapter 1
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2 How do I assemble the printer?
● Getting started
● How do I unpack the printer?
● How do I assemble the stand?
● How do I attach the stand to the printer?
● How do I remove packaging materials from the printer?
● How do I assemble the bin?
● How do I switch on the printer for the first time?
● How do I install ink cartridges?
● How do I remove the setup printheads?
● How do I install the printheads?
● How do I install the printhead cleaners?
● How do I load a roll of paper onto the spindle?
● How do I load the paper into the printer?
● How do I connect the printer?
● How do I install accessories?

Getting started 
The following topics describe how to assemble your new printer (also described in the
Setup instructions).

Because some of the components of the printer are bulky, you may need up to four
people to lift them. You will also need at least 3 × 5 m (10 × 16 ft) of empty floor
space, and about two hours.
The symbols on the boxes identify the contents. Refer to the table below:

Symbol on box Contents of box

Printer body

Stand and bin assembly

Consumables box, including ...

 Maintenance Kit (please keep this safe)

Spare box (used while attaching the stand to the
printer)
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How do I unpack the printer? 
Before you start unpacking, consider where you are going to put the assembled
printer. You should allow some clear space at the back and at the front of the printer.
The recommended clearances are shown in the illustration below.

When you have identified a suitable location, you can begin unpacking.

1. Remove the two side lids. Then remove all the upper four plastic handles from
both sides of the box (two each side).

Chapter 2
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2. Cut the strap around the boxes carefully, as the boxes may fall as soon as the
strap is cut.

3. Remove the boxes from the top of the main printer box.

4. Remove all eight plastic handles from both sides of the box.
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5. Remove the main printer box.

6. Remove the two packing pieces.

How do I assemble the stand?
Warning When you are unpacking the leg assembly, you will see that there is
anti-slip material around two of the wheels on the feet. Do not remove this
material yet.

1. Remove the first tray from the stand and bin assembly box.

Chapter 2
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2. From the first tray, remove the two boxes marked with L and R. Place them on
the floor as shown.

3. Lower the cross-brace on to the L and R boxes.

4. You now need to identify which is the left and the right side of the cross-brace.

(1) left (2) right (3) one hole (4) two holes

17
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5. Now you will need the bag of screws and the screwdriver provided. You may
notice that the screwdriver is slightly magnetic.

6. Remove the two leg covers from the left leg.

7. Lower the left leg onto the left side of the cross-brace. The left leg will fit only on
the left side of the cross-brace.

Chapter 2
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8. Fix the left leg to the cross-brace using four screws on the inner side of the leg.

9. Fix the left leg to the cross-brace using two screws on the outer side of the leg.

10. Lower the right leg onto the right side of the cross-brace. The right leg will fit only
on the right side of the cross-brace.
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11. Fix the right leg to the cross-brace using four screws on the inner side of the leg.

12. Fix the right leg to the cross-brace using two screws on the outer side of the leg.

13. Position a foot on the left leg. There are pins to help you to position the foot
correctly.

Note Do not remove the anti-slip material from the wheel.

Chapter 2
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14. Fix the left foot using four screws.

15. Position a foot on the right leg. There are pins to help you to position the foot
correctly.

Note Do not remove the anti-slip material from the wheel.

16. Fix the right foot using four screws.

21

H
ow

 do I assem
ble the printer?



How do I attach the stand to the printer?
1. You now need to identify the left and right of the printer. This information is shown

on the foam end packs. Also identify the rear of the printer.

2. Pull open the protective plastic from the base of the printer. Please ensure that
there is a three-meter space clear of obstructions to the rear of the printer.
Remove the two desiccant bags from the printer.

3. In this step, make sure you position the stand pins in the holes in the center of the
printer body brackets.

Chapter 2
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Lift the stand assembly onto the printer body. The anti-slip material should face to
the rear of the printer.

4. Fix the right side of the stand to the printer using one screw. Make sure that the
screw is fully tightened.

5. Fix the left side of the stand to the printer using two screws. Make sure that the
screws are fully tightened.
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6. Place the spare and consumables boxes against the rear of the printer box. The
arrows on the boxes must point towards the printer box.
Check that the anti-slip material is still fixed to the two rear wheels.

7. Using four people, rotate the printer on to the spare and consumables boxes.

Rotate the printer until its rear rests on the spare and consumables boxes and the
wheels with the anti-slip material touch the floor.

Chapter 2
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8. Remove the pallet before trying to lift the printer into an upright position.

9. Using four people and the hand holds on the rear of the printer body, carefully lift
the printer into an upright position. The anti-slip material should stop the printer
from sliding forwards.
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How do I remove packaging materials from the printer?
1. Remove the two foam end packs and the plastic covering the printer.

2. Position the left leg cover on the front of the left leg (1), then clip the rear edge (2)
into place.

3. Position the right leg cover on the front of the right leg (1), then clip the rear edge
(2) into place.

Chapter 2
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4. Remove the anti-slip material from the two rear wheels on the stand assembly.

5. Remove the packing tapes 1 to 8. Open the printer window and remove the two
window inserts 9 and 10.

6. Remove the protective covering from the printer window and the front panel
screen.
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7. Remove the spindle lock.

8. Open the printhead cleaner door and remove the carriage packing material. Then
close the cleaner door.

9. Press the spindle lever down, which will unseat the right–hand end of the spindle.
Remove that end of the spindle first, and then the left. Do not insert your fingers
into the spindle supports during the removal process.

Chapter 2
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10. Remove the spindle lock foam piece. Then replace the spindle.

11. Install the Quick Reference Guide holder. Angle the holder at the top (1), then
position the two hooks and clip the lower part (2) to the rear of the printer.

How do I assemble the bin?
1. Locate the bin components.
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2. Fix one screw to the inside of the stand’s left leg.

3. Do not fully fit the screw.

4. Fix one screw to the inside of the stand’s right leg.

5. Do not fully fit the screw.

Chapter 2
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6. Lift the supporting framework of the bin into position in front of the printer.

7. Fix the top arms of the bin to the two screws that you have just fitted.

8. Fix the lower arms of the bin to the stand using one screw for each leg.
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9. Now tighten the two top screws.

10. Clip all six loops to the frame of the bin. Locate the loops with rear extensions in
positions 2, 4, and 6.

11. Secure all six loops to the frame, using two clips on each loop.

Chapter 2
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12. Fit all three mobile stoppers to the three loops as indicated.

13. Carefully squeeze the mobile stopper and then fit it onto the loop.

14. When the mobile stopper is engaged with the loop, release your grip.
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15. Move the three mobile stoppers into their parked position. These stoppers are
used only when printing on sheets of paper less than 900 mm in length (up to A1
size).

How do I switch on the printer for the first time?
1. Plug the power cable into the rear of the printer, then plug the other end into the

AC power outlet.

2. Turn the power switch at the rear of the printer to the on position.

Chapter 2
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3. If the power light on the front panel remains off, press the Power key to switch on
the printer.

4. Wait until you see this front panel message. Highlight your language on the front
panel using the Up and Down keys. Press the Select key.

5. The front panel will now display how to install the ink supplies.
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How do I install ink cartridges?
1. Remove the printheads, printhead cleaners, and ink cartridges from the

consumables box.

2. Find the ink cartridge door, which is on the left side of the printer.

3. Press the ink cartridge door until it clicks.
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4. Open the ink cartridge door.

5. To release the ink cartridge drawer, pull the blue handle down.

6. Slide the ink cartridge drawer out.
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7. Place the ink cartridge onto the ink cartridge drawer.

Note There are marks on the drawer showing the correct location.

8. Position the ink cartridge at the rear of the drawer as indicated.

9. Push the ink cartridge drawer back into the printer until it locks into position.

If you have difficulty, see The problem is I cannot insert an ink cartridge.
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10. Install the other three ink cartridges in the same way.

11. Close the ink cartridge door (push it until it clicks shut).

12. Wait (about a minute) until you see this front panel message.
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How do I remove the setup printheads?
1. Open the printer window.

2. Remove the packing tape that is holding down the printhead carriage latch.

3. Pull up and release the latch on top of the carriage.
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4. Lift up the cover. This will give you access to the setup printheads.

5. Before removing the setup printheads, look at the window on top of each one and
check that the printhead contains ink. If it does not, contact your customer service
representative.

6. To remove a setup printhead, lift up the blue handle.
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7. Using the blue handle, gently disengage the setup printhead from the carriage.

8. Lift the setup printhead until it is released from the carriage. Then remove the
other setup printheads.

How do I install the printheads?
1. Remove the blue protective cap and the clear protective tape from the printhead.
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2. Lower all the printheads vertically into their correct positions.

3. Seat the printheads slowly and carefully.

If you have difficulty, see The problem is I cannot insert a printhead.
4. Make sure the printheads are correctly seated. When all the printheads are

installed, the front panel prompts, “Close printhead cover and window”.

5. If Reseat is displayed on the front panel, see The problem is the front panel
keeps telling me to reseat or replace a printhead.
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6. Close the carriage cover.

7. Make sure the latch engages correctly.

8. Close the printer window.

9. Please wait (about a minute) while the printer checks the printheads.
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How do I install the printhead cleaners?
1. Wait until you see this front panel message.

2. Press the printhead cleaner door, which is on the right side of the printer.

3. Open the printhead cleaner door.
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4. Insert the printhead cleaner into the slot of the correct color.

5. Push the printhead cleaner in and down until it clicks into place.

If you have difficulty, see The problem is I cannot insert a printhead cleaner.
6. Insert the other seven printhead cleaners into the correct slots.
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7. Close the printhead cleaner door.

8. Wait until you see this front panel message, then press the Select key.

How do I load a roll of paper onto the spindle?
1. Lower the spindle lever.
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2. Remove the right-hand end of the spindle (1) from the printer, then move it to the
right in order to extract the other end (2). Do not insert your fingers into the
spindle supports during the removal process.

3. Remove the blue paper stop (1) from the left-hand end of the spindle. Keep the
spindle horizontal.

4. Slide the roll of paper that came with your printer onto the spindle. Make sure the
paper is oriented exactly as shown.

Note There is also a label on the spindle showing the correct orientation.
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5. Put the blue paper stop onto the spindle and push it on as far as it will go without
using excessive force.

6. Make sure the stop is seated correctly.

7. With the blue paper stop on the left, slide the spindle into the printer. The blue
spindle lever will drop down automatically as you insert the spindle.
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8. When you meet resistance, lift the blue lever to seat the spindle properly.

9. The spindle lever will be in the horizontal position when the spindle has been
correctly inserted.

How do I load the paper into the printer?
1. At the front panel, highlight the  icon and press the Select key.
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2. Highlight Roll and press the Select key.

3. Highlight Load roll now and press the Select key.

4. Highlight the paper type you have loaded and press the Select key.

5. Wait until you see the 'Open window' message.
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6. Open the printer window.

7. Lift the paper load lever.

8. Pull out approximately 1 m (3 ft) of the roll.
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9. Insert the edge of the roll above the black roller.

Warning Take care not to touch the rubber wheels on the platen while
loading paper: they may rotate and trap skin, hair, or clothing.

10. Wait until the paper emerges from the printer as shown below.

Note If you have an unexpected problem at any stage of the paper
loading process, see The problem is the paper cannot be loaded
successfully.

11. Make sure the paper is aligned with the blue line and half-circle on the platen.
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12. Lower the paper load lever.

13. You should see the front panel message below.

14. Using the stops, carefully wind the excess paper back onto the spindle.

15. Close the printer window.
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16. The printer will adjust the paper by winding it back and forth, after which you can
expect the front panel message below.

17. Using the stops, carefully wind the excess paper back onto the spindle.

18. The printer will automatically perform printhead alignment and a color calibration
for the paper type that you have loaded. During this process the printer will
advance the paper by up to 3 m (≈10 ft) before printing. Please do not try to stop
the paper advance; it is necessary to ensure a successful printhead alignment.
The whole alignment and calibration process will take about twenty minutes;
while it is going on, you can start connecting the printer. See How do I connect
the printer?.
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How do I connect the printer?    
1. Your printer can be connected to a computer directly or to one or more computers

via a network.

(1) PC, Macintosh, or workstation
(2) Printer
(3) Server
(4) PC, Macintosh, or workstation

2. Locate the area at the back of the printer where you can connect the printer to
your computer or network, or install an optional accessory.

3. A Fast Ethernet socket is provided for connection to a network.
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4. Two FireWire sockets are provided for direct connection to computers.

Note A FireWire cable is not provided with the printer. Any cable
recommended by the 1394 Trade Association may be used.

5. A larger socket is provided to connect an optional accessory.

Caution Do not attempt to use this socket for any other purpose.

6. Pass the network cable through the hook at the rear of the printer.
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How do I install accessories?  
There are various optional accessories that you can buy and install at any time during
the life of your printer. The physical installation of each accessory is graphically
illustrated on the poster provided with the accessory (except in the case of the
Jetdirect print server; see below). Here are some further steps to follow after
completing the physical installation process.

Gigabit Ethernet socket  
To check that the Gigabit Ethernet socket has been correctly installed, go to the front
panel and select the  icon, then I/O setup > Gigabit Ethernet.

The front panel will reveal whether the socket is Installed or Not installed.

Please follow the appropriate instructions to connect the printer to your network:

● How do I connect my printer to a network (Windows)?
● How do I connect my printer to a network (Mac OS X)?
● How do I connect my printer to a network (Mac OS 9)?

You can plug in your network cable as illustrated below.
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USB 2.0 socket 
To check that the USB 2.0 socket has been correctly installed, go to the front panel
and select the  icon, then I/O setup > USB.

The front panel will reveal whether the socket is Installed or Not installed.

Please follow the appropriate instructions to connect the printer to your computer:
● How do I connect my printer directly to a computer (Windows)?
● How do I connect my printer directly to a computer (Mac OS X)?
● How do I connect my printer directly to a computer (Mac OS 9)?

You can plug in your USB cable as illustrated below.
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Jetdirect print server  
To install the Jetdirect card:

1. Go to the rear of the printer and remove a small cover plate secured by two
screws near the left-hand side.
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2. Insert the Jetdirect card and secure it with the screws that accompany the card.

3. Save the cover plate and screws in case you decide to remove the Jetdirect card
later.

To check that the card has been correctly installed, go to the front panel and select
the  icon, then I/O setup > Jetdirect EIO.

The front panel will reveal whether the print server is Installed or Not installed.

Please follow the appropriate instructions to connect the printer to your network:

● How do I connect my printer to a network (Windows)?
● How do I connect my printer to a network (Mac OS X)?
● How do I connect my printer to a network (Mac OS 9)?
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You can plug in your network cable as illustrated below.

Memory expansion card  
To check that the 256 MB memory expansion card has been correctly installed, go to
the front panel and select the  icon, then Information > Show printer
information. The front panel will display various items of information about the
printer, including Memory size (MB).

If the memory size is now shown as 512 MB, your memory expansion card has been
correctly installed.
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3 How do I set up my printer
software?
● How do I choose which connection method to use?
● How do I connect my printer to a network (Windows)?
● How do I connect my printer to a network (Mac OS X)?
● How do I connect my printer to a network (Mac OS 9)?
● How do I connect my printer directly to a computer (Windows)?
● How do I connect my printer directly to a computer (Mac OS X)?
● How do I connect my printer directly to a computer (Mac OS 9)?
● How do I uninstall the printer driver (Windows)?
● How do I uninstall the printer driver (Mac OS 9)?

How do I choose which connection method to use?   
The following methods can be used to connect your printer.

Connection type Speed Cable length Other factors

Fast Ethernet Fast; varies
according to
network traffic

Long (100 m=328
ft.)

Requires extra
equipment
(switches).

Gigabit Ethernet
(optional
accessory)

Very fast; varies
according to
network traffic

Long (100 m=328
ft.)

Requires extra
equipment
(switches).

Jetdirect print
server (optional
accessory)

Moderate; varies
according to
network traffic

Long (100 m=328
ft.)

Requires extra
equipment
(switches).

Useful for wireless
or AppleTalk
connection, and
for Novell printing.

FireWire Very fast Short (4.5 m=15 ft.)

USB 2.0 (optional
accessory)

Very fast Short (5 m=16 ft.)

Note 1 The speed of any network connection depends on all components
used in the network, which may include network interface cards, hubs, routers,
switches, and cables. If any one of these components is not capable of high-
speed operation, you will find that you have a low-speed connection. The
speed of your network connection can also be affected by the total amount of
traffic from other devices on the network.

Note 2 The Gigabit Ethernet and USB 2.0 accessories are installed in the
same slot in the printer, so they cannot both be installed at the same time. This
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does not affect the Jetdirect print server accessory, which is installed
elsewhere.

Note 3 There are various possible ways of connecting the printer to a
network, but only one of them can be active at a time; with the exception of the
Jetdirect print server, which can be active at the same time as one other
network connection.

How do I connect my printer to a network (Windows)? 
In order to set up a network connection, you must configure the IP address of your
printer. There are two cases, depending on the kind of IP address configuration on
your network. You need only to follow the steps of the case that applies to your
network architecture:

● Automatic IP address configuration: the printer obtains an IP address automatically
● Manual IP address configuration: you need to enter an IP address manually

Automatic IP address configuration
In this case, once the network cable is connected and the printer is powered up, it
automatically takes an IP address. You need to get this value and perform the
following steps to configure the printer in the network:

1. Go to the front panel and select the  icon, then I/O setup > Fast Ethernet (or
Gigabit Ethernet) > Show configuration.

2. The front panel will display some information, including the printer's IP address.
Make a note of the IP address.

3. Insert the Printer Software Setup for Windows CD into your computer.
4. Choose the language.
5. Read the information in the Welcome dialog and click Next.
6. Read and accept the license agreement.
7. Choose Connected via the network.
8. Choose Basic network setup for a PC or server.
9. Wait while the configuration program looks for printers connected to your

network. When the search has finished, a list of printers will be displayed. Identify
your printer by its IP address, select it from the list, and click Next.

10. Wait while the configuration program analyzes the network and the printer. The
program will detect the network settings and will suggest the settings to be used
when configuring the printer. Normally, it is not necessary to change any of these
settings, so click Next.
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11. Choose your printer model and click Next.
12. Continue following instructions on the screen until the installation is complete.

Manual IP address configuration
In this case, there is no IP address at the moment of starting the installation. The
installation process will consist of detecting the printer, configuring its IP address, and
installing the driver with these settings. Perform the following steps:

1. Go to the front panel and select the  icon, then I/O setup > Fast Ethernet (or
Gigabit Ethernet) > Show configuration.

2. The front panel will display some information, including the printer's MAC
address. Make a note of the MAC address.

3. Insert the Printer Software Setup for Windows CD into your computer.
4. Choose the language.
5. Read the information in the Welcome dialog and click Next.
6. Read and accept the license agreement.
7. Choose Connected via the network.
8. Choose Basic network setup for a PC or server.
9. Wait while the configuration program looks for printers connected to your

network. When the search has finished, a list of printers will be displayed. Identify
your printer by its MAC address, select it from the list, and click Next.

10. Wait while the configuration program analyzes the network and the printer. As
there are no TCP/IP parameters configured, the program will ask you to enter the
IP address, the subnet mask, and the gateway. Enter these values according to
your network configuration and take care, when choosing the IP address and the
subnet mask, that you select values that will not create conflicts with the current
network devices. It is recommended that you get these values from your network
administrator.

11. Choose your printer model and click Next.
12. At the end of the installation, you will have drivers configured to work with your

printer and your printer will have a valid IP address. You can see this IP address
on the front panel when you select the  icon, then I/O setup > Fast Ethernet
(or Gigabit Ethernet) > Show configuration.
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How do I connect my printer to a network (Mac OS X)? 
You can connect your printer to a network under Mac OS X using the following
methods:

● Rendezvous
● AppleTalk
● TCP/IP

Note The Printer Setup Utility was known as the Print Center in versions of
Mac OS X earlier than 10.3.

Using Rendezvous
Before you begin, make sure the following are true:

● The printer is set up and on.
● The Ethernet hub or router is on and functioning properly.
● All computers on the network are on and connected to the network.
● The printer is connected to the network.
● The printer drivers are installed. To install the drivers, insert the drivers CD and

follow the instructions on the screen.

To connect your printer using Rendezvous:

1. Go to the front panel, select the  icon, and then I/O setup > Fast Ethernet (or
Gigabit Ethernet, if you are using that option) > Show configuration. Note the
mDNS service name of your printer, as shown on the front panel. You may need
it later on.

2. Open the Printer Setup Utility by selecting the Finder icon on your desktop. Click
the Applications icon in the top right corner of the Finder window, then select
Utilities from the list. Select Printer Setup Utility from the Utilities list.

3. Click the Add button. The Add Printer dialog is displayed.
4. Select Rendezvous from the popup menu.
5. Click on the name of the printer. If you cannot identify the printer by its name, use

the mDNS Service Name that you noted earlier.
6. The connection is configured automatically, and the printer is now available on

the network.

Using AppleTalk

Note AppleTalk is supported only with the optional Jetdirect print server.

Before you begin, make sure the following are true:

● The printer is set up and on.
● The Ethernet hub or router is on and functioning properly.
● All computers on the network are on and connected to the network.
● The printer is connected to the network.
● The printer drivers are installed. To install the drivers, insert the drivers CD and

follow the instructions on the screen.
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To connect your printer using AppleTalk:

1. Go to the front panel and select the  icon, then I/O setup > Jetdirect EIO >
Show configuration.

2. The front panel will display some information, including the printer's Appletalk
name. Make a note of the Appletalk name.

3. Make sure that the AppleTalk protocol is active by double-clicking the System
preference icon on the Dock menu bar and selecting Network. Select Built-in
Ethernet as well as AppleTalk from the Show menu to confirm that AppleTalk is
active.

4. Open the Printer Setup Utility by selecting the Finder icon on your desktop. Click
the Applications icon in the top right corner of the Finder window, then select
Utilities from the list. Select Printer Setup Utility from the Utilities list.

5. In the Printer List, click the Add button to add a printer. The Add Printer List
dialog box is displayed.

6. Select AppleTalk from the pop-up menu. Select the Appletalk zone.
7. Click the Create button, and select the printer from the list. You may need the

AppleTalk name that you noted in step 2.
8. Click the Add button and close the Printer Setup Utility.

Using TCP/IP
Before you begin, make sure the following are true:

● The printer is set up and on.
● The Ethernet hub or router is on and functioning properly.
● All computers on the network are on and connected to the network.
● The printer is connected to the network.
● The printer drivers are installed. To install the drivers, insert the drivers CD and

follow the instructions on the screen.

To connect your printer using TCP/IP:

1. Go to the front panel and select the  icon, then I/O setup > Fast Ethernet (or
Gigabit Ethernet) > Show configuration.

2. The front panel will display some information, including the printer's IP address.
Make a note of the IP address.

3. Open the Printer Setup Utility by selecting the Finder icon on your desktop. Click
the Applications icon in the top right corner of the Finder window, then select
Utilities from the list. Select Printer Setup Utility from the Utilities list.

4. Click the Add button. The Add Printer List dialog box is displayed.
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5. Select IP Printing from the popup menu.
6. Type the printer's IP address (which you noted in step 2) into the Printer Address

field.
7. Select the HP Designjet 4000 PS3 PostScript Printer Description (PPD) file.
8. In the Printer Model field, select HP and then HP Designjet 4000ps.
9. Click the Add button. Close the Printer Setup Utility.

How do I connect my printer to a network (Mac OS 9)? 
You can connect your printer to a network under Mac OS 9 using the following
methods:

● TCP/IP
● AppleTalk

Using TCP/IP
Before you begin, make sure that your printer is switched on and connected to the
network.

To connect your printer using TCP/IP:

1. Go to the front panel and select the  icon, then I/O setup > Fast Ethernet (or
Gigabit Ethernet) > Show configuration.

2. The front panel will display some information, including the printer's IP address.
Make a note of the IP address.

3. Go to your computer and open the Desktop Printer Utility located in the HP
Designjet 4000ps folder on the hard disk.

4. Choose the AdobePS driver and the Printer (LPR) connection. Click OK.
5. Use the first Change button to select the HP Designjet 4000 PS3 PostScript

Printer Description (PPD) file.
6. Use the second Change button to enter the printer's IP address into the Printer

Address field. Click Verify and then OK.
7. Check that your changes appear correctly on the screen, then click Create.
8. Click Save to save your new printer setup on the Desktop.

Using AppleTalk

Note AppleTalk is supported only with the optional Jetdirect print server.
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Before you begin, make sure that your printer is switched on and connected to the
network.

To connect your printer using AppleTalk:
1. Go to the front panel, select the  icon, and then I/O setup > Jetdirect EIO >

Show configuration. Note the AppleTalk name of your printer, as shown on the
front panel. You may need it later on.

2. Select Chooser from the Apple menu.
3. Click the Adobe PostScript driver icon.

4. In the AppleTalk Zones list, select the AppleTalk zone where your printer is
located (if it exists). Make sure that the AppleTalk protocol is Active.

5. The Chooser will check all the printers that are connected by AppleTalk in your
zone.

6. Select your printer. If you have several similar printers, you can identify the
correct one by its AppleTalk name.

7. Click the Create button in the Chooser to set up the printer.
8. The type of printer is selected automatically. A new printer icon will appear on

your desktop.
9. Close the Chooser. An icon will appear on your desktop.

How do I connect my printer directly to a computer
(Windows)? 

You can connect your printer directly to a computer without going through a network,
by using the printer's built-in FireWire socket (supported under Windows 2000, XP,
and 2003 Server) or the optional USB 2.0 socket (supported under Windows 98 SE,
Me, 2000, XP, and 2003 Server).

1. Do not connect the computer to the printer yet. You must first install the
printer driver software on the computer, as follows.

2. Insert the Printer Software Setup for Windows CD into your CD drive. If the CD
does not autorun, run the SETUP.EXE program in the root folder of the CD.

3. Follow the instructions that appear on your screen.
4. When asked how the printer is connected, choose Connected directly to this

computer.
5. Choose your connection method and click Next.
6. Choose your printer model and click Next.
7. When prompted to do so, connect your computer to the printer, using a FireWire

or USB cable. Ensure that the printer is switched on. When the printer software
has detected the printer, the installation process will be completed automatically.
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How do I connect my printer directly to a computer (Mac
OS X)? 

You can connect your printer directly to a computer without going through a network,
by using the printer's built-in FireWire socket or the optional USB 2.0 socket.

1. Make sure the printer is powered off.
2. Insert the Software Setup CD into your CD drive.
3. In Finder, navigate to the CD.
4. Double-click on OS X HP DJ 4000ps Install to launch the installer.
5. The installer takes you through various steps until you reach the main install

dialog box.
6. Click the Install button.
7. The printer driver installs and a status bar is displayed. Follow any instructions

given by the installer, then quit the installer when the installation is complete.

Connecting with FireWire
1. Connect the FireWire cable between your printer and the computer.
2. Power on the printer.
3. Open the Printer Setup Utility by selecting the Finder icon on your desktop. Click

the Applications icon in the top right corner of the Finder window, then select
Utilities from the list. Select Printer Setup Utility from the Utilities list.

4. Click the Add button. The Add Printer dialog is displayed.
5. Select HP FireWire from the popup menu.
6. Click the name of the printer.
7. Click the Add button.

Connecting with USB
1. Connect the USB cable between your printer and the computer.
2. Power on the printer.
3. Open the Printer Setup Utility by selecting the Finder icon on your desktop. Click

the Applications icon in the top right corner of the Finder window, then select
Utilities from the list. Select Printer Setup Utility from the Utilities list.

4. The printer icon is automatically added to the list of available printers.

Note Under Mac OS X 10.2 only, the new printer appears as a Generic
printer. To correct this, first delete the Generic printer icon. Then click the Add
button, select USB from the popup menu in the Add Printer dialog, select the
name of your printer, and click the Add button.

Sharing the printer

Note Printer sharing between users is supported under Mac OS X 10.2.x and
10.3.

If your computer is connected to a network, you can make your directly-connected
printer available to other computers on the same network.

1. Double-click the System Preferences icon in the Dock menu bar on your desktop.
2. Enable printer sharing by going to Sharing > Services > Printer Sharing.
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3. From the client computer, the printer will now be displayed in the list of available
printers in the Printer Setup Utility.

How do I connect my printer directly to a computer (Mac
OS 9)? 

You can connect your printer directly to a computer without going through a network,
by using the optional USB 2.0 socket.

1. Make sure the printer is powered off.
2. Insert the Software Setup CD into your CD drive.
3. In Finder, navigate to the CD.
4. Double-click on OS 9 HP DJ 4000ps Install to launch the installer.
5. The installer takes you through various steps until you reach the main install

dialog box. We recommend that you choose the Easy install option.
6. Click the Install button.
7. The printer driver installs and a status bar is displayed.
8. Click Restart to restart the computer.
9. Connect the USB cable between your printer and the computer.
10. Power on the printer.
11. Run the Desktop Printer Utility in the HP Designjet 4000ps folder.
12. Choose the AdobePS driver and the USB connection.
13. Click the Change button in the USB Printer Selection section to select the printer.
14. Click the Auto Setup button to set up the printer automatically. You can click the

Change button to select the PostScript Printer Description (PPD) file.
15. Once you have selected the correct PPD file, click the Create button to save the

desktop printer.

Sharing the printer
If you have Mac OS 9.1 or later, and your computer is connected to a network through
TCP/IP, you can make your directly-connected printer available to other computers on
the same network.

1. In the Apple menu, go to Control Panels > USB Printer Sharing.
2. Click the Start button.
3. Click the My Printers tab. The printer will be displayed. Check the box next to the

printer name to enable sharing.
4. To connect to the printer from another Macintosh, first install the printer driver

software: insert the drivers CD and follow the instructions on the screen.
5. In the Apple menu, go to Control Panels > USB Sharing.
6. Click the Network Printers tab. You will see a list of shared printers.
7. If your printer is in the list, click the Use checkbox next to the printer's name.

If your printer is not in the list, click the Add button, open the neighborhood where
the printer is shared, and choose the printer.

8. Run the Desktop Printer Utility in the HP Designjet 4000ps folder.
9. Choose the AdobePS driver and the USB connection.
10. Click the Change button in the USB Printer Selection section to select the printer.
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11. Click the Auto Setup button to set up the printer automatically. You can click the
Change button to select the PostScript Printer Description (PPD) file.

12. Once you have selected the correct PPD file, click the Create button to save the
desktop printer.

How do I uninstall the printer driver (Windows)?   
1. Insert the Printer Software Setup for Windows CD into your CD drive. If the CD

does not autorun, run the SETUP.EXE program in the root folder of the CD.
2. Follow the instructions on your screen to uninstall the printer driver.

How do I uninstall the printer driver (Mac OS 9)?   
1. Insert the Software Setup CD into your CD drive.
2. In Finder, navigate to the CD.
3. Double-click on OS 9 HP DJ 4000ps Install to launch the installer.
4. The installer takes you through various steps until you reach the main install

dialog box. You have two options:
– Easy install
– Uninstall driver
Choose Uninstall driver.

5. The printer driver uninstalls and a status bar is displayed. Quit the installer when
the uninstallation is complete.
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4 How do I operate the printer?
● How do I switch the printer on and off?
● How do I restart the printer?
● How do I change the language of the front panel?
● How do I access the Embedded Web Server?
● How do I change the language of the Embedded Web Server?
● How do I password–protect the Embedded Web Server?
● How do I request e-mail notification of specific error conditions?
● How do I change the sleep mode setting?
● How do I turn off the buzzer?
● How do I change the front panel contrast?
● How do I change the units of measurement?
● How do I adjust for altitude?

How do I switch the printer on and off?
The normal and recommended way to switch the printer on and off is to use the
Power key on the front panel.

When you switch off the printer this way, the printheads are automatically stored with
the printhead cleaners, which prevents them from drying out.

If you are not planning to use the printer for a long time (for instance, a day or more),
you are recommended to switch it off using the Power key, and then also switch off
the power switch at the rear.
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To switch it back on later, use the power switch at the rear, and then the Power key.
When the printer has not been used for a certain period of time (30 minutes by
default), it will save power by going into sleep mode. However, any interaction with the
printer will return it to active mode, and it can resume printing immediately.

How do I restart the printer?
In some circumstances you may be advised to restart the printer. Please proceed as
follows:

1. Press the Power key on the front panel to switch the printer off, wait a few
moments, then press the Power key again. This should cause the printer to
restart; if not, continue with step 2.

2. Use the Reset key on the front panel. You will need an implement with a narrow
tip to operate the Reset key. This normally has the same effect as step 1 above,
but may work if step 1 does not.

3. If neither of the above steps seem to have any effect, you should switch off the
printer using the power switch at the rear of the printer.

4. Remove the power cord from the power socket.
5. Wait for 10 seconds.
6. Insert the power cord into the power socket and switch on the printer using the

power switch.
7. Check that the Power light on the front panel comes on. If it does not, use the

Power key to switch the printer on.

How do I change the language of the front panel?   
To change the language of the front-panel menus and messages, start with the printer
powered off.

1. At the front panel, press the Select key and hold it down.
2. While holding the Select key down, press the Power key and hold it down.
3. Continue to hold down both keys until the green light on the left side of the front

panel starts flashing. You can expect a delay of about one second. If the green
light starts flashing without any delay, you may need to start again.

4. Release the Select and Power keys.
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The language selection menu should now appear on the front panel.

How do I access the Embedded Web Server?   
The Embedded Web Server enables you to manage your printer and your printing
jobs remotely using an ordinary Web browser running on any computer.

Note In order to use the Embedded Web Server, you must have a TCP/IP
connection to your printer. If you have an Appletalk, Novell, or USB connection
to your printer, you will not be able to use the Embedded Web Server.

The following browsers are known to be compatible with the Embedded Web Server:

● Internet Explorer 5.5 or later, for Windows.
● Internet Explorer 5.2.1 or later, for Mac OS 9.
● Internet Explorer 5.1 or later, for Mac OS X.
● Netscape Navigator 6.01 or later.
● Mozilla 1.5 or later.
● Safari.

There are several ways to access the Embedded Web Server:

● On any computer, open your Web browser and give the address of your printer.
You can find out the address of your printer (starting with http:) from the front
panel, by highlighting the  icon.

● Select Status of my printer, Check media available, or Manage my printer's
queue from the Services tab of your Windows printer driver, or from the Services
panel of your Mac OS printer driver.

● On a computer running Windows with your printer software installed, double–click
the Printer Access Utility icon on your desktop, then select your printer.

If you have followed these instructions but failed to get through to the Embedded Web
Server, see The problem is I cannot access the Embedded Web Server from my
browser.

Using IP over FireWire with Mac OS X 10.3
If you are using Mac OS X 10.3 and have a FireWire connection to your printer, it is
possible to set up an IP address for the printer in order to use the Embedded Web
Server. To do this:

1. Open System Preferences and click Network.
2. Choose Network Port Configurations from the Show pop-up menu.
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3. Click New, and then choose FireWire from the Port pop-up menu. You can give
the new port configuration a name, FireWire.

4. Drag the port configuration to the top of the Port Configuration list. This ensures
that the port is assigned an IP address.

5. Click Apply Now.

If you don't drag the FireWire port configuration to the top of the Port Configuration
list, you need to choose Manually (or DHCP with manual address) from the
Configure IPv4 pop-up menu, and then enter an IP address. See
http://www.apple.com/ for more detail or updated information on activating IP over
FireWire.

When the printer is connected through FireWire, we recommend adding the printer
using the FireWire modules in order to take full advantage of FireWire printing, and to
use the IP over FireWire only to visit the printer’s Embedded Web Server.

If you connect your printer through FireWire and the printer is also connected to the
network through Fast Ethernet or Gigabit Ethernet, the printer’s IP over FireWire will
not be available and you will not be able to access the Embedded Web Server from
the Printer Dialog. However, you will be able to print through FireWire.

Also in the case of printer sharing over FireWire, remote users will not be able to
access the Embedded Web Server from the Printer Dialog, although they will be able
to print.

How do I change the language of the Embedded Web
Server? 

The Embedded Web Server can work in the following languages: English,
Portuguese, Spanish, French, Italian, German, Simplified Chinese, Traditional
Chinese, Korean, and Japanese. It will choose whichever language you have
specified in your Web browser's options. If you have specified a language that it
cannot support, it will work in English.

To change the language, you must change your Web browser's language setting. For
example, in Internet Explorer version 6, go to the Tools menu and select Internet
Options, Languages. Then ensure that the language you want is at the top of the list
in the dialog box.

How do I password–protect the Embedded Web Server?   
1. In the Embedded Web Server, go to the Security page, which you can find in the

Settings tab.
2. Enter a password of your own choice in the New password field.
3. Enter it again in the Confirm password field to guard against misspelling.
4. Click Set password.

Now no-one will be able to perform the following actions with the Embedded Web
Server without giving the password:

● Manage print jobs in the queue (cancel, delete)
● View previews of print jobs
● Delete stored jobs
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● Clear accounting information
● Update the printer's firmware

Note If you forget the password, see The problem is I cannot access the
Embedded Web Server from my browser.

How do I request e-mail notification of specific error
conditions?  

1. In the Embedded Web Server, go to the E-mail server page, which you can find in
the Settings Tab, and ensure that the following fields are correctly filled in:
– SMTP server: the IP address of the outgoing mail server (SMTP) that will

process all e-mail messages from the printer. If the mail server requires
authentication, e-mail notifications will not work.

– Printer e-mail address: each e-mail message sent by the printer must
include a return address, which does not need to be a real, functional e-mail
address, but it should be unique, so that recipients of the message can
identify the printer that sent it.

2. Go to the Notification page, which is also in the Settings tab.
3. Click New to request new notifications (or Edit to edit notifications that have

already been set up). Then fill in the e-mail addresses to which notifications
should be sent, and select the incidents that should result in notification
messages. Initially the most commonly-specified incidents are shown; to see all
the possibilities, click Show all alerts.

How do I change the sleep mode setting?
If the printer is left switched on but unused for a certain period of time, it will go
automatically into sleep mode to save power. To change the time the printer waits
before it goes into sleep mode, go to the front panel and select the  icon, then
Configuration menu > Sleep mode wait time.

How do I turn off the buzzer?
To turn the printer's buzzer on or off, go to the front panel and select the  icon, then
Configuration menu > Buzzer.

How do I change the front panel contrast?   
To change the contrast of the front panel display, select the  icon, then
Configuration menu > Display contrast, and choose a value using the Up or Down
key. Press the Select key to set the value you have chosen.

How do I change the units of measurement?  
To change the units of measurement displayed in the front panel, select the  icon,
then Configuration menu > Unit selection, and select English or Metric.
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How do I adjust for altitude?
Your printer will work better if you tell it roughly at what altitude it is. To set the
altitude, go to the front panel and select the  icon, then Configuration menu >
Altitude, and select a range.
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5 How do I handle paper?
● How do I load a roll onto the spindle?
● How do I load a roll into the printer?
● How do I unload a roll from the printer?
● How do I load a single sheet?
● How do I unload a single sheet?
● How do I select supported paper types?
● How do I view information about the paper?
● How do I download media profiles?
● How do I use non-HP paper?
● How do I cancel the drying time?
● How do I change the drying time?

How do I load a roll onto the spindle?   
1. Make sure the printer wheels are locked (the brake lever is pressed down) to

prevent the printer from moving.
2. Lower the spindle lever.

3. Remove the right-hand end of the spindle (1) from the printer, then move it to the
right in order to extract the other end (2). Do not insert your fingers into the
spindle supports during the removal process.
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The spindle has a stop at each end to keep the roll in position. The stop at the left-
hand end can be removed to mount a new roll, it slides along the spindle to hold
rolls of different widths.

4. Remove the blue paper stop (1) from the left-hand end of the spindle.

5. If your roll has a three-inch cardboard core, ensure that the core adaptors
supplied with the printer have been installed. See below:

6. The roll may be very long; rest the spindle horizontally on a table and load the roll
on the table. Bear in mind that you may need two people to handle it.

7. Slide the new roll onto the spindle. Make sure the paper type is oriented as
shown. If it is not, remove the roll, turn it 180 degrees and slide it back on to the
spindle.

Note There is also a label on the spindle showing the correct orientation.
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8. Put the blue paper stop on to the upper end of the spindle, and push it towards
the end of the roll.

9. Ensure the blue paper stop is pushed in as far as it will go, without using
excessive force.
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10. With the blue paper stop on the left, slide the spindle into the printer left and then
right as shown by the arrows 1 and 2.

11. To make sure that the right end of the spindle is in place, check that the spindle
lever is in its top position (horizontal). You can move the lever yourself if
necessary.

If you are a regular user of different paper types, you can change rolls more quickly if
you pre-load rolls of different paper types on different spindles. Extra spindles are
available for purchase.
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How do I load a roll into the printer?   
Note To start this procedure you need to have a roll loaded on the spindle.
See How do I load a roll onto the spindle?.

1. At the printer's front panel, select the  icon, then Roll > Load roll now.

2. The front panel displays a list of paper types.

3. Select the paper type you are using. If it is not clear which you should select, see
How do I select supported paper types?.

4. Wait until the front panel prompts you to open the window.
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5. Lift the paper load lever.

6. Pull out approximately 1 m (3 ft.) of paper.
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7. Carefully insert the leading edge of the roll above the black roller.

Warning 1 Take care not to touch the rubber wheels on the platen while
loading paper: they may rotate and trap skin, hair, or clothing.

Warning 2 Take care not to push your fingers inside the printer's paper
path. It is not designed to accommodate fingers, and the results may be
painful.

8. Wait until the paper emerges from the printer as shown below.

Note If you have an unexpected problem at any stage of the paper
loading process, see The problem is the paper cannot be loaded
successfully.
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9. Align the right-hand edge of the paper with the blue line and the left edge of the
half-circle on the right of the platen.

10. When the paper is correctly aligned with the blue line and half-circle, lower the
paper load lever.

11. The front panel prompts you to wind excess paper onto the roll.
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12. Wind the excess paper onto the roll. Use the paper stop to turn the roll in the
direction shown.

13. Lower the window.
14. The front panel again prompts you to wind excess paper onto the roll.

15. The printer will perform a color calibration, if it has not already calibrated the
paper type you are using, and if color calibration is turned on. See How do I
perform color calibration?.

16. The front panel displays the Ready message and the printer is ready to print.
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How do I unload a roll from the printer?   
If there is more than 30 cm of paper remaining of the roll, use the following procedure.

1. At the printer's front panel, select the  icon, then Unload paper now.
2. The paper will normally be removed from the printer.

If the paper is not automatically removed from the printer, the front panel will
prompt you to lift the paper load lever and turn the paper stop (1) by hand until
the paper is removed from the printer. When you have finished, lower the paper
load lever.

3. Turn the paper stop (1) by hand, until the paper is fully wound onto the roll.
4. Press the Select key.
5. Press the spindle lever (2) down and remove the roll from the printer, pulling out

the right-hand end first. Do not insert your fingers into the spindle supports during
the removal process.

If there is less than 30 cm remaining of the roll, use the following procedure:

1. If you have already selected Unload paper now at the front panel, press the
Cancel key to cancel that procedure.

2. Ensure that the paper load lever is in the down position, and press the Form
Feed and Cut key twice (or until the paper advances).

3. Raise the paper load lever and pull the paper out manually.
4. Press the spindle lever (2) down and remove the empty spindle from the printer,

pulling out the right-hand end first. Do not insert your fingers into the spindle
supports during the removal process.
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How do I load a single sheet?  
Any loaded roll must be unloaded before loading a sheet. See How do I unload a roll
from the printer?.

1. At the printer's front panel, select the  icon, then Sheet > Load sheet now.

Note As usual, you must press the Select key to select this option.

2. The front panel displays a list of paper types.

3. Select the paper type you are using. If it is not clear which you should select, see
How do I select supported paper types?.
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4. Wait until the front panel prompts you to open the window.

5. Lift the paper load lever.

6. Insert the sheet into the printer as shown below.
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7. Insert the sheet until it reappears from the printer as shown below.

Warning 1 Take care not to touch the rubber wheels on the platen while
loading paper: they may rotate and trap skin, hair or clothing.

Warning 2 Take care not to push your fingers inside the printer's paper
path. It is not designed to accommodate fingers, and the results may be
painful.

8. Pull the sheet out from the top.

91

H
ow

 do I handle paper?



9. Align the leading edge of the sheet with the metal bar in the platen.
Align the right-hand edge of the sheet with the left edge of the half-circle on the
platen, as shown below.

10. Lower the window.
11. Lower the paper load lever.

12. If the paper has been loaded successfully, the front panel displays the Ready
message and the printer is ready to print. If something has gone wrong (paper
mispositioned or misaligned), follow the instructions on the front panel.
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13. If you are printing on a sheet of paper less than 900 mm in length (up to A1 size),
deploy the three mobile stoppers on the bin.

Note 1 When printing on sheet paper you are recommended to select
Normal or Best print quality, see How do I change the print quality?.

Note 2 If you have an unexpected problem at any stage of the paper loading
process, see The problem is the paper cannot be loaded successfully.

How do I unload a single sheet?  
At the printer's front panel, select the icon, then Unload paper now.

To give the ink time to dry, the printer holds the sheet for some time (see Tell me
about drying time).
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How do I select supported paper types?         
The following tables list the HP paper types that are suitable for use with your printer,
and show the name that you should select in the front panel when loading each paper
type. The “recommended” paper types, listed first, have been thoroughly tested and
are known to provide the best print quality when used with your printer. The “other
supported” paper types can be used with your printer but are not guaranteed to
provide the best print quality. For the part numbers, widths, and weights of these
papers, see Tell me about ordering paper.

Note This list is likely to change over the course of time. For the latest
information, see http://www.hp.com/go/designjet.

Recommended paper types
Product name Front panel name

HP Bright White Inkjet Bond Paper Bright White

Max Speed Bright White

HP Matte Film Matte Film

HP Clear Film Clear Film

HP Natural Tracing Paper Natural Tracing Paper

HP Translucent Bond Translucent Bond

HP Vellum Vellum

HP Coated Paper Coated Paper

HP Heavyweight Coated Paper Heavyweight Coated Paper

HP Heavyweight Coated Paper—long roll Heavyweight Coated Paper

HP Productivity Photo Gloss Productivity Photo Gloss

HP Productivity Photo Semi-Gloss Productivity Photo Gloss

HP Photo Paper RC Matte High-Gloss Photo Paper

HP Proofing Paper RC Satin High-Gloss Photo Paper

HP Universal High-Gloss Photo Paper High-Gloss Photo Paper

HP Universal Semi-Gloss Photo Paper High-Gloss Photo Paper

HP Universal Inkjet Bond Paper Bond Paper

Max Speed Bond Paper
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Other supported paper types
Product name Front panel name

HP Polyester Film Opaque White Glossy High-Gloss Photo Paper

HP Universal Coated Paper Bright White

Max Speed Bright White

HP Universal Heavyweight Coated Paper Heavyweight Coated Paper

HP Super Heavyweight Coated Paper Super Heavy Coated Paper

HP Banners with Tyvek Super Heavy Coated Paper

HP Colorfast Adhesive Vinyl High-Gloss Photo Paper

HP Backlit Film Reverse Print Matte Matte Film

HP Studio Canvas Canvas

HP Outdoor Billboard Paper Blue Back Super Heavy Coated Paper

HP Canvas Matte Canvas

HP Outdoor Paper Super Heavy Coated Paper

HP Canvas Paper 140 gsm Canvas

HP Canvas Paper 180 gsm Canvas

HP Fine Art Paper Aquarella Super Heavy Coated Paper

HP Fine Art Paper Cream Super Heavy Coated Paper

HP Fine Art Paper Sahara Super Heavy Coated Paper

HP Indoor Paper Self-Adhesive Super Heavy Coated Paper

How do I view information about the paper? 
At the printer's front panel, highlight the  or icon.
You will see the following information displayed on the front panel:

● The paper source (roll or sheet)
● The paper manufacturer's name
● The paper type you have selected
● The total width of the paper in millimeters (as measured by the printer)

If no paper is loaded, the message Out of paper is displayed.

The same information (apart from the manufacturer's name) is displayed on the
Embedded Web Server's Supplies page.
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How do I download media profiles?   
Each supported paper type has its own characteristics. For optimum print quality, the
printer changes the way it prints on each different paper type. For example, some may
need more ink and some may require a longer drying time. So the printer must be
given a description of the requirements of each paper type. This description is called
the “media profile”. The media profile contains the ICC profile, which describes the
color characteristics of the paper; it also contains information on other characteristics
and requirements of the paper that are not directly related to color. Existing media
profiles for your printer are already installed in the printer's software.

However, you would find it inconvenient to scroll through a list of all paper types
available for your printer, so your printer contains media profiles for only the most
commonly used paper types. If you buy a paper type for which your printer has no
media profile, you will find that you cannot select that paper type in the front panel. To
download the correct media profile, go to http://www.hp.com/support/designjet-
downloads/, select the name of your printer, then select Media profiles.

If you do not find the media profile you want on the Web, you may find that it has been
added to the latest firmware for your printer. You can check the firmware release
notes for information. See How do I update my printer's firmware?.

How do I use non-HP paper?  
HP's own paper types have been fully tested with the printer and can be expected to
give the best print quality.

However, you can print on paper from any manufacturer. In that case, you should
select (in the front panel) the HP paper type that is most similar to the paper you will
be using. If in doubt, try several different HP paper type settings, and choose the one
that provides you with the best print quality. If results are not entirely satisfactory with
any paper type setting, see General advice.

How do I cancel the drying time?  
Press the Form Feed and Cut key (1) on the front panel.

Caution A print that has had insufficient time to dry can suffer from quality
problems.
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How do I change the drying time?  
You may wish to change the drying time setting to suit special printing conditions.

Select the  icon, then Drying options > Drying time. You can then select
Extended, Optimal, Reduced, or None.

See Tell me about drying time.
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6 How do I handle the ink system?
● How do I remove an ink cartridge?
● How do I insert an ink cartridge?
● How do I remove a printhead?
● How do I insert a printhead?
● How do I manage printhead monitoring?
● How do I recover (clean) the printheads?
● How do I clean a printhead's electrical connections?
● How do I align the printheads?
● How do I remove a printhead cleaner?
● How do I insert a printhead cleaner?
● How do I check the status of the ink system?
● How do I get ink cartridge statistics?
● How do I get printhead statistics?
● How do I check printer usage statistics?

How do I remove an ink cartridge?  
There are two types of ink cartridge removal.

● The ink cartridge is very low and you want to replace it with a full cartridge for
unattended printing (you can use up the remaining ink in the first cartridge at a
more convenient time).

● The ink cartridge is empty or faulty, and you must replace it to continue printing.

Caution 1 Do not try to remove an ink cartridge while printing.

Caution 2 Remove an ink cartridge only if you are ready to insert another one.

Warning Make sure the printer wheels are locked (the brake lever is pressed
down) to prevent the printer from moving.
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1. At the printer's front panel, select the  icon, then Ink cartridges > Replace ink
cartridges now.

2. The ink cartridge door is on the left-hand side of the printer.

3. Release the door catch by pressing on the top until it clicks.
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4. Pull the door fully open.

5. Grip the blue tab in front of the cartridge you wish to remove.
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6. Pull the blue tab down.

7. Then pull it outwards, towards you.
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8. The cartridge comes out, in its drawer.

9. Lift the cartridge out of its drawer.

Note 1 Avoid touching the end of the cartridge that is inserted into the
printer, as there may be ink on the connection.

Note 2 Avoid storing partially used ink cartridges on their ends.

10. The front panel display will identify the missing ink cartridge.
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How do I insert an ink cartridge?  
1. Pick up the new ink cartridge and find the label identifying the ink color. Hold the

ink cartridge so that you can see the identifying colored label at the top of the side
facing you.

2. Check that the colored label above the empty slot in the printer matches the color
of the label on the cartridge.

3. Insert the ink cartridge into the cartridge drawer.

Position the cartridge at the rear of the drawer as indicated below.
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4. Slide the drawer and cartridge into the slot until it locks into position.

If you have difficulty, see The problem is I cannot insert an ink cartridge.
5. When all cartridges have been inserted, close the door (push it until it clicks shut).

6. The front panel display confirms that all cartridges have been correctly inserted.
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How do I remove a printhead?  
Warning Make sure the printer wheels are locked (the brake lever is pressed
down) to prevent the printer from moving.

Printhead replacement must be performed with the printer switched on at the power
isolation switch.

1. At the printer's front panel, select the  icon, then Printheads > Replace
printheads now.

2. The printer moves the carriage into the correct position.

Caution If the carriage is left in the central part of the printer for more
than seven minutes. it will try to move back to its normal position in the
right-hand end.

3. When the carriage has stopped moving, the front panel will ask you to open the
window.
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4. Locate the carriage.

5. Pull up and release the latch on top of the carriage.

6. Lift up the cover. This will now give you access to the printheads.
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7. To remove a printhead, lift up the blue handle.

8. Using the blue handle, gently disengage the printhead.
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9. Gently pull the blue handle upward until the printhead is released from the
carriage.

Caution Do not pull abruptly because this can damage the printhead.

10. The front panel display identifies the missing printhead.
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How do I insert a printhead?  
1. If the printhead is new:

a. Remove the blue protective cap by pulling down on it.
b. Remove the clear protective tape from the printhead's nozzles by pulling on

the paper tab.

The printhead is designed to prevent you from accidentally inserting it into the
wrong position. Check that the colored label on the printhead matches the
colored label of the carriage position into which the printhead is to be inserted.

2. Insert the new printhead into its correct position in the carriage.

Caution Insert the printhead slowly and vertically, straight down. It may
be damaged if you insert it too fast, or at an angle, or if you turn it as you
insert it.
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3. Push down as indicated by the arrow shown below.

When installing the new printhead there may be some resistance, so you need to
press it down firmly but smoothly.
If you have difficulty, see The problem is I cannot insert a printhead.

4. Insert any other printheads that need to be installed, and close the carriage cover.

When all the printheads have been inserted correctly and accepted by the printer,
the printer will beep.

Note If the printer does not beep when you insert the printhead and the
Replace message appears on the front panel, the printhead may need to
be reseated.
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5. Latch the carriage cover.

When the carriage has been correctly latched, it looks like this:

6. Close the window.
7. The front panel display confirms that all printheads are correctly inserted.
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8. Now replace the printhead cleaners for any printheads that have been changed.
See How do I remove a printhead cleaner? and How do I insert a printhead
cleaner?.

Caution Leaving the old printhead cleaner in the printer will shorten the
new printhead's life and possibly damage the printer.

How do I manage printhead monitoring?  
The printer automatically checks the status of the printheads from time to time in order
to monitor their health and detect any problems that might affect print quality. The
frequency of these checks is optimized to maintain good throughput.

If you want to increase the frequency of printhead monitoring in order to detect any
problems sooner, select the  icon, then Configuration menu > Printhead
monitoring > Intensive. When the printer is printing and printhead monitoring is set
to Intensive, the front panel and the Embedded Web Server printer status line will
display the following message: Printing. Printhead monitoring (instead of just
Printing).

Note When Intensive is selected, the throughput of the printer will be
reduced because of the increased frequency of printhead checks.

To return to the default printhead monitoring frequency, select the  icon, then
Configuration menu > Printhead monitoring > Optimized.

How do I recover (clean) the printheads?    
To clean the printheads (which often enables them to recover from problems), go to
the printer's front panel and select the  icon, then Printheads > Recover
printheads. Cleaning takes about two to four minutes.

How do I clean a printhead's electrical connections? 
In some extreme cases it is possible that the printer will not recognize a printhead
after it has been installed. This is due to the build-up of ink deposits on the electrical
connections between the printhead and the printhead carriage. Under these
circumstances you are recommended to clean the printhead's electrical connections.
Routine cleaning of the connections when there are no apparent problems is not
recommended.
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Included with your printer (in the Maintenance Kit box) is a carriage interconnect wiper.

This should be used for cleaning the electrical interconnects of both the printhead
carriage and the printhead, which should be done if the front panel persistently
displays the Reseat or Replace message next to the printhead.

1. Remove a new pre-moistened replacement sponge from its pouch.

A supply of sponges is included in the box with the wiper. If all sponges have
been used, more can be obtained by contacting your customer service
representative.

2. Open the carriage interconnect wiper.
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3. Load the sponge into the carriage interconnect wiper by positioning the sponge
on the face of the carriage interconnect wiper with the shorter tab in the locating
slot.

4. Close the carriage interconnect wiper, trapping the sponge in place.

5. Open the printhead carriage latch and extract the printhead that has the problem,
as indicated on the front panel. See How do I remove a printhead?.
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6. Insert the carriage interconnect wiper into the printhead slot at the back. Wipe the
electrical contacts by inserting the tool between the electrical connections at the
back of the slot and the steel spring with the sponge facing away from you and
towards the electrical contacts. Try to avoid picking up any ink deposit which may
have accumulated on the bottom surface of the slot.

Caution If the carriage is left in the central part of the printer for more
than seven minutes. it will try to move back to its normal position in the
right-hand end.

7. Rub the sponge against the contacts with a light force along the entire depth of
the flex connector as allowed by the mechanical stop on the tool.
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8. Take special care to clean all contacts thoroughly, including the ones at the
lowest point of the connector.

9. Using the same sponge, clean the lower strip of electrical contacts on the
printhead (unless the printhead is new), avoid touching the upper set of electrical
contacts.

Caution Do not touch the surface of the printhead containing the
nozzles, which are easily damaged.

10. After waiting a few moments to allow both connectors to dry, replace the
printhead into the printhead carriage. See How do I insert a printhead?.
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11. On completion of the cleaning process, open the carriage interconnect wiper by
pulling on the sponge tab.

12. Remove the soiled sponge from the carriage interconnect wiper.

13. Dispose of the soiled sponge in a safe place to prevent the transfer of ink onto
hands and clothing.

If the front panel continues to display the Reseat or Replace message, replace the
printhead or contact your customer service representative.
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How do I align the printheads?  
The printer will normally perform printhead alignment whenever printheads are
replaced. If there is no paper loaded when a printhead is replaced, the printer will
perform the alignment the next time you load paper.

Note You can turn off these automatic printhead alignments from the front
panel: select the  icon, then Configuration menu > Auto. printhead
alignment: Off.

In addition, you should align the printheads if the Image Diagnostics Print indicates an
alignment error. See How do I use the Image Diagnostics Print?.
1. Make sure that you have a roll of opaque paper loaded in the printer; the best

results will be achieved with the type of paper that you normally use for printing.
Single sheets of paper, and transparent materials such as translucent bond, clear
film, matte film, tracing paper, and vellum are not suitable for printhead alignment.

2. To request printhead alignment (if the alignment is not being performed
automatically), go to the front panel, select the  icon, and then Printheads >
Align printheads.

3. If you are close to the beginning of a roll, the front panel will report that the printer
may need to feed up to 3 m (≈ 10 ft) of paper before starting the printhead
alignment. This is necessary to ensure a successful alignment. In this case, you
will be given the following options:
– To continue with the printhead alignment, allowing the printer to feed as

much paper as necessary
– To schedule the printhead alignment to be performed later, after you have

used a few meters of paper for printing
– To cancel the printhead alignment

4. If you choose to continue with the printhead alignment, the process will start
immediately, unless an image is currently being printed, in which case the
alignment will be done as soon as the current print job is finished.
The alignment process takes about twelve minutes.
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How do I remove a printhead cleaner?  
After you have replaced a printhead, the front panel will prompt you to replace the
printhead cleaner.

Caution When replacing a printhead, always replace the corresponding
printhead cleaner. Leaving the old cleaner in the printer will seriously shorten
the new printhead's life and possibly damage the printer. A new printhead
cleaner is provided with each new printhead.

When removing a printhead cleaner:

● Be careful not to get ink on your hands. There may be ink on, around, and inside
the replaced printhead cleaner.

● Always handle and store the replaced printhead cleaner upright to avoid spilling
any ink.

Warning Make sure the printer wheels are locked (the brake lever is pressed
down) to prevent the printer from moving.

1. The printhead cleaners are located in slots underneath the front panel, at the
front of the printer. Press the top of the service station door to release the catch.
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2. Open the door.

3. Each printhead cleaner has a handle on the front. To remove the cleaner, press
inward and upward as indicated by the arrow shown here, until the cleaner is
released.

4. Lift up the printhead cleaner to remove it from the slot, and slide it out horizontally
as shown below.
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See also How do I insert a printhead cleaner?.

How do I insert a printhead cleaner?  
The plastic bag in which the new printhead cleaner comes can be used to dispose of
the old printhead and printhead cleaner.

1. Insert each printhead cleaner into the correct color slot location, in the service
station, in the direction indicated by the arrow shown here.

2. When the printhead cleaner has been pushed all the way in, press inwards and
downwards as indicated by the arrow shown here, until it clicks into place.

If you have difficulty, see The problem is I cannot insert a printhead cleaner.

Note The front panel will not show the new printhead cleaner until the
right-hand door is closed.
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3. When you have inserted the printhead cleaner(s) into the printer, close the door.

Note The printer needs all the ink cartridges, printheads, and printhead
cleaners to be installed before it can continue.

4. If no paper is loaded, the front panel will instruct you to load some.

Whenever you insert a new printhead and cleaner, the printer will normally perform a
printhead alignment and color calibration. Both are recommended for best print
quality. In some cases, you may decide to postpone printhead alignment until after
some further printing has been done.

Note If you prefer to save some time at the expense of print quality, you can
turn off these automatic procedures from the front panel, by selecting the 
icon, then Configuration menu > Auto. printhead alignment > Off and
Configuration menu > Color calibration > Off.

The front panel may request that you load paper that is suitable for printhead
alignment. The printhead alignment procedure requires a roll of opaque paper: not a
single sheet, and not any kind of transparent or translucent material.

When the front panel displays Ready, you are ready to print.

Note Make sure the printer window and the right-hand door are closed after
you replace the supplies. The printer will not print while these are open.
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How do I check the status of the ink system?    
1. Access the Embedded Web Server (see How do I access the Embedded Web

Server?).
2. Go to the Supplies page.

The Supplies page shows you the status of the ink cartridges (including the ink
levels), the printheads, the printhead cleaners, and the loaded paper.

How do I get ink cartridge statistics?    
To get information on your ink cartridges:
1. Go to the front panel and select the  icon.
2. Select Ink cartridges > Ink cartridge information, then select the cartridge on

which you want information.
3. The front panel displays:

– Its color
– Its product name
– Its serial number
– Its status
– Its ink level, if known
– Its total ink capacity in milliliters
– Its warranty status
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You can also get most of this information without leaving your computer by using the
Embedded Web Server.

For an explanation of the ink cartridge status messages, see The problem is an ink
cartridge status message.

How do I get printhead statistics?     
To get information on your printheads:

1. Go to the front panel and select the  icon.
2. Select Printheads > Printhead information, then select the printhead on which

you want information.
3. The front panel displays:

– Its color
– Its product number
– Its serial number
– Its status
– The volume of ink it has used
– Its warranty status
– The status of its cleaner

You can also get most of this information without leaving your computer by using the
Embedded Web Server.

For an explanation of the printhead and printhead cleaner status messages, see The
problem is a printhead status message and The problem is a printhead cleaner status
message.

If the warranty status is See warranty note, this indicates that non-HP ink is being
used. See Worldwide Limited Warranty—HP Designjet 4000 Printer series for details
of the warranty implications.

How do I check printer usage statistics?   
1. Access the Embedded Web Server (see How do I access the Embedded Web

Server?).
2. Go to the Usage page.
3. Go to the Historical tab to see the accumulated usage of the printer since the

first day.
4. Go to the Snapshot tab to save a record of the accumulated usage since the first

day, and reset the Accumulated tab's counters to zero.
5. Go to the Accumulated tab to view the accumulated usage since the last

snapshot.
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7 How do I adjust my printed
images?
● How do I change the page size?
● How do I create a custom page size?
● How do I change the print quality?
● How do I choose print quality settings?
● How do I print at maximum speed?
● How do I adjust the margins?
● How do I print on oversize page sizes?
● How do I change the paper's orientation?
● How do I rotate an image?
● How do I print a mirror image?
● How do I scale an image?
● How do I change the palette settings?
● How do I change the treatment of overlapping lines?
● How do I change the graphic language setting?

How do I change the page size?
The page size can be specified in the following ways:

● Using a Windows printer driver: select the Paper/Quality tab, then Size is.
● Using a Mac OS printer driver: select the Page Attributes panel, then Paper size.
● Using the Embedded Web Server: go to the Page Size section of the Submit Job

page.
● Using the front panel: select the  icon, then Printing defaults menu > Paper

options > Size.

Note If a page size is set with the printer driver or with the Embedded Web
Server, it overrides the page size set with the front panel.

How do I create a custom page size?   
You can create a custom page size using a printer driver or the Embedded Web
Server.

Using the HP-GL/2 & RTL printer driver for Windows
1. Select the Paper/Quality tab.
2. Press the Custom button.
3. Choose one of the selectable names (Custom 1 to Custom 5) for your custom

page size.
4. Enter its width and height.
5. Press the OK button.
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Using the PostScript printer driver for Windows XP or Windows 2000
1. Select the Paper/Quality tab.
2. Press the Custom button.
3. Enter your choice of name for your custom page size.
4. Enter its width and height.
5. Press the Save button.

Using the PostScript printer driver for Windows Me or Windows 98
1. Select the Paper/Quality tab.
2. Select Custom page 1, Custom page 2, or Custom page 3 from the Size is list.
3. Choose the width and height of your custom page.
4. Press the OK button.

Using the PostScript printer driver for Windows NT
1. Select the Page Setup tab.
2. Select PostScript Custom Page Size from the list of page sizes.
3. Choose the width and height of your desired page size.
4. Press the OK button.

Using the PostScript printer driver for Mac OS X
1. Select Page Setup from the File menu.
2. Select the Custom Paper Size panel.
3. Press the New button.
4. Enter your choice of name for your custom page size.
5. Enter its width and height.
6. Press the Save button.

Using the PostScript printer driver for Mac OS 9
1. Select Page Setup from the File menu.
2. Select the Page Attributes panel.
3. Select the Custom Page Default panel.
4. Enter your choice of name for your custom page size.
5. Enter its width and height.
6. Press the Add button.

Using the Embedded Web Server
1. Go to the Page Size section of the Submit Job page.
2. Select the Custom option.
3. Choose the width and height of your desired page size.
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How do I change the print quality?  
Your printer has three different print quality options: Best, Normal, and Fast. There
are also two supplementary options that have an effect on print quality: Optimize for
drawings/text or Optimize for images, and Maximum detail. See How do I choose
print quality settings? for guidance on choosing among these options.

You can specify the print quality in the following ways:

● Using a Windows printer driver: go to the Print Quality section of the Paper/
Quality tab.

● Using a Mac OS printer driver: go to the Image Quality panel.
● Using the Embedded Web Server: go to the Image Quality section of the Submit

Job page.
● Using the front panel: select the  icon, then Printing defaults menu > Image

quality.

Note 1 If a print quality is set with the printer driver or with the Embedded
Web Server, it overrides the print quality setting from the front panel.

Note 2 You cannot change the print quality of pages that the printer is already
receiving or has already received (even if they have not started to print yet).
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How do I choose print quality settings?  
The following table shows suggested print quality settings and paper types for various
different kinds of prints, assuming that you are using roll paper. You are not obliged to
follow these suggestions, but you may find them helpful.

If you are using sheet paper, you are recommended to set print quality to Best.
If you are not sure how to change the print quality settings, see How do I change the
print quality?.

Note High-density images should be printed on heavier paper (heavyweight
or glossy).

Print content Image quality settings Paper types (front
panel)

Print
quality

Optimized
for

Maximum
detail

Lines (draft) Fast Drawings/
text

On Bright White
Bond Paper

Translucent materials*

Coated Paper

Lines Normal Drawings/
text

Off Bright White

Bond Paper

Translucent materials*

Coated Paper

Lines and
area fills

Best Drawings/
text

Off Bright White

Bond Paper

Translucent materials*

Coated Paper

Heavyweight Coated
Paper

Productivity Photo
Gloss
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Print content Image quality settings Paper types (front
panel)

Print
quality

Optimized
for

Maximum
detail

Lines and
images

Best Drawings/
text

On Coated Paper

Heavyweight Coated
Paper

Productivity Photo
Gloss

In-store
advertising

Normal Images Off Coated Paper

Heavyweight Coated
Paper

Productivity Photo
Gloss

Renderings Best Images Off Heavyweight Coated
Paper

Productivity Photo
Gloss

Photographs Best Images Off Productivity Photo
Gloss

* Translucent materials include Vellum, Translucent Bond, Natural Tracing Paper,
Clear Film, and Matte Film.

For technical details of print resolution, see Tell me about functional specifications.
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How do I print at maximum speed? 
There are two paper type settings in the front panel especially designed for printing at
maximum speed.

Print content Image quality settings Paper types (front
panel)

Print
quality

Optimized
for

Maximum
detail

Lines (draft) Fast Drawings/
text

Off Max Speed Bright
White*

Max Speed Bond
Paper†

* To use Max Speed Bright White, load HP Bright White Inkjet Bond Paper and select
Max Speed Bright White from the list of paper types in the front panel.

† To use Max Speed Bond Paper, load HP Universal Inkjet Bond Paper and select
Max Speed Bond Paper from the list of paper types in the front panel.

How do I adjust the margins?  
The printer margins determine the printable area of the page that can be used by your
application. There are two margin options: Extended and Normal. For the dimensions
of the margins, see Tell me about functional specifications.

You can specify the margins in the following ways:

● Using the Windows HP-GL/2 printer driver: Normal margins are selected by
default. To select Extended margins, select the Paper/Quality tab and check the
Extended margins box.

● Using the Windows PostScript printer driver: select the Paper/Quality tab, then
Size is. You select the page size and the margins at the same time.

● Using a Mac OS printer driver: select the Page Attributes panel, then Paper size.
You select the paper size and then select the margins.
With the Mac OS 10.1 driver, you can select only Normal margins.

● Using the Embedded Web Server: select the Submit Job page, then Margins.
● Using the front panel: select the  icon, then Printing defaults menu > Paper

options > Margins.

Note If margins are set with the printer driver or with the Embedded Web
Server, they override the margins set with the front panel.
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How do I print on oversize page sizes?   
For technical reasons, it is impossible to print an image that covers the full width or
length of the paper. There must always be a margin around the image. If you want to
print, for example, an A3–sized image with no margins around it, you must print on
paper larger than A3 (leaving margins around the image as usual), and then cut off
the margins after printing.

Oversize page sizes are designed to meet this need. Each oversize page size is large
enough to accommodate a standard paper size plus margins.

You can specify an oversize page size in the following ways:

● Using the Windows HP-GL/2 printer driver: select one of the oversize paper sizes
from the Size is list.

● Using the Windows PostScript printer driver: select the Paper/Quality tab, then
Size is. You select the oversize page size and the margins at the same time.

● Using a Mac OS 9 or 10.1 printer driver: create a custom paper size with zero
margins, and take into account that the margins added to the final job will be the
ones that are set in the printer's front panel.

● Using a newer Mac OS printer driver: select the Page Attributes panel, then
Paper size. You select the oversize paper size and then select the margins.

● Using the Embedded Web Server: for PDF, TIFF, and JPEG jobs, oversize page
sizes are automatically selected if you leave margins set to Default. If you select
Normal or Extended margins, normal page sizes will be used.
The Embedded Web Server does not support the use of oversize page sizes for
HP-GL/2, RTL, CALS G4, or PostScript jobs (you must use a printer driver).

● Using the front panel: for PDF, TIFF, and JPEG jobs, front panel margin settings
are ignored and you are assumed to be using oversize pages in all cases.
The front panel does not support the use of oversize page sizes for HP-GL/2,
RTL, CALS G4, or PostScript jobs (you must use a printer driver).

How do I change the paper's orientation?     
You can select portrait or landscape orientation of the paper using a printer driver or
the Embedded Web Server.

● Using the PostScript printer driver for Windows NT: go to the Orientation section
of the Page Setup tab.

● Using any other printer driver for Windows: go to the Orientation section of the
Finishing tab.

● Using the PostScript printer driver for Mac OS: select Page Setup from the File
menu, then go to the Orientation section of the Page Attributes panel.

● Using the Embedded Web Server: go to the Orientation section of the Submit Job
page.
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How do I rotate an image?
Images are normally printed in portrait orientation. You may wish to rotate an image
by 90 degrees in order to save paper. You can do this in the following ways:

● Using a Windows printer driver: select the Finishing tab, then Rotate by 90
degrees.

● Using a Mac OS printer driver: select the Finishing panel, then Rotate by 90
degrees.

● Using the Embedded Web Server: select the Submit Job page, then Rotate.
● Using the front panel: select the  icon, then Printing defaults menu > Paper

options > Rotate.

Note 1 If rotation is set with the printer driver or with the Embedded Web
Server, it overrides the setting in the front panel.

Note 2 When you rotate a job, the page length may be increased to avoid
clipping, because the top and bottom margins are usually larger than the side
margins.

Possibility of clipped images
With either rolls or sheets, if you rotate an image to landscape whose original
orientation was portrait, the paper may not be wide enough for the image, and it may
be clipped. For example, rotating a portrait D/A1-size image on D/A1-size paper by 90
degrees will probably result in a clipped image. If you are using the Embedded Web
Server, the preview screen will confirm this with a warning triangle.

How do I print a mirror image?
If you are using clear imaging paper, sometimes called backlit, you may want to print
a mirror image of your drawing, so that when the paper is lit from behind it is in the
correct orientation. To do this without changing the image in your application:
● Using a Windows printer driver: select the Finishing tab, then Mirror image.
● Using a Mac OS printer driver: select the Finishing panel, then Mirror image.
● Using the Embedded Web Server: select the Submit Job page, then Mirror.
● Using the front panel: select the  icon, then Printing defaults menu > Paper

options > Mirror.

Note If mirror image is set with the printer driver or with the Embedded Web
Server, it overrides the setting in the front panel.

How do I scale an image?
You can send an image to the printer at a certain size but tell the printer to rescale it
to a different size (normally larger). This may be useful:

● If your software does not support large formats
● If your file is too large for the printer's memory—in this case you can reduce the

page size in your software and then scale it up again using the front panel option
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You can rescale an image in the following ways:

● Using a Windows printer driver: select the Effects tab, then Resizing options.
– The Print document on option (with Scale to fit checked) adjusts the image

size to the page size selected for your printer. For example, if you have
selected ISO A2 as the page size and you print an A4-size image, it will be
enlarged to fit the A2 page. If the ISO A3 page size is selected, the printer
would reduce a larger image to fit the A3 size.

– The % of normal size option enlarges the printable area of the original page
by the percentage indicated and adds the printer margins to make up the
output page size.

● Using a Mac OS printer driver: select the Finishing panel, then Print document on.
No Scale to fit option is displayed, because it is permanently on: the driver
always adjusts the image size to the page size selected for your printer.

● Using the Embedded Web Server: select the Submit Job page, then Scaling.
● Using the front panel: select the  icon, then Printing defaults menu > Paper

options > Scale.

If you are printing to a single sheet, you must ensure that the image can actually fit
onto the page, otherwise clipping will occur.

How do I change the palette settings?  
You cannot change the Factory palette, but you can define Palettes A and B to be
whatever you choose.

These palettes will be applied only to HP-GL/2 jobs with no software palette embedded.

Note All HP-GL/2 jobs generated by the HP-GL/2 driver that comes with the
printer will include an embedded software palette, and thus any palette
settings in the front panel will be ignored.

To redefine Palette A:

1. Go to the front panel, select the  icon, then Printing defaults menu > HP-
GL/2 options > Define palette > Palette A.

2. Scroll to the pen number you want to change and press Select.
3. The current width assigned to this pen is displayed, for example Width=0.35 mm.

If you want to change it:
4. Press Select.
5. Scroll to the width you want.
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6. Press Select again.
7. Press Back to get to the previous menu: Color/Width. Otherwise, scroll to Color.
8. The current color assigned to the pen is displayed, for example Color=110. If you

want to change it:
9. Press Select.
10. Scroll to the color you want.
11. Press Select again.
12. Press Back to get to the previous menu.
13. When both width and color are correct, press Back.
14. Scroll to the next pen number you want to change, press Select and then repeat

the above process.
15. When all pen definitions are correct, press Back to exit the menus.

Note The palette you have just defined will take effect only when you select it
to be the current palette.

If you do not get the results you expect, see The problem is pen settings seem to
have no effect.

How do I change the treatment of overlapping lines?
The Merge setting controls the overlapping lines in an image. There are two settings,
Off and On.

● If Merge is Off, where the lines cross only the color of the top line is printed.
● If Merge is On, where the lines cross the colors of the two lines are merged.

To turn Merge on, select the  icon, then Printing defaults menu > HP-GL/2
options > Merge: On. You can set the merge setting from your software in some
applications. Settings in your software override the front-panel settings.

Note Merge settings have no effect on PostScript files.
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How do I change the graphic language setting?     
Unless you are troubleshooting one of the problems mentioned below, you should not
need to change the default setting (Automatic), and you are not recommended to do
so, because setting a specific graphic language means that you will be able to print
only files in that language.

To change the graphic language setting, select the  icon, then Printing defaults
menu > Graphic language, where the following options are available.

● Select Automatic to let the printer determine which type of file it is receiving. This
setting works for most software applications.

● Select HP-GL/2 if you are not working with PostScript files, and you have
experienced image position problems or timing problems.

● Select PS if you are printing only PostScript files and your PostScript jobs do not
start with the standard PostScript header (%!PS) and do not include PJL
language switching commands.
Alternatively, select PS if you have experienced problems while downloading
PostScript fonts. In this case, please reselect Automatic after you have
downloaded the fonts.

If you are downloading fonts over a USB connection, select the  icon, then
Printing defaults menu > PS options > Encoding > ASCII.

● Select TIFF, JPEG, PDF, or CALS G4 only if you are sending a file of the
appropriate type directly to the printer without going through a printer driver. This
is normally done only from the Embedded Web Server, in which case the
language setting is done by the Embedded Web Server and you do not have to
do it yourself.

Note The PS and PDF options are available with PostScript printers only.
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8 How do I get accurate colors
from my printer?
● How do I perform color calibration?
● How do I perform black point compensation?
● How do I set the rendering intent?
● How do I select the color emulation mode?
● How do I produce matching prints from different HP Designjets?
● How do I get accurate colors from Adobe Photoshop CS (HP–GL/2 & RTL driver)?
● How do I get accurate colors from Adobe Photoshop CS (PostScript driver)?
● How do I get accurate colors from Adobe InDesign CS?
● How do I get accurate colors from QuarkXPress 6?
● How do I get accurate colors from Autodesk AutoCAD 2002?
● How do I get accurate colors from Microsoft Office 2003?
● How do I get accurate colors from ESRI ArcGIS 9?

How do I perform color calibration?  
Color calibration improves color consistency between prints, and from one printer to
another.

It is normally performed whenever a printhead is replaced, and whenever a new paper
type is introduced that has not been calibrated yet with the new printhead(s).
However, this automatic behavior can be turned off, and a default color correction
used for each of the known paper types.

1. From the front panel, select the  icon, then Configuration menu > Color
calibration.

2. The available options for color calibration are:
– On: the printer performs color calibration whenever you introduce a new

paper type that has not yet been calibrated with the current set of printheads.
The color correction resulting from the calibration is then used for
subsequent prints on that paper type with the same print quality setting.

– Off: the printer uses a default color correction, different for each paper type
and print quality setting.

3. The printer calibrates the colors by printing a calibration strip, scanning the strip
with a built-in optical sensor, and calculating the color corrections required. The
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color calibration strip is 269 mm wide, and 18 mm long when using glossy paper;
on other paper types, it is 109 mm long. Color calibration takes about three to six
minutes, depending on the paper type.

Note Color calibration can be requested manually at any time from the front
panel, by selecting the  icon, then Printheads > Calibrate color.

How do I perform black point compensation?
The black point compensation option controls whether to adjust for differences in
black points when converting colors between color spaces. When this option is
selected, the full dynamic range of the source space is mapped into the full dynamic
range of the destination space. It can be very useful in preventing blocking shadows
when the black point of the source space is darker than that of the destination space.
This option is allowed only when the relative colorimetric rendering intent is selected
(see How do I set the rendering intent?).

Black point compensation can be specified in the following ways:

● Using a Windows printer driver: select the Color tab, then Black point
compensation.

● Using a Mac OS printer driver: select the Color Options panel, then Black point
compensation.

● Using the Embedded Web Server: select the Submit Job page, then Black point
compensation.

● Using the front panel: select the  icon, then Printing defaults menu > Color
options > Black point compensation.

How do I set the rendering intent?
Rendering intent is one of the settings used when doing a color transformation. As
you probably know, some of the colors you want to print may not be reproducible by
the printer. The rendering intent allows you to select one of four different ways of
handling these so–called out–of–gamut colors.

● Saturation (graphics): best used for presentation graphics, charts, or images
made up of bright, saturated colors.

● Perceptual (images): best used for photographs or images in which colors blend
together. It tries to preserve the overall color appearance.

● Relative colorimetric (proofing): best used when you want to match a particular
color. This method is mainly used for proofing. It guarantees that, if a color can be
printed accurately, it will be printed accurately. The other methods will probably
provide a more pleasing range of colors but do not guarantee that any particular
color will be printed accurately. It maps the white of the input space to the white
of the paper on which you are printing.

● Absolute colorimetric (proofing): the same as relative colorimetric, but without
mapping the white. This rendering is also used mainly for proofing, where the
goal is to simulate the output of one printer (including its white point).
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The rendering intent can be specified in the following ways:

● Using a Windows printer driver: select the Color tab, then Rendering intent.
● Using a Mac OS printer driver: select the Color Options panel, then Rendering

intent.
● Using the Embedded Web Server: select the Submit Job page, then Rendering

intent.
● Using the front panel: select the  icon, then Printing defaults menu > Color

options > Rendering intent.

How do I select the color emulation mode?   
You can set the color emulation mode in the following ways:

● Using a Windows printer driver: select the Color Management section of the Color
tab.

● Using a Mac OS printer driver: select the Color Options panel.
● Using the Embedded Web Server: select the Color Management section of the

Submit Job page.
● Using the front panel: select the  icon, then Printing defaults menu > Color

options.

See Tell me about color emulation modes.

How do I produce matching prints from different HP
Designjets?

See The problem is color matching between different HP Designjets.

How do I get accurate colors from Adobe Photoshop CS
(HP–GL/2 & RTL driver)? 

This topic outlines one way to have good control over the printed colors you will obtain
from your printer; there are many other ways. Before starting, ensure that your paper
type has already been calibrated.

Application settings
1. Open Adobe Photoshop and select Color Settings from the Edit menu.

– Working spaces: the working space is the color space you want to use
when manipulating the image. We recommend using the color space that
comes with the image (see Color Management Policies below), if any;
otherwise, our recommended default settings are: RGB: Adobe RGB 1998,
CMYK: SWOP for the USA and Euroscale Coated v2 for the rest of the world.

– Color Management Policies: select 'Preserve Embedded Profiles'.
– Rendering Intent: see How do I set the rendering intent?.
– Black Point Compensation: this option is recommended if you have chosen

the Relative Colorimetric rendering intent. See How do I perform black point
compensation?.
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2. Open the image. Accept the embedded color profile if there is one:

Otherwise accept the default that Adobe Photoshop proposes:
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3. Once you have defined the color space in which you are going to work, you can if
you like make a soft proof, which means emulating on the screen how the image
will look when printed. To do this, you will need an ICC profile for your monitor.
Select View > Proof Setup > Custom. Use the following information to select
options in the Proof Setup window.
– Profile: choose the profile based on the printer model and paper type you

intend to use.
– Preserve Color Numbers: this checkbox tells the application how to

simulate the document's appearance without converting colors from the
Document Space to the Proof Profile Space. It simulates the color shifts that
may occur when the document's color values are interpreted using the Proof
Profile instead of the Document Profile. This option is not recommended.

– Intent: this menu allows you to choose a rendering intent for the conversion
from document space to simulation space, letting you preview the effects of
different renderings. See How do I set the rendering intent?.

– Use Black Point Compensation: this option is recommended if you have
chosen the Relative Colorimetric rendering intent. See How do I perform
black point compensation?.

– Paper White: this checkbox emulates the whiteness of the paper on the
monitor. The effect is the same as using the Absolute Colorimetric rendering
intent.

– Ink Black: this checkbox turns off the black point compensation for the
rendering from simulation to the monitor. So, if the simulation space black is
lighter than the monitor black, you will see the washed-out blacks on the
monitor. This option is not recommended.

– Preview: if this checkbox is enabled (recommended), the changes you make
in this window are reflected in the image immediately.
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4. When you are ready to print the image, open the Print with Preview window from
the File menu. In the Color Management tab you can select:
– Source Space: 'Document' (automatically assigned for you).
– Profile: select the profile you will use. We recommend using Adobe RGB. If

neither Adobe RGB or sRGB is selected, then choose the appropriate ICC
profile for the paper loaded, and remember to select later on in the driver the
option Managed by Application.

– Intent: See How do I set the rendering intent?.

Driver settings
In the Paper/Quality tab (Windows) or Image Quality panel (Mac OS), set Print
Quality to Best.
In the Color tab (Windows) or Color Options panel (Mac OS), you have the following
Color Management options. Select the same option that you selected in the Print
dialog box above (Print Space section, Profile option).

● sRGB: this is the default color space. The input RGB data are converted to
CMYK using the printer's internal color maps, which depend on the paper type
and print quality selected. These are the most “versatile” color maps, producing
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saturated colors for CAD and office applications and also producing good results
with photographic images.

● AdobeRGB: similar to sRGB, but using the AdobeRGB to CMYK internal color
maps, which are designed for AdobeRGB input data with a bigger source gamut.
Best suited to digital photography.

● Managed by Application: the driver will not perform any color correction. This
path can be used when building custom RGB printer profiles and applying them
within the application (the application is responsible for applying the right color
management by using the custom RGB printer profiles). In this case, make sure
that you have selected the right media profile in the "Print Space, Profile" option
in the application print command (see above).

Printer settings
Ensure that the Paper Type setting on the front panel corresponds to the paper you
intend to use.

How do I get accurate colors from Adobe Photoshop CS
(PostScript driver)? 

This topic outlines one way to have good control over the printed colors you will obtain
from your printer; there are many other ways. Before starting, ensure that your paper
type has already been calibrated.
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Application settings
1. Open Adobe Photoshop and select Color Settings from the Edit menu

(Windows) or from the Photoshop menu (Mac OS).
– Working spaces: the working space is the color space you want to use

when manipulating the image. We recommend using the color space that
comes with the image (see Color Management Policies below), if any;
otherwise, our recommended default settings are: RGB: Adobe RGB 1998,
CMYK: SWOP for the USA and Euroscale Coated v2 for the rest of the world.

– Color Management Policies: select 'Preserve Embedded Profiles'.
– Rendering Intent: see How do I set the rendering intent?.
– Black Point Compensation: this option is recommended if you have chosen

the Relative Colorimetric rendering intent. See How do I perform black point
compensation?.
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2. Open the image. Accept the embedded color profile if there is one:

Otherwise accept the default that Adobe Photoshop proposes:

3. Once you have defined the color space in which you are going to work, you can if
you like make a soft proof, which means emulating on the screen how the image
will look when printed. To do this, you will need an ICC profile for your monitor.
Select View > Proof Setup > Custom. Use the following information to select
options in the Proof Setup window.
– Profile: choose the profile based on the printer model and paper type you

intend to use.
– Preserve Color Numbers: this checkbox tells the application how to

simulate the document's appearance without converting colors from the
Document Space to the Proof Profile Space. It simulates the color shifts that
may occur when the document's color values are interpreted using the Proof
Profile instead of the Document Profile. This option is not recommended.

– Intent: this menu allows you to choose a rendering intent for the conversion
from document space to simulation space, letting you preview the effects of
different renderings. See How do I set the rendering intent?.
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– Use Black Point Compensation: this option is recommended if you have
chosen the Relative Colorimetric rendering intent. See How do I perform
black point compensation?.

– Paper White: this checkbox emulates the whiteness of the paper on the
monitor. The effect is the same as using the Absolute Colorimetric rendering
intent.

– Ink Black: this checkbox turns off the black point compensation for the
rendering from simulation to the monitor. So, if the simulation space black is
lighter than the monitor black, you will see the washed-out blacks on the
monitor. This option is not recommended.

– Preview: if this checkbox is enabled (recommended), the changes you make
in this window are reflected in the image immediately.
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4. When you are ready to print the image, open the Print with Preview window from
the File menu. In the Color Management tab you can select:
– Source Space: 'Document' (automatically assigned for you). This is the color

space in which you have been working while editing the image.
– Profile: select PostScript Color Management. With this option, the

application tells the driver which source profile and rendering intent should
be used for the conversion to the print space. In this case the driver will use
the 'Document' profile and the rendering intent selected below. The driver's
Input Profile and Rendering Intent settings are overridden.

– Intent: see How do I set the rendering intent?.

Driver settings
The application's PostScript Color Management option will override the color settings
of the driver (Input Profile and Rendering Intent). In this case, the driver will use the
application's "Document" profile and selected rendering intent. Then, we have only to
select in the driver:

● In the Paper/Quality tab (Windows) or Image Quality panel (Mac OS), set Print
Quality to Best.

● In the Color tab (Windows) or Color Options panel (Mac OS), check the
Automatic PANTONE Calibration box.

Chapter 8

150

H
ow

 d
o 

I g
et

 a
cc

ur
at

e 
co

lo
rs

fr
om

 m
y 

pr
in

te
r?



Printer settings
Ensure that the Paper Type setting on the front panel corresponds to the paper you
intend to use.

How do I get accurate colors from Adobe InDesign CS?
This topic outlines one way to have good control over the printed colors you will obtain
from your printer; there are many other ways. We describe the hard-proofing
technique that shows you on your printer how your colors will appear when
reproduced in a press. Before starting, ensure that your paper type has already been
calibrated.

Note EPS, PDF, and grayscale images don't allow page-layout applications
to manage their colors. In addition, such images are displayed very poorly on a
monitor.
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Application settings
1. Open Adobe InDesign and select Color Settings from the Edit menu.

– Working spaces: the working space is the color space you want to use
when manipulating the image. We recommend using the color space that
comes with the image (see Color Management Policies below), if any;
otherwise, our recommended default settings are: RGB: Adobe RGB 1998,
CMYK: SWOP for the USA and Euroscale Coated v2 for the rest of the world.

– Color Management Policies: select 'Preserve Embedded Profiles'.
– Rendering Intent: see How do I set the rendering intent?.
– Black Point Compensation: this option is recommended if you have chosen

the Relative Colorimetric rendering intent. See How do I perform black point
compensation?.

2. Create or open the image with its own or the most appropriate color space. Then
retouch the image as needed.

3. When you have the image ready to send to the output device, that is the moment
to simulate on your printer what will appear on the output device. You must
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convert the image from the source or work profile to the output CMYK device, and
then again from the output CMYK device to the printer profile (calibrated).
In InDesign we recommend the Proof Setup command (View > Proof Setup ->
Custom). This command lets you select the "proof profile" in the source space
when printing. You can also see a simulation on your monitor. We recommend as
follows:

Each object in InDesign has its own color management. The InDesign elements
(native) use the working spaces (default profiles) and the rendering intent defined
in Color Settings , and the placed objects have their own assigned profile and
rendering intent. Then, each element is converted from its own color space to the
simulation color space, using its own rendering intent.
– Profile: select the profile that corresponds to the device you want to emulate

(usually a particular press profile or an standard press profile)
– Paper White: this checkbox emulates the whiteness of the paper on the

monitor. The effect is the same as using the Absolute Colorimetric rendering
intent.

– Ink Black: this checkbox turns off the black point compensation for the
rendering from simulation to the monitor. So, if the simulation space black is
lighter than the monitor black, you will see the washed-out blacks on the
monitor. This option is not recommended.
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4. Select File > Print to print the image, converting it to an output space that
depends on the printer, the paper type, and the print quality.
– Select the Output tab (on the left), and then select Composite CMYK, in

order to see the CMYK profiles.
– Select the Color Management tab to see the following options.
– Source Space: select 'Proof' to emulate the proof color space.
– Profile: choose the profile based on the printer model and paper type you

intend to use.
– Intent: select Relative or Absolute Colorimetric. The only difference is that

Absolute Colorimetric emulates the background color of the paper to be used
by the press, while Relative Colorimetric maps the paper color of the press to
the paper color of the printer.

Driver settings
The PostScript driver is recommended for page-layout applications because it can
color–manage CMYK data, RGB data, or both simultaneously.

In the Paper/Quality tab (Windows) or Image Quality panel (Mac OS), set Print
Quality to Best.
In the Color tab (Windows) or Color Options panel (Mac OS), select 'Application
Managed Colors' and check the Automatic PANTONE Calibration box. When the
application performs color conversion to the printer's color space, the printer should
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accept these colors without changing them. Make sure you have selected the right
media profile in “Print Space, Profile” above.

Printer settings
Ensure that the Paper Type setting on the front panel corresponds to the paper you
intend to use.

How do I get accurate colors from QuarkXPress 6?
This topic outlines one way to have good control over the printed colors you will obtain
from your printer; there are many other ways. We describe the hard-proofing
technique that shows you on your printer how your colors will appear when
reproduced in a press. Before starting, ensure that your paper type has already been
calibrated.

Note EPS, PDF, and grayscale images don't allow page-layout applications
to manage their colors. In addition, such images are displayed very poorly on a
monitor.

Application settings
1. Open QuarkXPress and select Properties from the Edit menu (Windows) or the

QuarkXPress menu (Mac OS). Then select Quark CMS from the Properties
dialog box.
– Ensure that the Color Management Active box is checked.
– The Destination Profiles area lets you choose profiles that correspond to

your devices: Monitor profile, Composite Output profile, and Separation
Output profile. Select in the Separation Output profile the profile of your
output device (press) which you want to emulate on your printer later. Select
in the Composite Output profile your printer profile; remember that it depends
on the printer model, paper type, and print quality option.

– In the Default Source Profiles you must set the default profiles for solid colors
and images that don't have embedded profiles. The following default profiles
are recommended: RGB: Adobe RGB 1998, CMYK: SWOP for the USA and
Euroscale Coated v2 for the rest of the world. Also select the rendering
intent, which QuarkXpress uses for all conversions; if in doubt, select
Relative Colorimetric. See How do I set the rendering intent?.

– Check the box Color Manage RGB sources to RGB destinations in the
RGB Default Source Profiles and Color Manage CMYK sources to CMYK
destinations in the CMYK Default Source Profiles.

– The Display Simulation tells QuarkXPress how the display simulation should
behave:
• None means that it doesn't simulate anything on the display.
• Monitor Color Space means that it converts from the source profile to

the display profile for display only.
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• Composite Output Color Space makes the display simulate a
composite printer: that is, a printer without separate plates for different
colors, such as an inkjet printer.

• Separation Output Color Space makes the display simulate a
separations printer: that is, a printer with separate plates for different
colors, such as a digital press.

You can select Monitor Color Space if you want to display only, or you can
select the Separation Output Color Space if you also want to see the
simulation of the output device on the monitor. You can simulate the final
output with the printer (hard–proofing) and with the monitor (soft-proofing ).

2. Open and retouch the document as you like.
3. Select File > Print > Setup > Printer Description, and select your printer.
4. Select File > Print > Profiles.

– Select the appropriate Separation Output Profile (emulation) and Composite
Output Profile (printer).

– Check the Composite Simulates Separation box, then Quark will perform the
simulation.
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Note Each object in QuarkXpress has its own color management. The solid
colors use the color profile and rendering intent selected in the default source
profiles for Solid Colors (RGB, CMYK, or Hexachrome) of the Color
Management Preferences dialog box. The imported objects have their own
assigned profile and rendering intent. QuarkXPress will use the rendering
intent assigned to the image for both conversions, from the image color space
to the simulation color space, and from the simulation color space to the printer
color space.

Driver settings
The PostScript driver is the best choice for page-layout applications because it can
color–manage CMYK data, RGB data, or both simultaneously.

In the Image Quality panel, set Print Quality to Best.
In the Color Options panel, select Application Managed Colors and check the
Automatic PANTONE Calibration box. When the application performs color
conversion to the printer's color space, the printer should accept these colors without
changing them. Make sure you have selected the right media profile in Composite
Output in the Preferences dialog box.

Printer settings
Ensure that the Paper Type setting on the front panel corresponds to the paper you
intend to use.
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How do I get accurate colors from Autodesk AutoCAD
2002?

AutoCAD has no color management settings, so the best you can do is to configure
the driver correctly. If you are using the HP-GL/2 and RTL driver, click the Properties
button and configure the driver as follows.

● In the Paper/Quality tab, set Print Quality to Best.
● In the Color tab, ensure that the Print In Grayscale box is unchecked, and set

Color Matching Method to 'sRGB'.

How do I get accurate colors from Microsoft Office 2003?
Microsoft Office has no color management settings, so the best you can do is to
configure the driver correctly. If you are using the HP-GL/2 and RTL driver, click the
Properties button and configure the driver as follows.

● In the Paper/Quality tab, set Print Quality to Best.
● In the Color tab, ensure that the Print In Grayscale box is unchecked, and set

Color Matching Method to 'sRGB'.

How do I get accurate colors from ESRI ArcGIS 9?
ArcGIS is a scalable system of software for geographic data creation, management,
integration, analysis, and dissemination for every organization, from an individual to a
globally distributed network of people.

The application always sends RGB data to the printer driver; you can choose between
several different printer engines. The printer engine determines the format and
method used by ArcMap to send the print job to the printer. There are from one to
three options available, depending on license and printer configurations.

● Windows is the default and is always available, regardless of the printer in use. It
allows the application to use the installed HP-GL/2 and RTL driver.

● PostScript is available only if your printer supports PostScript and the PostScript
driver was selected in the Name section. This allows you to output the file as a
Postscript file. This option may be useful in certain specific cases, but in general it
is not recommended.

● ArcPress is an extension that can be purchased for printing from ArcGIS. It is a
software RIP that takes the original metafile and rasterizes it before sending it to
the printer, so that the printer does not need to rasterize it. This is beneficial
because some printers are not capable of rasterization or do not have enough
memory to process large jobs. Use ArcPress always with HP RTL (RGB)
TrueColor.
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Printing with the Windows printer engine
1. Ensure that you have installed the HP-GL/2 and RTL driver.
2. When you are ready to print, select File > Page and Print Setup, and select the

HP-GL/2 and RTL driver.

3. Click the Properties button and configure the driver as follows.
– In the Paper/Quality tab, set Print Quality to Best.
– In the Color tab, ensure that the Print In Grayscale box is unchecked, and

set Color Matching Method to 'sRGB'.
4. Click the OK button.
5. Select File > Print.

– Printer Engine: select Windows Printer (it will use the selected raster driver).
– Output Image Quality (Resample Ratio): this setting alters the number of

pixels sampled when an ArcMap print file is generated; it determines how
many pixels in the map document will be used to create the file sent to the
printer.
• Fast = 1:5
• Normal = 1:3
• Best = 1:1 (as is)
The 'Best' choice requires a lot of resources to process the print job, and
could cause long processing times and perhaps out–of–memory messages,
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depending on the map size. If you have these problems, select an Output
Image Quality lower than 'Best'. Bear in mind that you will gain no advantage
in print quality by sending an image whose resolution is higher than the
printer's input resolution.

6. You can print now (click the OK button).

Printing with the ArcPress printer engine
1. You must have the driver you need installed, although it will function only as a port.
2. When you are ready to print, select File > Page and Print Setup, select the

driver (the driver settings have no effect), and click the OK button.
3. Select File > Print.

– Printer Engine: select ArcPress.
– Click the Properties button, select the HP RTL (RGB) TrueColor driver, and

select the resolution that will be sent to the printer.
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– Select the Color Adjustment tab if you want to adjust gamma, brightness,
contrast, or saturation. You can preview the changes.

4. You can print now: click the OK button in this dialog box and in the Print dialog
box.
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9 How do I manage print jobs?
● How do I submit a job?
● How do I save a job?
● How do I print a saved job?
● How do I check ink and paper usage for a job?
● How do I cancel a job?
● How do I manage the print queue?
● How do I nest jobs to save roll paper?

How do I submit a job?   
1. Access the Embedded Web Server (see How do I access the Embedded Web

Server?).
2. Go to the Submit job page.

3. Browse your computer and select the file to print.

Note Submitting a job to be printed via the Embedded Web Server does
not require you to have the printer driver nor the file's native application
installed on your computer.

4. If you want to submit more than one file, click the Add another file button to add
another file.

5. Set the job options.
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If you leave an option set to Default, the setting saved in the job will be used. If
the job contains no setting for that option, the setting in the printer will be used.
The setting in the printer can be changed from the front panel, or in some cases
from the Device Setup page in the Embedded Web Server.

6. Click the Print button.

How do I save a job?   
If you intend to reprint a job later with some changes to the job settings (such as size
or quality), you can store the job inside your printer so that you will not need to
resubmit it later.

Note If you want to reprint a job without changes, you can do that from the
print queue without needing to save the job.

You can save a job only while submitting it for printing:

1. Access the Embedded Web Server (see How do I access the Embedded Web
Server?).

2. Go to the Submit job page.
3. Browse your computer and select the file to print.
4. If you want to submit more than one file, click the Add another file button to add

another file. All files submitted together will have the same job settings.
5. In the job options, check the Store job in printer option.
6. Set the rest of the job options.
7. Click the Print button.

How do I print a saved job?   
1. Access the Embedded Web Server (see How do I access the Embedded Web

Server?).
2. Go to the Stored jobs page.
3. Select the job or jobs that you want to print, using the check box beside each job

name.
4. Click the Print button to print the job with the original settings, or Advanced Print

to change the settings.

How do I check ink and paper usage for a job?        
1. Access the Embedded Web Server (see How do I access the Embedded Web

Server?).
2. Go to the Accounting page, which shows you all the information regarding the

jobs recently printed by the printer.
Alternatively, go to the Jobs Queue page, and click on the name of the job on
which you want information. Its properties page will then be displayed.

How do I cancel a job?   
A job can be canceled from the front panel by pressing the Cancel key, or from the
Embedded Web Server by selecting the job and clicking the Cancel icon..
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The printer advances the paper as though the print were finished.

Note A multi-page job or a big file may take longer to stop printing than other
files.

How do I manage the print queue?    
This information below applies only if you are using the drivers that came with your
printer or the Embedded Web Server to submit printing jobs.

Your printer can store pages in a queue while it is printing the current page. The
queue may contain pages from more than one job.

Note If the printer hangs up while printing a job, and the queue facility is
turned on, the partially printed job will appear in the queue as “On hold” when
the printer is next turned on. When you resume the job, it will start printing at
the page at which it was interrupted.

Turning off the queue
If you wish, you can turn off the queue from the Web server (Settings tab > Device
setup > Queue), or from the front panel: select the  icon and then Queue.

The When To Start Printing options

Note The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a file you have in the queue. From the
Web server, select the Settings tab > Device setup > When to start printing; or,
from the front panel, select the  icon and then When to start printing.

There are three options you can select:

● When After Processing is selected, the printer waits until the whole page has
been processed and then it starts to print. This is the slowest setting but offers
the best print quality.

● When Immediately is selected, the printer prints the page as it is processed. This
is the quickest setting, but the printer may stop halfway through a print to process
data. This setting is not recommended for complex images with dense color.

● When Optimized is selected (this is the default setting), the printer calculates the
best time to begin printing the page. It is usually the best compromise between
the After Processing and Immediately settings.
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Identifying a job in the queue
The best way to look at the queue is in the Embedded Web Server (Information >
Jobs queue), where you can manage the queue and get full information on every job
(by clicking the name of the file).

However, you can also manage the queue from the front panel. To do so, select the
 icon and then Queue management, where you can see a list of the jobs in the

queue.

Each has an identifier, comprising:

<position in queue>: <image name>

The job currently being printed is in position 0. The next job to be printed is in position
1, the previous job already printed is in position -1.

Prioritizing a job in the queue
To make any job in the queue the next one to be printed, select it and choose Reprint
(in the Embedded Web Server) or Move to front (in the front panel).

If nesting is turned on, the prioritized job may still be nested with others. If you really
want this job to be printed next, and on its own on the roll, first turn nesting off and
then move it to the front of the queue as described above.

Deleting a job from the queue
Under normal circumstances, there is no need to delete a job from the queue after
printing it, as it will just fall off the end of the queue as more files are sent. However, if
you have sent a file in error, and want to avoid any chance of it being reprinted, you
can simply delete it, by selecting it and choosing Delete (in the Embedded Web
Server or in the front panel).

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (Status = printing in the Web server, or its queue
position is 0 in the front panel), and you want both to cancel the job and to delete it,
first click the Cancel icon in the Web server, or press the Cancel key on the front
panel, and then delete it from the queue.

Making copies of a job in the queue
To make extra copies of any job in the queue, select the job in the Embedded Web
Server and click the Reprint icon, then specify the number of copies you want. The
job will be moved to the top of the queue.

You can also do this from the front panel: select the job and choose Copies, then
specify the number of copies required and press the Select key. This overrides any
value set by your software.

Note If Rotate was On when you sent the file, every copy will be rotated.

If the job has already been printed, use Move to front to move it to the top of the
queue.
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How do I nest jobs to save roll paper?   
Nesting means placing pages side by side on the paper, rather than one after the
other. This is done to avoid wasting paper.

1. Direction of paper flow
2. Nesting off
3. Nesting on
4. Paper saved by nesting

When does the printer try to nest pages?
When both of the following are true:

● The printer is loaded with roll paper, not sheet paper.
● In the front panel's Job Management menu or the Embedded Web Server's

Device Setup page, Nest is On.

Which pages can be nested?
All pages can be nested, unless they are so large that two of them cannot fit side by
side on the roll.

Which pages qualify for nesting?
In order to be in the same nest, the individual pages must be compatible in all of the
following ways:

● All pages must have the same print quality setting (Fast, Normal, or Best).
● Pages must be all Optimized for Drawings/Text or all Optimized for Images.
● The Maximum Detail setting must be the same on all pages.
● The Margins setting must be the same for all pages (Extended or Normal).
● The Mirror setting must be the same for all pages.
● The Rendering Intent must be the same for all pages.
● The Cutter setting must be the same for all pages.
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● The color adjustment settings must be the same for all pages. These are known
as Advanced Color Settings in the Windows driver, and CMYK Settings in the
Mac OS driver.

● Pages must be all color, or all grayscale: not some in color and some in grayscale.
● All pages must be in one or other of the following two groups (the two groups

cannot be mixed in the same nest):
– HP-GL/2, RTL, CALS G4
– PostScript, PDF, TIFF, JPEG

● JPEG, TIFF, and CALS G4 pages with resolutions greater than 300 dpi may not
nest with other pages in some cases.

How long does the printer wait for another file?
So that the printer can make the best nest possible, it waits after a file has been
received to check whether a subsequent page will nest with it or with pages already in
the queue. This waiting period is the nest wait time; the factory default nest wait time
is two minutes. This means that the printer waits for up to two minutes after the last
file is received before printing the final nest. You can change this waiting time from the
printer's front panel: select the icon, then Nest options > Wait time. The available
range is 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the
front panel. You can print the nest (cancel the nest wait) by pressing the Cancel key.
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10 How do I maintain my printer?
● How do I clean the exterior of the printer?
● How do I clean the platen?
● How do I lubricate the printhead carriage?
● How do I maintain the ink cartridges?
● How do I move or store my printer?
● How do I update my printer's firmware?

How do I clean the exterior of the printer?
Clean the outside of the printer and all other parts of the printer that you regularly
touch as part of normal operation (e.g. ink cartridge drawer handles) as required with
a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive
liquid soap.

Warning To avoid an electric shock, make sure that the printer is switched
OFF and unplugged before you clean it. Do not let water get inside the printer.

Caution Do not use abrasive cleaners on the printer.

How do I clean the platen?
You should plan to clean your printer's platen on a regular basis, every few months or
when needed.

Note If you print on wide paper after using narrower paper for some time, you
may find that the left side of the platen has become dirty and will leave marks
on the back of the paper if not cleaned.

Follow these instructions to clean the platen.

1. Unload all paper from the printer.
2. Open the window.
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3. With a dry brush, remove ink deposits from the cutter groove.

4. With the same dry brush, remove ink deposits from the platen surface.

5. Use a clean, absorbent lint-free cloth, slightly dampened with isopropyl alcohol, to
wipe off loosened ink deposits from the platen.

Note Isopropyl alcohol is not provided in the Maintenance Kit.
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Caution Do not use commercial cleaners or abrasive cleaners. Do not
wet the platen directly because you will leave too much moisture behind.
Do not wet the rubber wheels at all (not even with the cloth).

6. Clean the cutter ramp with the damp cloth.

7. Clean the exposed part of the wheels with a dry cloth. Ideally you should clean
the whole circumference of these wheels.

How do I lubricate the printhead carriage? 
The printhead carriage occasionally (about once a year) needs lubrication to slide
easily along the slider rod.

1. To gain access to the carriage, go to the front panel and select the  icon, then
Printheads > Replace printheads now. The carriage will slide into the middle
section of the printer.

Caution If the carriage is left in the central part of the printer for more
than seven minutes. it will try to move back to its normal position in the
right-hand end.

2. Take the bottle of oil from the Maintenance Kit that is supplied with your printer. A
replacement kit can be ordered if necessary.

3. Open the window and apply a few drops of oil from the Maintenance Kit to the
pads on either side of the carriage.
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4. Apply a few drops of oil directly to the slider rod on either side of the carriage.

How do I maintain the ink cartridges?  
During the normal lifetime of a cartridge, no specific maintenance is required.
However, in order to maintain the best print quality, you should replace a cartridge
when it has reached its expiration date, which is the date marked on the cartridge plus
6 months.

How do I move or store my printer? 
If you need to move your printer or store it for an extended period of time, you need to
prepare it properly to avoid possible damage to it. To prepare your printer, follow the
instructions below.
1. Do not remove the ink cartridges, printheads, or printhead cleaners.
2. Make sure that no paper is loaded.
3. Make sure that the printhead carriage is located in the service station (the right-

hand end of the printer).
4. Make sure that the front panel displays Ready.
5. Switch off the power using the Power key on the front panel.
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6. Also switch off the power switch at the rear of the printer.
7. Disconnect any cables connected to the printer.
8. Repack the printer in its original packaging.

How do I update my printer's firmware?
Your printer's various functions are controlled by software that resides in the printer,
otherwise known as firmware.

From time to time firmware updates will be available from Hewlett-Packard. These
updates increase your printer's functionality and enhance the features that your printer
already possesses. Firmware can be downloaded from the Internet and installed into
your printer using the Embedded Web Server's Firmware update page (found in the
Settings tab).

If you are unable to use the Embedded Web Server because you do not have a TCP/
IP connection to your printer (for instance, when using USB or Appletalk), you can
obtain firmware updates and installation software from these Web pages:

● http://www.hp.com/support/designjet/fw4000/ or
● http://www.hp.com/support/designjet/fw4000ps/
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11 How do I use the Image
Diagnostics Print?
● How do I print the Image Diagnostics Print?
● How do I respond to the Image Diagnostics Print?
● How do I interpret Image Diagnostics part 1?
● How do I interpret Image Diagnostics part 2?
● How do I interpret Image Diagnostics part 3?
● How do I proceed if I still have a problem?

How do I print the Image Diagnostics Print? 
The Image Diagnostics Print consists of patterns designed to highlight print quality
problems. It helps you to check whether you have a print quality problem, and if you
have, what the cause of the problem is and how to resolve it.

Before using the Image Diagnostics Print, check that you have been using appropriate
print quality settings (see How do I choose print quality settings?).

To print the Image Diagnostics Print:

1. Ensure that you have paper of at least A3 size (29.7 × 42 cm = 11.7 × 16.5 in)
loaded into the printer. Use the same paper type that you were using when you
detected a problem.

2. Ensure that the front panel has the same print quality settings that you were using
when you detected the problem (see How do I change the print quality?). In the
Image Diagnostics Print, the only difference between Drawings/text and Images
is that the latter uses more ink in part 2, so that the colors appear darker.
To print the Image Diagnostics Print will take about two minutes if you choose
Images; sometimes less if you choose Drawings/text (depending on the paper
type).

3. At the printer's front panel, select the  icon, then Information > Internal prints
> Print image diagnostics > Drawings/text or Images.

When the print is ready, see How do I respond to the Image Diagnostics Print?.
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How do I respond to the Image Diagnostics Print?
The Image Diagnostics Print is in three numbered parts.

1. Part 1 tests printhead alignment. See How do I interpret Image Diagnostics part 1?.
2. Part 2 tests printhead performance and the paper advance mechanism. See How

do I interpret Image Diagnostics part 2?.
3. If Part 2 has revealed a printhead problem, Part 3 identifies which of the eight

printheads is responsible for it. See How do I interpret Image Diagnostics part 3?.
If Part 2 has not revealed any problem, you can and should ignore Part 3.

How do I interpret Image Diagnostics part 1?
The purpose of part 1 is to identify color-to-color alignment and bidirectional alignment
problems.

If you have horizontal misalignment, you will see something like this:
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If you have vertical misalignment, you will see something like this:

If you have bidirectional misalignment, you will see something like this:

Corrective action
1. Align the printheads, using the same paper type with which you were

experiencing unacceptable print quality, if feasible (some paper types are not
suitable for printhead alignment). See How do I align the printheads?.

2. If there is no improvement in print quality, contact your customer service
representative.
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How do I interpret Image Diagnostics part 2?
The purpose of part 2 is to test whether the printheads and the paper advance
mechanism are working correctly. This part of the print should not be used to check
for color consistency or accuracy.

Banding
Banding has occurred when you see repetitive horizontal bands within the printed
image. They can appear as light bands:

or dark bands:
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or as a more gradual wave effect:

Horizontal bands across strips of one color only
If a printhead is faulty, you will see horizontal bands across strips of one color only; or
at least the horizontal bands will be much more noticeable in one color than in the
others.

Note Banding in the green strips is more difficult to see; and it may be caused
by a yellow printhead or by a cyan printhead. If you see banding only in the
green strip, it is caused by a yellow printhead; if you see banding in the green
and cyan strips, it is caused by a cyan printhead.

Corrective action
1. Check that you are using appropriate print quality settings. See How do I choose

print quality settings?.
2. Clean the printheads. See How do I recover (clean) the printheads?.
3. Reprint the Image Diagnostics Print. If you still see banding, continue with steps 4

and 5.
4. As there are two printheads for each color, check exactly which printhead is

responsible for the problem, using Part 3 of the Image Diagnostics Print. See Part 3.
5. Replace the printhead that shows the problem. See How do I remove a

printhead? and How do I insert a printhead?.
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Horizontal bands across all the colored strips
If the printer has paper advance problems you will see horizontal bands across all the
colored strips.

Note Banding in the green strips is more difficult to see.

Corrective action
1. Check that you are using appropriate print quality settings. See How do I choose

print quality settings?.
2. If you are using low-quality paper, try better-quality paper. The performance of

your printer can be guaranteed only if you use recommended papers. See How
do I select supported paper types?.

3. Perform paper advance calibration with the same paper type that you intend to
use for the final print. See How do I perform paper advance calibration?.

4. If there is no improvement in print quality, contact your customer service
representative.

How do I interpret Image Diagnostics part 3?
If part 2 has revealed a printhead problem, the purpose of part 3 is to identify which
particular printhead is faulty. Each rectangle in this plot is labelled with the number of
the printhead that produced it.
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Here are three examples of a black rectangle in close-up, showing the fine lines of
which it is made:

In the first two examples above, there are so many missing lines that the printhead
may be faulty. In the third case there are only a few missing lines, which are
acceptable, because the printer can compensate for such minor problems.

Corrective action
If part 3 shows a problem with one printhead, but part 2 shows no problem, there is no
immediate need to take any corrective action, because the printer is able to
compensate for the problem and maintain print quality. However, if part 2 also shows
a problem, continue as follows:

1. Clean the printheads. See How do I recover (clean) the printheads?.
2. If there is no improvement in print quality, replace the printhead that shows the

problem. See How do I remove a printhead? and How do I insert a printhead?.

How do I proceed if I still have a problem?
If the entire Image Diagnostics Print contains no defects and you still experience print
quality problems, here are some things to check:

● Try using a higher print quality option. See How do I choose print quality settings?
and How do I change the print quality?.

● Check the driver you are using to print with. If it is a non-HP driver, go to
http://www.hp.com/go/designjet/ and download the correct HP driver.

● If you are using a non-HP RIP, its settings may be incorrect. Refer to the
documentation that came with the RIP.

● Check that your printer's firmware is up to date. See How do I update my printer's
firmware?.

● Check that you have the right settings in your software application.
● If you are seeing a problem only at the top of the page, see The problem is a

defect near the start of a print.
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12 How do I perform paper
advance calibration?
Your printer was calibrated at the factory to ensure that it advances the paper
accurately when using supported paper types in normal environmental conditions.
However, you may find it useful to recalibrate in certain circumstances:
● Unsupported paper: different paper manufacturers provide papers with a wide

range of properties such as paper thickness or stiffness, which may benefit from
calibration. You can expect the best print quality when using HP's recommended
papers (see How do I select supported paper types?).

● Abnormal but stable environmental conditions: if you are printing in unusual
conditions of temperature or humidity (see Tell me about environmental
specifications), and those conditions are expected to remain stable, recalibration
may be worthwhile.

However, paper advance calibration assumes that you have an image quality problem
and that you have already followed the appropriate troubleshooting procedure for that
problem. If you have no particular problem, there is no need to perform the calibration.

Before performing paper advance calibration, use the Image Diagnostics Print to
check that the printheads are correctly aligned (see How do I print the Image
Diagnostics Print?).

Note In theory, paper advance calibration should improve print quality.
However, if you find the calibration print difficult to interpret, you may choose
the wrong paper advance setting and thus degrade print quality. In this case,
you can restore the original factory settings by selecting the  or  icon at
the front panel, and then Paper advance calibration > Drawings/text or
Images > Select Pattern > Factory Default.

Overview of the calibration process
1. Use the front panel to print a colored pattern stored in the printer seven times,

each time with a different paper advance setting.
2. Decide which pattern has been printed most successfully.
3. Use the front panel to tell the printer which pattern was best—and therefore which

paper advance setting to use in future.

Note 1 There are separate paper advance settings for each paper type name
in the front panel: each must be calibrated separately. When you calibrate a
particular paper type, the settings for all other paper types are unaffected.

Note 2 There are separate paper advance settings for Optimized for
drawings/text and Optimized for images: each must be calibrated separately.

Note 3 Papers from different manufacters may require different paper
advance settings even if they are of the same type, therefore the calibration
will be useful only for the particular paper you calibrated. Remember that,
when you perform the calibration, you will overwrite any previous paper
advance settings for this paper type.
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The calibration process in detail
1. Load the printer with the type of paper that you plan to use for printing

subsequently. The paper must be at least 41 cm wide (16 in) and 75 cm long (30
in).

2. Select the  or  icon, and then Paper advance calibration.

3. Select Drawings/text or Images, depending on the type of prints you wish to
make subsequently.

Note It is very important to use the same setting that you will later use
for printing in the driver, the Embedded Web Server, or the front panel
(Optimized for drawings/text or Optimized for images). Otherwise the
calibration has no effect.

4. Select Print Patterns. The printer will print a series of numbered patterns (1 to
7), each looking like this if you selected Drawings/text:

or like this if you selected Images:

5. The Drawings/text print takes about three minutes, the Images print takes about
five minutes. When the calibration print has finished printing, the printer will cut
the paper.

Chapter 12

184

H
ow

 d
o 

I p
er

fo
rm

 p
ap

er
 a

dv
an

ce
ca

lib
ra

tio
n?



6. Look at each of the printed patterns (1 to 7) and decide which one shows the best
quality. Each pattern has one part on the left that is a continuous color gradient
(A), and another part on the right (B). Either part can be used to help you decide
which is the best of the series of patterns; it will depend on your circumstances.
However, if you are using glossy paper or canvas, you are recommended to
ignore part A and make your selection by looking at part B only.
– In the color gradient, part A, you should look for light or dark horizontal bands

(banding), which indicate that the paper advance is not quite right. Usually
you will see dark bands across the first pattern and light bands across the
last pattern (see the examples below). The best pattern is one with no
banding; if in doubt, select the pattern in the middle, between the last pattern
with dark bands and the first pattern with light bands.
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If you find it difficult to identify the best pattern, the following scenario
descriptions may help you.
• Where you have only one pattern which is clearly the best and the ones

above and below contain light/dark bands, select this pattern.
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• Where you have two patterns next to each other which do not show
signs of banding, see below, use the patterns above and below these
two to help you select. For example, if the pattern above the two equal
ones contains less banding then choose the pattern just below it.

• Where you have three patterns which show no signs of banding, select
the middle pattern.

– If you look at part B of the print, you will probably see that it appears darker
in some patterns than in others. The best pattern is the one that appears
lightest, most uniform, and least grainy.

7. Select the  or  icon, and then Paper advance calibration > Drawings/text
or Images > Select Pattern.

8. Select the number of the pattern (1 to 7) that printed best. If you found it difficult
to choose between two patterns e.g. patterns 3 and 4, then select “Between
pattern 3 and 4”

The calibration is complete.

After calibration
If you find that the paper advance calibration has reduced but not eliminated your print
quality problem, you could try step 7 again and select a different number. If you are
seeing light bands, try selecting a lower number than your original selection; if you are
seeing dark bands, try a higher number.

If you later want to cancel your calibration and restore the paper advance setting with
which the printer left the factory, select the  or  icon, and then Paper advance
calibration > Drawings/text or Images > Select Pattern > Factory Default.
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13 The problem is print quality
● General advice
● The problem is banding (horizontal lines across the image)
● The problem is lines are missing or thinner than expected
● The problem is solid bands or lines printed over the image
● The problem is graininess
● The problem is the paper is not flat
● The problem is the print smudges when touched
● The problem is ink marks on the paper
● The problem is a defect near the start of a print
● The problem is lines are stepped
● The problem is lines are printed double or in wrong colors
● The problem is lines are discontinuous
● The problem is lines are blurred (ink bleeds from lines)
● The problem is lines are slightly warped
● The problem is color accuracy
● The problem is PANTONE color accuracy
● The problem is color matching between different HP Designjets

General advice 
When you have any print quality problem:

● To achieve the best performance from your printer, use only genuine
manufacturer's supplies and accessories, whose reliability and performance have
been thoroughly tested to give trouble-free performance and best-quality prints.
For details of recommended papers, see How do I select supported paper types?.

● Make sure that the paper type selected in the front panel is the same as the
paper type loaded into the printer. To check this, highlight the  or  icon on
the front panel.

● Bear in mind that roll paper will generally give better print quality than a single
sheet of the same kind of paper. When you are using single sheets of paper, we
strongly recommend that you always set the print quality to Best.

● Check that you are using the most appropriate print quality settings for your
purposes (see How do I choose print quality settings?). You are most likely to see
print quality problems if you have set the print quality to Fast.

● To maintain the best print quality at the expense of speed, change the Printhead
monitoring setting to Intensive. See How do I manage printhead monitoring?.

● Check that your environmental conditions (temperature, humidity) are suitable for
high-quality printing. See Tell me about environmental specifications.

The problem is banding (horizontal lines across the
image)   

If your printed image suffers from added horizontal lines as shown (the color may vary):
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1. Check that you are using appropriate print quality settings. See How do I choose
print quality settings?.

2. If the problem persists, clean the printheads. See How do I recover (clean) the
printheads?.

3. Consider changing to a heavier paper type: we recommend HP Heavyweight
Coated Paper or HP Productivity Photo Gloss when printing dense colors.

4. If the problem persists, use the Image Diagnostics Print to find out more about it.
See How do I use the Image Diagnostics Print?.

The problem is lines are missing or thinner than
expected  

1. Check that the line thickness and color settings are correct in your application.
2. Check that you are using appropriate print quality settings. See How do I choose

print quality settings?.
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3. If the problem persists, clean the printheads. See How do I recover (clean) the
printheads?.

4. Consider changing to a heavier paper type: we recommend HP Heavyweight
Coated Paper or HP Productivity Photo Gloss when printing dense colors.

5. If the problem persists, use the Image Diagnostics Print to find out more about it.
See How do I use the Image Diagnostics Print?.
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The problem is solid bands or lines printed over the
image 

This kind of problem can show itself in several different ways, illustrated below in
magenta:

1. A thick colored band
2. Thinner colored bands
3. Discontinuous colored blocks
4. Thin lines

In each case the recommended procedure is as follows:

1. Clean the electrical connections of the printhead that seems to be responsible (in
this example, the magenta printhead). See How do I clean a printhead's electrical
connections?.

2. Clean the printheads. See How do I recover (clean) the printheads?.
3. Reprint your image with the same settings as before.
4. If the problem persists, replace the printhead that seems to be causing the

problem. If you are not sure which printhead is responsible, use the Image
Diagnostics Print to identify it. See How do I use the Image Diagnostics Print?.

Chapter 13

192

Th
e 

pr
ob

le
m

 is
 p

rin
t q

ua
lit

y



The problem is graininess   

1. Check that you are using appropriate print quality settings. See How do I choose
print quality settings?.

2. Use the Image Diagnostics Print to find out more about the problem. See How do
I use the Image Diagnostics Print?.

The problem is the paper is not flat    
If the paper does not lie flat when it comes out of the printer, but has shallow waves in
it, you are likely to see visible defects in the printed image, such as vertical stripes.
This can happen when you use thin paper that becomes saturated with ink.

Try changing to a heavier paper type: we recommend HP Heavyweight Coated Paper
or HP Productivity Photo Gloss for printing dense colors. See also How do I choose
print quality settings?.

193

The problem
 is print quality



The problem is the print smudges when touched    
The black ink pigment can smudge when touched by a finger or pen. This is
particularly noticeable on the following materials: vellum, translucent bond, films,
productivity photo paper, and natural tracing paper.

To reduce the smudging:

● Try to print in an environment which is not too humid for the printer. See Tell me
about environmental specifications.

● Change pure black objects in your image to a dark color, such as dark brown, so
that they will be printed with colored inks instead of black ink.

● Use HP Heavyweight Coated Paper.
● Increase the drying time (see How do I change the drying time?).

The problem is ink marks on the paper   
This problem may occur for several different reasons.

Smears on the front of coated paper
If a lot of ink is used on coated paper, the paper absorbs the ink quickly and expands.
As the printheads move over the paper, the printheads come into contact with the
paper and the printed image is smeared.

Whenever you notice this problem, you should cancel the printing job immediately.
Press the Cancel key and also cancel the job from your computer application.
Otherwise the soaked paper may damage the printheads.

Try the following suggestions to avoid this problem:

● Use a recommended paper type (see How do I select supported paper types?).
● If the image you are printing contains intense color, try using HP Heavyweight

Coated Paper.
● Use extended margins (see How do I adjust the margins?), or try to increase the

margins by relocating the image within the page using your software application.
● If necessary, try changing to a non-paper-based material such as transparent film.

Smears or scratches on the front of glossy paper
Glossy paper may be extremely sensitive to the bin or to anything else that it contacts
soon after printing. This will depend on the amount of ink printed and the
environmental conditions at the time of printing. Avoid any contact with the paper and
handle the print with care.

It is a good idea to leave a sheet of paper in the bin so that freshly-printed sheets do
not make direct contact with the bin.

Ink marks on the back of the paper
Ink on the platen is likely to mark the back of the paper. See How do I clean the platen?.
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The problem is a defect near the start of a print   
There is a type of defect that affects only the start of a print, within 5.5 cm of the
leading edge of the paper. You may see a thin or thick band of inconsistent color:

To avoid this problem:

1. The easiest solution is to select the Extended Margins option in the driver, the
Embedded Web Server, or the front panel. This means that the area of the paper
affected by the problem (at the start of the page) will no longer be printed on. See
How do I adjust the margins?.

2. Check that you are using appropriate print quality settings. See How do I choose
print quality settings?.

The problem is lines are stepped  
If lines in your image appear stepped or jagged when printed:

1. The problem may be inherent in the image. Try to improve the image with the
application you are using to edit it.

2. Check that you are using appropriate print quality settings. See How do I choose
print quality settings?.

3. Turn on the Maximum Detail option.
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The problem is lines are printed double or in wrong
colors  

This problem can have various visible symptoms:
● Colored lines are printed double, in different colors.

● The borders of colored blocks are wrongly colored.

To correct this kind of problem:

1. Check that you are using appropriate print quality settings. See How do I choose
print quality settings?.

2. Align the printheads. See How do I align the printheads?.
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The problem is lines are discontinuous 
If your lines are broken in the following way:

1. Check that you are using appropriate print quality settings. See How do I choose
print quality settings?.

2. You are more likely to get good vertical lines with roll paper than with sheet
paper. If you must use sheet paper, set the print quality to Best.

3. Consider changing to a heavier paper type, such as HP Heavyweight Coated
Paper or HP Productivity Photo Gloss. SeeHow do I choose print quality settings?.

4. Align the printheads. See How do I align the printheads?.

The problem is lines are blurred (ink bleeds from lines)    
If you see that the ink is soaking into the paper, making the lines blurred and fuzzy,
this could be because of humidity in the air. Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for
high-quality printing. See Tell me about environmental specifications.

2. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or
HP Productivity Photo Gloss. SeeHow do I choose print quality settings?.

Note Glossy photo paper types are especially difficult to dry. Take extra
care with them.

3. Check that the paper type selected in the front panel is the same as the paper
type you are using.

4. Perhaps you have adjusted the drying time at the front panel to speed up the
printer output. Select the  icon, then Drying options > Drying time, and make
sure it is set to Optimal.

5. Allow the prints time to dry separately; do not cover or stack them.

The problem is lines are slightly warped    
The paper itself may be warped. This can happen if it has been used or stored in an
extreme environment. See Tell me about environmental specifications.
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The problem is color accuracy  
There are two basic requirements for color accuracy:

1. Ensure that your paper type has been calibrated, which will give you consistency
from print to print, and from printer to printer. See How do I perform color
calibration?.

2. Select suitable options in your application: see How do I get accurate colors from
my printer?.

Note If you are not using PostScript, remember that your printer may be
configured to use one of its internal pen palettes instead of your software's
palette (which is the default). See The problem is pen settings seem to have
no effect.

Color accuracy using EPS or PDF images in page layout applications
Page layout applications such as Adobe InDesign and QuarkXPress do not support
color management of EPS, PDF, or grayscale files.

If you have to use such files, try to ensure that the EPS, PDF, or grayscale images are
already in the same color space that you intend to use later on in Adobe InDesign or
QuarkXPress. For instance, if your final goal is to print the job in a press that follows
the SWOP standard, at the time of creating the EPS, PDF or grayscale you should
convert the image into SWOP.

The problem is PANTONE color accuracy  
Spot colors are special premixed inks to be used directly in the press, and the best–
known spot colors are PANTONE colors.

If you have the PostScript model, your printer provides a facility called Automatic
PANTONE Calibration, which can easily match most of the PANTONE Solid Coated
spot colors. When an application sends a PANTONE color to print, it sends the
PANTONE name together with its own estimate of equivalent CMYK values. The
Automatic PANTONE Calibration facility recognizes the PANTONE name and
converts it to CMYK in a way that depends on the printer model and the selected
paper type, enabling the color to be rendered with greater precision than is possible
with the generic CMYK values sent by the application.

Even when using Automatic PANTONE Calibration, you cannot expect the printer to
match the PANTONE colors exactly. Your printer is certified by Pantone for some
papers, but this does not mean that it can reproduce 100% of the PANTONE colors.

Using Automatic PANTONE Calibration (the best choice)
In order to use Automatic PANTONE Calibration, you need an application that
recognizes the PANTONE colors, and a calibrated PostScript printer.

The Automatic PANTONE Calibration facility emulates PANTONE Solid Coated colors
only (suffix C). Other PANTONE colors will be printed using the CMYK values sent by
the application.
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Converting PANTONE colors manually
If you have a non–PostScript printer, or if you are using an application (such as Adobe
Photoshop) that does not send the name of the PANTONE color to the printer, you will
not be able to use Automatic PANTONE Calibration. Instead, if you wish, you can
convert each PANTONE color manually to CMYK values in the application, using
tables produced especially for your printer and paper type.

If your application has a facility to convert PANTONE colors to CMYK values
automatically, it probably does not take account of printer or paper type, so you will
get better results with a manual conversion using the tables.

You can also obtain a PANTONE calibrated color chart in EPS, TIFF, and PDF
format, which can be convenient if your application has an eyedropper tool with which
you can pick up colors from an imported graphic.

Tips
● Automatic PANTONE Calibration works with PostScript printers only.
● Ensure that Automatic PANTONE Calibration is turned on in the driver.
● Some applications may not support PANTONE colors fully; for example,

Photoshop 7.0 does not send the PANTONE Color with its name, it sends only
the CMYK values from its standard table.

● Some colors may be out of gamut and impossible to match precisely with your
printer and paper type.

The problem is color matching between different HP
Designjets 

If you print an image on two different printer models (for instance, on an HP Designjet
4000 Printer series and an HP Designjet 1000 Printer series), you may find that the
colors of the two prints do not match well.
Matching two printing devices that use different ink chemistry, paper chemistry, and
printheads is unlikely to be completely successful. The information provided here is
the best way to emulate one printer with another. Even so, the end result may not be
a perfect match.

Printing via separate PostScript drivers
The situation is that you are printing on each printer using the PostScript driver
installed for that printer. In this example, we are using an HP Designjet 4000 Printer
series and an HP Designjet 1000 Printer series.

1. Ensure that both printers have been updated to the latest firmware version. See
How do I update my printer's firmware?.

2. Ensure that you have the latest printer driver for both printers. You can download
the latest versions for any HP printer from http://www.hp.com/go/designjet.

3. Ensure that Color Calibration is turned on. At the front panel of the HP Designjet
4000 series, select the  icon, then Configuration menu > Color Calibration
> On .

4. Load the printers with similar paper types.
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5. Ensure that the Paper Type setting on the front panel corresponds to the paper
you have loaded.

6. Print your image on the HP Designjet 1000 Printer series using your normal
settings.

7. Now prepare to print the same image on the HP Designjet 4000 Printer series.
8. In your application, set the color space of the image to emulate the HP Designjet

1000 Printer series and the specific paper type that you used in that printer. The
data sent to the driver must be already converted to this emulation color space,
which is a CMYK color space. See your application's online help for information
on how to do this. In this way, the 4000 series will emulate the colors that the
1000 series can produce when printing on that paper type.

9. In the PostScript driver for the HP Designjet 4000 Printer series, go to the Color
Management section and set the CMYK input profile to the same HP Designjet
1000 Printer series color space that you selected in the application (the emulation
color space).

Note When trying to emulate another printer you should always use
CMYK colors, not RGB.

10. Set the rendering intent to Relative Colorimetric, or to Absolute Colorimetric if you
want to emulate the whiteness of the paper.

11. Print the image on the HP Designjet 4000 Printer series.

Printing via separate HP-GL/2 drivers
The situation is that you are printing on each printer using the HP-GL/2 driver installed
for that printer.

1. Ensure that both printers have been updated to the latest firmware version. See
How do I update my printer's firmware?.

2. Ensure that you have the latest printer driver for both printers. You can download
the latest versions for any HP printer from http://www.hp.com/go/designjet.

3. Ensure that Color Calibration is turned on. At the front panel of the HP Designjet
4000 Printer series, select the  icon, then Configuration menu > Color
Calibration > On .

4. Load the printers with similar paper types.
5. Ensure that the Paper Type setting on the front panel corresponds to the paper

you have loaded.
6. With the HP-GL/2 driver for the HP Designjet 4000 Printer series, select the Color

tab, and set the Color Matching Method to sRGB.
7. With the HP-GL/2 driver for the HP Designjet 1000 series, select the Options tab,

then Manual Color > Color Control > Match Screen. You should also select the
Paper Size tab, then Paper Type, and select an Enhanced Colors paper type.

Printing the same HP-GL/2 file
The situation is that you have produced an HP-GL/2 file (also known as a PLT file)
using the HP-GL/2 driver installed for one printer, and you intend to send the same file
to both printers.

1. Ensure that both printers have been updated to the latest firmware version. See
How do I update my printer's firmware?.
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2. Ensure that Color Calibration is turned on. At the front panel of the HP Designjet
4000 Printer series, select the  icon, then Configuration menu > Color
Calibration > On .

3. Load the printers with similar paper types.
4. Ensure that the Paper Type setting on the front panel corresponds to the paper

you have loaded.
5. If you have an HP-GL/2 file produced for an HP Designjet 1000 Printer series and

you want to print it on an HP Designjet 4000 Printer series, proceed as follows
using the Embedded Web Server or the front panel.
– Using the Embedded Web Server: in the Color Management section of the

Submit Job page, set the Input Profiles: RGB to None (Native).
– Using the front panel: select the  icon, then Printing defaults menu >

Color Options > RGB Input Profile: None (Native).
For other HP Designjet Printers, set both printers to match the screen colors
(sRGB if selectable), as when printing with separate HP-GL/2 drivers.
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14 The problem is an image error
● The problem is the print is completely blank
● The problem is the output contains only a partial print
● The problem is the image is clipped
● The problem is the image is in one portion of the printing area
● The problem is the image is unexpectedly rotated
● The problem is the print is a mirror image of the original
● The problem is the print is distorted or unintelligible
● The problem is one image overlays another on the same sheet
● The problem is pen settings seem to have no effect

The problem is the print is completely blank  
If the front-panel graphic language setting is Automatic (the default), try the other
settings: PostScript for a PostScript file, HP-GL/2 for an HP-GL/2 file, etc. (see How
do I change the graphic language setting?). Then send the file again.

When you have finished this particular print, remember to reset the graphic language
to Automatic.

The problem is the output contains only a partial print    
● Did you press Cancel before all the data were received by the printer? If so, you

have ended the data transmission and will have to print the page again.
● The I/O timeout setting may be too short. From the front panel, you can increase

the I/O timeout setting to a longer period and then send the print again. Select
the  icon, then I/O setup > I/O timeout.

● There may be a communications problem between your computer and the printer.
Check your interface cable.

● Check to make sure that your software settings are correct for your current page
size (e.g. long-axis prints).

● If you are using network software, make sure it has not timed out.
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The problem is the image is clipped   
This normally indicates a discrepancy between the actual printable area on the loaded
paper and the printable area as understood by your software.

● Check the actual printable area for the paper size you have loaded.
printable area = paper size – margins
The Windows HP-GL/2 driver displays the printable area in the Paper/Quality tab.

● Check what your software understands to be the printable area (which it may call
"printing area" or "imageable area"). For example, some software applications
assume standard printable areas that are larger than those used in this printer.

● If you are trying to print a very long image on a roll, check that your software is
capable of printing an image of that size.

● Check that the orientation of the paper is the same as that assumed by your
software. The front-panel Printing defaults menu > Paper options > Rotate
option changes both the orientation of a print and the orientation of the page. It is
possible that a rotated image on a roll may be slightly clipped in order to retain
the correct page size.

● You may have asked to rotate the page from portrait to landscape on a paper
size that is not wide enough.

● If necessary, change the printable area in your software.

There is another possible explanation for a clipped image. Some applications, such as
Adobe Photoshop, Adobe Illustrator, and CorelDRAW, use an internal 16–bit
coordinate system which means that they cannot handle an image of more than
32,768 pixels. If you try to print an image larger than this from these applications, the
bottom of the image will be clipped. In this case, the only way to print the whole image
is to reduce the resolution so that the whole image requires fewer than 32,768 pixels.
The HP-GL/2 printer driver contains an option called Compatibility with 16–bit
applications, which can be used to reduce the resolution of such images
automatically. You can find this option by clicking the Troubleshooting button in the
driver's Services tab.

The problem is the image is in one portion of the printing
area  

● Have you selected too small a page size in your application?
● Does your application think that the image is in one portion of the page?
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The problem is the image is unexpectedly rotated  
At the front panel, select the  icon, then Printing defaults menu > Paper options
> Rotate. Check that the setting is what you wanted.

For non-PostScript files: if Nesting is On, pages may be automatically rotated to save
paper. See How do I rotate an image?.

The problem is the print is a mirror image of the original  
At the front panel, select the  icon, then Printing defaults menu > Paper options
> Mirror. Check that the setting is what you wanted.

The problem is the print is distorted or unintelligible        
● The interface cable connecting your printer to your network (or to your computer)

could be faulty. Try another cable.
● If the front-panel graphic language setting is Automatic (the default), try the other

settings: PostScript for a PostScript file, HP-GL/2 for an HP-GL/2 file etc. (see
How do I change the graphic language setting?). Then send the file again.

● Depending on the software, drivers, and RIPs you are using with your printer,
there will be different ways of solving this problem. Refer to the vendor's user
documentation for details.
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The problem is one image overlays another on the same
sheet    

The I/O timeout setting may be too long. From the front panel, decrease the setting
and print again. Select the  icon, then I/O setup > I/O timeout.

The problem is pen settings seem to have no effect    
Here are some possible explanations:

● You have changed the settings in the front panel by selecting the  icon
followed by Printing defaults menu > HP-GL/2 settings > Define palette, but
you have forgotten to select that palette in Printing defaults menu > HP-GL/2
settings > Palette.

● If you want the software-driven pen settings, you must remember to go to the
front panel and select the  icon followed by Printing defaults menu > HP-
GL/2 settings > Palette, and set it to Software.
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15 The problem is with the ink
system
● The problem is I cannot insert an ink cartridge
● The problem is I cannot insert a printhead
● The problem is I cannot insert a printhead cleaner
● The problem is the front panel keeps telling me to reseat or replace a printhead
● The problem is an ink cartridge status message
● The problem is a printhead status message
● The problem is a printhead cleaner status message

The problem is I cannot insert an ink cartridge   
1. Check that you have the correct type of cartridge (model number).
2. Check that the colored label on the cartridge is the same color as the label on the

slot.
3. Check that the cartridge is correctly oriented, with the colored label at the top.

Caution Never clean inside the ink cartridge slots.

The problem is I cannot insert a printhead 
1. Check that you have the correct type of printhead (model number).
2. Check that you have removed the blue protective cap and the clear protective

tape from the printhead.
3. Check that the colored label on the printhead is the same color as the label on

the slot.
4. Check that the printhead is correctly oriented (compare with the others).
5. Check that you have closed and latched the printhead cover.

The problem is I cannot insert a printhead cleaner   
1. Check that you have the correct type of cleaner (model number).
2. Check that the colored label on the cleaner is the same color as the label on the

slot.
3. Check that the cleaner is correctly oriented (compare with the others).

The problem is the front panel keeps telling me to reseat
or replace a printhead 

1. Remove the printhead and check that its protective film has been removed.
2. Try cleaning the electrical connections between the printhead and the carriage.

See How do I clean a printhead's electrical connections?.
3. Reinsert the printhead into the carriage and check the front panel message.
4. If the problem remains, try a new printhead.
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The problem is an ink cartridge status message
These are the possible ink cartridge status messages:

● OK: the cartridge is working normally, with no known problems
● Missing: there is no cartridge present, or it is not properly connected to the printer
● Low: the ink level is low
● Very low: the ink level is very low
● Empty: the cartridge is empty
● Reseat: you are recommended to remove the cartridge and then reinsert it
● Replace: you are recommended to remove the cartridge and then reinsert it; if

that fails, replace the cartridge with a new cartridge
● Altered: there is something unexpected about the cartridge's status—perhaps it

has been refilled

The problem is a printhead status message
These are the possible printhead status messages:

● OK: the printhead is working normally, with no known problems
● Missing: there is no printhead present, or it is not properly installed in the printer
● Reseat: you are recommended to start the printhead removal process from the

front panel (see How do I remove a printhead?), but instead of removing the
printhead, just press the Select key on the front panel

● Replace: you are recommended to remove the printhead and then reinsert it; if
that fails, clean the electrical connections; if that fails, replace the printhead with a
new printhead

● Remove: the printhead is not a suitable type for use in printing (for instance, a
setup printhead)

The problem is a printhead cleaner status message
These are the possible printhead cleaner status messages:

● OK: the cleaner is working normally, with no known problems
● Missing: there is no cleaner present, or it is not properly installed in the printer
● Reseat cleaner: you are recommended to remove the cleaner and then reinsert it
● Wrong stall: the cleaner has been installed in the wrong place
● End of life: the cleaner has reached the end of its planned lifetime
● Not replaced with printhead: you have installed a new printhead without

installing the new cleaner that came with it

If a printhead cleaner needs to be removed or reseated, you must start the printhead
replacement process (see How do I remove a printhead?). Open the window when
prompted to do so by the front panel. If the front panel shows the printheads with no
printhead blinking, you do not need to touch the printheads. Just close the window
again, and the printer will proceed to printhead cleaner replacement.
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16 The problem is with the paper
● The problem is the paper cannot be loaded successfully
● The problem is a paper jam (paper stuck in the printer)
● The problem is prints do not stack properly in the bin
● The problem is the printer uses a lot of paper to align the printheads

The problem is the paper cannot be loaded
successfully     

● The paper may be loaded at an angle (skewed). Check that the right-hand edge
of the paper is aligned with the half-circle on the right-hand side of the platen and,
particularly in the case of sheet paper, that the leading edge is aligned with the
metal bar in the platen.

● The paper may be crumpled or warped, or may have irregular edges.

Rolls
● If the paper gets stuck in the paper path to the platen, it may be that the leading

edge of the paper is not straight or clean, and needs to be trimmed. Remove the
initial 2 cm (1 in) from the roll and try again. This may be necessary even with a
new roll of paper.

● Check that the spindle is correctly inserted. The blue spindle lever on the right
should be in the horizontal position.

● Check that the paper is correctly loaded on the spindle, and that it loads over the
roll towards you.

● Check that the paper is wound tightly on the roll.

Sheets
● Check that the leading edge of the sheet is aligned with the cutter channel in the

platen.
● Do not use hand-cut sheets, which may be of irregular shapes. Use only

purchased sheets.
Here is a list of front panel messages related to paper loading, with the suggested
corrective action.

Front panel message Suggested action

Right edge of roll too far
from load line.

The roll has not been loaded correctly, the right–
hand edge was not aligned with the half–circle on
the platen. Press the Select key to try to load the
roll again.

Right edge of sheet too
far from load line.

The sheet has not been loaded correctly, the right–
hand edge was not aligned with the half-circle on
the platen. Press the Select key to try to load the
sheet again.
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Front panel message Suggested action

Right edge not found. The printer cannot locate the right–hand edge of
the paper, the paper may be badly positioned.
Press the Select key and try to load the roll again.

Sheet edge not found. The printer cannot locate the edges of the paper,
the paper may be badly positioned. Press the
Select key and try to reload the sheet.

Paper not found. During the paper load process the printer did not
detect any paper. Press the Select key to retry.

Paper loaded with too
much skew.

During the paper load process the printer detected
that the paper had too much skew. Press the
Select key to try to load the paper again.

Paper too small. During the load process the printer detected that
the paper is too narrow or too short to be loaded in
the printer. Press the Cancel key to stop the load
process. See Tell me about functional specifications.

Paper too big During the load process the printer has detected
that the paper is either too wide or too long (sheet
only) to be loaded properly. Press the Cancel key
to stop the load process. See Tell me about
functional specifications.

Sheet too long. During the load process the printer has detected
that the sheet is too long to be loaded properly.
Make sure that the printer expects sheet and not
roll. Press the Select key to try to load the paper
again. See Tell me about functional specifications.

Lever lifted. During the load process the blue paper load lever
was lifted. This prevents the printer from loading
the paper. Press the Select key to load the paper
again.
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The problem is a paper jam (paper stuck in the printer)
When a paper jam occurs, you will normally see the Possible paper jam message in
the front panel, with one of two error codes:

● 81:01 indicates that paper cannot advance into the printer.
● 86:01 indicates that the printhead carriage cannot move from side to side.

Check printhead path
1. Switch off the printer using the switch at the rear.

2. Open the window.
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3. Try to move the printhead carriage out of the way.

4. Lift the paper load lever as far up as it will go.

5. Carefully remove any of the jammed paper that you can lift up and out from the
top of the printer.

6. Carefully pull the rest of the roll or sheet down and out of the printer.
7. Switch on the printer.
8. Reload the roll, or load a new sheet. See How do I load a roll into the printer? or

How do I load a single sheet?.
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9. If you find that there is still some paper causing an obstruction within the printer, it
can often be cleared by loading a rigid paper type into the printer.

10. If you find that you have print quality problems after a paper jam, try realigning
the printheads. See How do I align the printheads?.

Check paper path
● This problem can occur when a roll has finished and the end of the roll is stuck to

the cardboard core. If this has happened, cut the end of the roll away from the
core; you should then be able to feed the paper through the printer, and load a
new roll.

● Otherwise, follow the procedure described above, under Check printhead path.

The problem is prints do not stack properly in the bin  
● Lift up the three loop stoppers when printing small sheets.
● Paper often tends to curl near the end of a roll, which can cause stacking

problems. Load a new roll, or remove prints manually as they are completed.
● If you are mixing prints or nesting sets of several different sizes, you may have

stacking problems because of the different sizes of paper in the bin.

The problem is the printer uses a lot of paper to align the
printheads

In order to align the printheads accurately, the printer sometimes needs to feed
through up to 3 m (≈10 ft) of paper before starting the printhead alignment process.
This is normal behavior and you should not try to interrupt or prevent it. See How do I
align the printheads?.

213

The problem
 is w

ith the paper



Chapter 16

214

Th
e 

pr
ob

le
m

 is
 w

ith
 th

e 
pa

pe
r



17 The problem is something else
● The problem is the printer's start–up process does not complete
● The problem is a front panel message
● The problem is a “printhead monitoring” message
● The problem is a “printheads are limiting performance” message
● The problem is the printer does not print
● The problem is a print job is waiting for a time-out
● The problem is the printer seems slow
● The problem is communication failures between computer and printer
● The problem is I cannot access the Embedded Web Server from my browser
● The problem is an out-of-memory error
● The problem is an AutoCAD 2000 memory allocation error
● The problem is the platen rollers squeak

The problem is the printer's start–up process does not
complete

If the printer's start-up process stops when the front panel is displaying the number
17, this indicates that there is a problem with the file system on the printer's hard disk,
so the printer is checking the whole file system and making any necessary
corrections. This problem can arise when there has been a power cut while the printer
was switched on, or if there is a physical problem with the hard disk.

Checking the whole file system normally takes about half an hour. There is nothing
you can do to speed it up. If you turn off the printer, the file system check will restart
whenever you turn it on again.

If you experience this problem repeatedly when there has been no power cut, contact
your customer service representative.

The problem is a front panel message    
The front panel displays messages of many kinds; some allow you to continue using
the printer while others require you to take action before you can continue.

● If the printer detects a condition of which you should be aware, it displays a
message for your information. Examples of information messages are
performance limiting conditions, and printer maintenance requirements. Once you
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have read the message you can remove it by pressing the Select key and
continue to use the printer.

● If the printer detects an error, an error code and short message are displayed on
the front panel. The following table provides suggested actions to recover from
these error conditions:

Code Short message Suggested action

13:01 Reseat all cartridges Remove and re-insert all the print
cartridges; see How do I remove an ink
cartridge? and How do I insert an ink
cartridge? for help. If the problem
persists, please contact your customer
service representative.

26.0:01 Reseat yellow cartridge The yellow cartridge is not detected,
please try to re-install it; see How do I
remove an ink cartridge? and How do I
insert an ink cartridge?. If the problem
persists, please contact your customer
service representative.

26.1:01 Reseat magenta cartridge The magenta cartridge is not detected,
please try to re-install it; see How do I
remove an ink cartridge? and How do I
insert an ink cartridge?. If the problem
persists, please contact your customer
service representative.

26.2:01 Reseat black cartridge The black cartridge is not detected,
please try to re-install it; see How do I
remove an ink cartridge? and How do I
insert an ink cartridge?. If the problem
persists, please contact your customer
service representative.

26.3:01 Reseat cyan cartridge The cyan cartridge is not detected, please
try to re-install it; see How do I remove an
ink cartridge? and How do I insert an ink
cartridge?. If the problem persists, please
contact your customer service
representative.

27:03 Restart the printer. If
problem persists, call HP
support.

An error has been detected during
printhead detection. Reseat all the
printheads; see How do I remove a
printhead? and How do I insert a
printhead? and How do I restart the
printer? for help. If the problem persists,
please contact your customer service
representative.

Chapter 17

216

Th
e 

pr
ob

le
m

 is
 s

om
et

hi
ng

 e
ls

e



Code Short message Suggested action

61:01 Wrong file format. The
printer cannot process the
job.

The file format is wrong and the printer
cannot process the job. Check the graphic
language setting of your printer (see How
do I change the graphic language
setting?). If you are sending PostScript
from Mac OS over a USB connection,
select ASCII encoding in both the driver
and the application. Check for the latest
firmware and driver releases.

61:04.1 Update system software
(firmware)

Even if you have the latest version
installed on your printer, you are
recommended to repeat the update
process to clear this error. See How do I
update my printer's firmware?.

61:08.1 File with password cannot
be printed.

Resend this file without password
protection.

62:04 Restart the printer. If
problem persists, call HP
support.

An error has been detected with the
parallel port. See How do I restart the
printer? If the problem persists, check for
the latest firmware release.

63:04 Restart the printer. If
problem persists, call HP
support.

An error has been detected with a LAN
port. See How do I restart the printer? If
the problem persists, check for the latest
firmware release.

64:04 Restart the printer. If
problem persists, call HP
support.

An error has been detected with the USB
port. See How do I restart the printer? If
the problem persists, check for the latest
firmware release.

66:08 Please resubmit the job as
the paper type has changed

The paper type has changed since the job
was submitter. The job cannot be printed
on the paper that is loaded; please
resubmit the job or change the paper.

71:03 Restart the printer. If
problem persists, call HP
support.

Out of memory failure. You are
recommended to remove any
unnecessary files from the hard disk using
the Embedded Web Server. See How do I
restart the printer?.

76:03 Restart the printer. If
problem persists, call HP
support.

The hard disk is full. If the problem
persists, you are recommended to
remove any unnecessary files from the
hard disk, using the Web server. See How
do I restart the printer?.

(continued)
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Code Short message Suggested action

77:04 Restart the printer. If
problem persists, call HP
support.

The Embedded Web Server does not
seem to be working. See How do I restart
the printer? If the problem persists, check
for the latest firmware release.

81:01 Possible paper jam See The problem is a paper jam (paper
stuck in the printer) for help.

86:01 Possible paper jam See The problem is a paper jam (paper
stuck in the printer) for help

If your printer front panel is displaying an error code which is not in the list above, try
the following: restart the printer see How do I restart the printer? and/or check to make
sure you have the latest firmware and driver versions; see How do I update my
printer's firmware? for help. If the problem persists, contact your customer service
representative.

The problem is a “printhead monitoring” message
This is not an error message. The message is displayed whenever the Printhead
monitoring option is set to Intensive. If you change the setting to Optimized, the
message wil not appear. See How do I manage printhead monitoring?.

The problem is a “printheads are limiting performance”
message

This message appears on the front panel during printing when the printer has
detected that one or more printheads are not performing optimally, and so it needs to
make extra passes to maintain print quality. To eliminate this message, choose one of
the following:

● Select a higher print quality; see How do I change the print quality?.
● Clean the printheads; see How do I recover (clean) the printheads?.
● Use the Image Diagnostics Print to identify which printhead is causing the

problem; see How do I use the Image Diagnostics Print?.

The problem is the printer does not print
Here are some possible explanations. See also The problem is a print job is waiting
for a time-out.

● You may have an electrical power problem. If there is no activity at all from the
printer, and the front panel does not respond, check that the power cable is
connected correctly and that there is power available at the socket.

● In the presence of unusual electromagnetic phenomena, such as strong
electromagnetic fields or severe electrical disturbances, the printer may behave
strangely, or even stop working. In this case, turn off the printer using the Power
key on the front panel, wait until the electromagnetic environment has returned to
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normal, and then turn it on again. If you still experience problems, please contact
your customer service representative.

● Ensure that the graphic language setting is correct. See How do I change the
graphic language setting?.

● Have you installed in your computer the correct driver for your printer? See the
Setup instructions.

● If you are using Mac OS with a FireWire or USB connection, you may find that
you need to change the data encoding. Select the  icon, then Printing
defaults menu > PS options > Encoding > ASCII. Then configure your
application to send ASCII data.

The problem is a print job is waiting for a time-out
If all is in order (paper loaded, all ink components installed, and no file errors), there
are still reasons why a file you have sent from your computer may not start printing
when expected:

● The print file may lack a proper file terminator and the printer is therefore waiting
for the specified I/O time-out period before assuming it is complete.

If you are using Mac OS with a FireWire or USB connection, select the  icon,
then Printing defaults menu > PS options > Encoding > ASCII. Then configure
your application to send ASCII data.

● Nesting may be on and the printer is waiting for the specified nest wait time-out
period before calculating the appropriate nests. In this case, the printer display
shows the remaining time for the nesting time-out.

● You may have requested a print preview from your printer driver. This is a
function you can use to check that the image is the one you want. In this case,
the preview is displayed in a Web browser window, and you must click a button to
start printing.

The problem is the printer seems slow
Here are some possible explanations.

● Did you set the print quality to Best? Best-quality prints take longer.
● Did you specify the correct paper type when loading the paper? To find out the

printer's current paper type setting, see How do I view information about the paper?.
● Are you using the printer with the Appletalk serial port on a Macintosh computer?

It is normal for the Appletalk port to be slow. Consider using the Ethertalk
interface to connect your printer to your Macintosh.

● Do you have a network connection to your printer? Check that all components
used in the network (network interface cards, hubs, routers, switches, cables) are
capable of high-speed operation. Is there a lot of traffic from other devices on the
network?

● Did you specify Extended drying time in the front panel? Try changing the drying
time to Optimal; see Tell me about drying time.

● Are your printheads in good condition? The printer may print slower to maintain
print quality when a printhead is faulty. Check the printhead status in the front
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panel or in the Embedded Web Server, and recover or replace printheads if
necessary.

● Do you have high-density black areas in your image? In this case, the printer may
change temporarily to a slower print quality option in order to maintain quality.

The problem is communication failures between
computer and printer

Some symptoms are:

● The front-panel display does not show the “Receiving” message when you have
sent an image to the printer.

● Your computer displays an error message when you are trying to print.
● Your computer or printer “hangs” (stays idle) while communication is taking place.
● Your printed output shows random or inexplicable errors (misplaced lines, partial

graphics etc.)

To solve a communication problem:

● Ensure that you have selected the correct printer in your software.
● Ensure that the printer works correctly when printing from other software.
● Remember that very large prints may take some time to receive, process, and

print.
● If the printer is connected to a network, try using it when connected directly to

your computer through a FireWire or USB cable.
● If your printer is connected to your computer through any other intermediate

devices, such as switch boxes, buffer boxes, cable adapters, cable converters,
etc., try using it when connected directly to your computer.

● Try another interface cable. For details of supported cables, see “Interface
specifications”.

● Ensure that the graphic language setting is correct. See How do I change the
graphic language setting?.

The problem is I cannot access the Embedded Web
Server from my browser 

If you have not done so already, please read How do I access the Embedded Web
Server?.

● Have you set a password for the Embedded Web Server, and then forgotten the
password? If so, select the  icon, then Configuration menu > Reset EWS
password.

● At the printer's front panel, select the  icon, then Configuration menu > Allow
EWS. If this option is off, turn it on.

● Check that you have a TCP/IP (network or FireWire) connection to your printer. If
you connect directly to your printer with a USB cable, you cannot use the
Embedded Web Server.

● If you are using a FireWire connection, make sure that your computer's operating
system supports IP over IEEE-1394 (FireWire). For example, Windows XP and
Windows 2003 Server support IP over FireWire, but Windows 2000 does not.
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Mac OS X 10.3 also supports IP over FireWire (see How do I access the
Embedded Web Server?). Make sure that your operating system is configured to
use IP over FireWire.

● At the printer's front panel, check that IP is enabled for the type of connection you
are using. Select the  icon, then I/O setup, then the type of connection you are
using, and check that you see IP enabled. If not, you may need to use a different
type of connection.

● If you normally access the Web through a proxy server, try bypassing the proxy
server and accessing the Web server directly. You can do this by modifying your
browser settings.
For instance, if you are using Internet Explorer 6 for Windows, go to Tools >
Internet Options > Connections > LAN Settings, and check the 'Bypass proxy
server for local addresses' box. Alternatively, for more precise control, click the
Advanced button and add the printer's IP address to the list of Exceptions for
which the proxy server is not used.

● Try switching off the printer (with the Power key on the front panel) and then
switching it on again.

The problem is an out-of-memory error 
There is no direct relationship between the size of a file in your computer and the
amount of memory needed in the printer to print the file. In fact, because of file
compression and other complicating factors it is often impossible to estimate how
much memory will be needed. So it is possible that a print will fail for lack of memory
even though you may have successfully printed larger files in the past. In this case
you may need to consider adding more memory to your printer.

If you are using the Windows HP-GL/2 driver, you can often solve printer memory
problems by selecting the Services tab, then Troubleshoot software problems, then
Print job as a bitmap (process in computer).

Note If you select this option, the time needed to process the job in your
computer may be considerably longer.

The problem is an AutoCAD 2000 memory allocation error
After installing the printer driver, when you try to print for the first time from AutoCAD
2000, you may see a message saying Memory allocation error, after which your
image is not printed.

This is due to a problem in AutoCAD 2000, and it can be fixed by downloading the
Plotting Update Patch (plotupdate.exe) from the Autodesk Web site,
http://www.autodesk.com/.

This patch is also worth trying if you have any other strange problems when printing
from AutoCAD 2000.
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The problem is the platen rollers squeak  
It may occasionally be necessary to oil the rollers. The Maintenance Kit, which came
with your printer, contains a bottle of suitable oil.

1. Open the window.

2. There are small holes in the platen beside some of the rollers.
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Using the bottle of oil supplied with the Maintenance Kit, insert the pointed end of
the bottle into each hole in turn, and put three drops of oil into each hole.

3. Repeat the process until all of the holes in the platen have had three drops of oil
placed in them.

4. Be careful not to spill oil onto the platen.
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5. If there is oil on the platen, wipe it away with the cloth supplied with the kit.

6. Lower the window.
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18 Tell me about the printer
● Tell me about color emulation modes
● Tell me about connecting the printer
● Tell me about the printer's rear lights
● Tell me about the printer's internal prints
● Tell me about preventive maintenance

Tell me about color emulation modes   
Your printer can emulate the color behavior of other devices: RGB devices such as
monitors, and CMYK devices such as presses and printers. See How do I select the
color emulation mode?.

If you have problems making your printer emulate another HP Designjet printer,
seeThe problem is color matching between different HP Designjets.

For a good emulation, the printer needs a specification of the colors these devices can
reproduce. The standard way of encapsulating such information is in ICC profiles. As
part of the solution, we provide the most common standards for the different devices.
Apart from selecting the appropriate ICC profile, you should select the appropriate
rendering intent depending on the type of print: business presentation, photography,
or proof. See How do I set the rendering intent?. For reference information on the
broader aspects of color printing refer to: http://www.hp.com/hpinfo/community/
environment/productinfo/psis_inkjet.htm

The options are as follows.

Note PDF and PostScript files can be used with PostScript printers only.

CMYK color emulation
All CMYK emulation options apply to PDF, PostScript, TIFF, and JPEG files only.

● None (Native): no emulation, for use when the color conversion is done by the
application or operating system, and therefore the data arrive at the printer
already color–managed.

● HP CMYK Plus: a set of HP proprietary re-rendering rules that will produce a
good result for most digital commercial printing jobs, by expanding the reduced
gamut of your press into the wider gamut of your printer.

● U.S. Sheetfed Coated 2 uses specifications designed to produce quality
separations using U.S. inks under the following printing conditions: 350% total
area of ink coverage, negative plate, bright white offset stock

● U.S. Sheetfed Uncoated 2 uses specifications designed to produce quality
separations using U.S. inks under the following printing conditions: 260% total
area of ink coverage, negative plate, uncoated white offset stock

● U.S. Web Coated (SWOP) 2 uses specifications designed to produce quality
separations using U.S. inks under the following printing conditions: 300% total
area of ink coverage, negative plate, coated publication-grade stock
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● U.S. Web Uncoated 2 uses specifications designed to produce quality
separations using U.S. inks under the following printing conditions: 260% total
area of ink coverage, negative plate, uncoated white offset stock

● Euroscale Coated 2 uses specifications designed to produce quality separations
using Euroscale inks under the following printing conditions: 350% total area of
ink coverage, positive plate, bright white coated stock

● Euroscale Uncoated 2 uses specifications designed to produce quality
separations using Euroscale inks under the following printing conditions: 260%
total area of ink coverage, positive plate, uncoated white offset stock

● JMPA: Japanese standard for offset press
● Photoshop 4 Default CMYK
● Photoshop 5 Default CMYK
● Other HP Designjet printers can be emulated

In the front panel and the Embedded Web Server, some further options are available:
● Japan Color 2001 Coated uses the Japan Color 2001 specification for type 3

(coated) paper. It is designed to produce quality separations using 350% total ink
coverage, positive film, and coated paper

● Japan Color 2001 Uncoated uses the Japan Color 2001 specification for type 4
(uncoated) paper. It is designed to produce quality separations using 310% total
ink coverage, positive film, and uncoated paper

● Japan Web Coated (Ad) uses specifications developed by the Japan Magazine
Publisher Association for digital proofing of images in the Japanese magazine/
advertising market

● Toyo is designed to produce quality separations for Toyo printing presses
● DIC is designed to produce quality separations for Dainippon Ink Company

printing presses

Note These options have no effect if the application is defining its own CMYK
space, known as calibrated CMYK or CIEBasedDEFG in PostScript
terminology.

RGB color emulation
These options apply to PDF, PostScript, TIFF, and JPEG files. For HP-GL/2 and RTL
files, only sRGB and AdobeRGB are supported.

If you want to print an RGB image, it must be converted to CMYK data (although you
may be able to do it in the application or operating system). To perform this
conversion, your printer is provided with the following color profiles:

● None (Native): no emulation. The printer will use its default internal conversion
from RGB to CMYK, without following any color standard. This does not imply
that results will be bad.

● sRGB IEC61966-2.1 emulates the characteristics of the average PC monitor.
This standard space is endorsed by many hardware and software manufacturers,
and is becoming the default color space for many scanners, printers, and
software applications.

● ColorMatch RGB emulates the native color space of Radius Pressview monitors.
This space provides a smaller gamut alternative to Adobe RGB (1998) for print
production work.
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● Apple RGB emulates the characteristics of the average Apple monitor, and is
used by a variety of desktop publishing applications. Use this space for files that
you plan to display on Apple monitors, or for working with old desktop publishing
files.

● Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if
you need to do print production work with a broad range of colors.

Tell me about connecting the printer  
Your printer comes with a 100base-TX network interface (Fast Ethernet) for network
connections, and a FireWire interface for direct connection to your computer.

A USB 2.0 interface, 1000base-T (Gigabit Ethernet) network interface, or Jetdirect
print server may be installed as optional accessories.

If you are not sure which interface to use, see How do I choose which connection
method to use?.

To find the sockets for these interfaces on your printer, see How do I connect the
printer?.

To set up your operating system to use the printer, see one of the following:
● How do I connect my printer to a network (Windows)?
● How do I connect my printer to a network (Mac OS X)?
● How do I connect my printer to a network (Mac OS 9)?
● How do I connect my printer directly to a computer (Windows)?
● How do I connect my printer directly to a computer (Mac OS X)?
● How do I connect my printer directly to a computer (Mac OS 9)?
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Tell me about the printer's rear lights 
At the rear of the printer, above the power switch, are three small lights:

● The amber light on the left is on when the printer is in sleep mode.
● The blue light in the center is on when the printer is on (when it has electrical

power).
● The green light on the right is on when the printer is printing.

Note You should never see all three lights on at the same time, because the
printer cannot print in sleep mode.

Tell me about the printer's internal prints
The internal prints give various kinds of information about your printer. They can be
requested from the front panel without using a computer.

Before requesting any internal print, make sure that paper is loaded (roll or sheet),
and that the front panel displays the Ready message.

To print any internal print, select the  icon, then Information > Internal prints,
then select whichever internal print you want.

The following internal prints are available:
● Demo: shows some of the capabilities of the printer.
● Menu map: shows details of all the front panel menus.
● Configuration: shows all the current front panel settings.
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● Usage report: shows estimates of the total number of prints, number of prints by
paper type, number of prints by print quality option, and total amount of ink used
per color.

● HP-GL/2 palette: shows the color or grayscale definitions in the currently-selected
color palette.

● PostScript font list: lists the PostScript fonts installed in the printer (PostScript
printers only).

● Image diaqnostics: helps you to solve print quality problems. See How do I use
the Image Diagnostics Print?.

● Service information: provides information needed by service engineers.

Tell me about preventive maintenance 
During the life of your printer, components that are used constantly can wear out with
time and use.

To avoid these components being so worn that the printer breaks down, the printer
keeps track of the number of cycles the printer carriage makes across the axis of the
printer and on the total quantity of ink printed.

The printer uses this number to advise you of the need for preventive maintenance,
displaying one of the following messages on the front panel:

● Maintenance #1 required
● Maintenance #2 required

These messages mean that some components are nearing the end of their lives. You
can continue printing for quite some time, depending on your use of the printer.
However it is strongly recommended that you contact your customer service
representative and arrange for a preventive maintenance on-site visit. The service
engineer can then replace the worn parts, which will prolong the life of the printer for a
further period.

The benefits of arranging a service engineer's visit when the front panel displays
these messages are two-fold:

● The printer components can be replaced at a time that is convenient for you and
so will not disturb your daily workflow.

● When the service engineer performs a preventive maintenance visit he will
replace several parts at once. This will avoid the need for repeat visits.
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19 Tell me about the Embedded
Web Server   
The Embedded Web Server is the control center for remote management of your
printer. From any computer, you can use an ordinary Web browser to contact your
printer's Embedded Web Server (see How do I access the Embedded Web Server?).

With the Embedded Web Server, you can:

● Submit jobs to the printer in various file formats (HP-GL/2, HP-RTL, PostScript,
PDF, JPEG, TIFF, CALS G4) without the need of a driver nor an application: see
How do I submit a job?.

Note PostScript and PDF formats can be used with PostScript printers
only.

● Control and manage all aspects of your print jobs: see How do I manage the print
queue?.

● View the status of the ink cartridges, the printheads, the printhead cleaners, and
the paper: see How do I check the status of the ink system?.

● View statistics on ink and paper usage: see How do I check printer usage
statistics?.

● Request e-mail notification when specified warning or error conditions occur
(such as low ink level): see How do I request e-mail notification of specific error
conditions?.

● Update the printer's firmware: see How do I update my printer's firmware?.
● Change various printer settings (on the Device Setup page)
● Set a password to restrict Web access to the printer: see How do I password–

protect the Embedded Web Server?.
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20 Tell me about the ink system
● Tell me about ink cartridges
● Tell me about printheads
● Tell me about printhead cleaners
● Tell me about ink system tips

Tell me about ink cartridges  
The printer's four ink cartridges provide yellow, magenta, black, and cyan ink to the
printheads. The color cartridges supplied with the printer have a capacity of 225 cm³,
and the black cartridge has a capacity of 400 cm³. It is also possible to buy and use
color cartridges with a capacity of 400 cm³.

Note All these cartridges are physically the same size: only the internal
capacity varies.

Ink cartridges require no maintenance or cleaning. As long as each ink cartridge is
inserted correctly into its slot, the ink will flow to the printheads. Because the
printheads control the amount of ink transferred to the page, you will continue to see
high-quality printing results even when the ink levels are getting low.

Replacing ink cartridges      

You can highlight the  icon at any time to check the ink levels of all the ink
cartridges (as illustrated below).
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The front panel warns you when a cartridge's ink level is low. When a cartridge is
empty, the printer stops printing and the front panel explains why:

You are recommended to replace the empty cartridge with a new HP cartridge: see
How do I remove an ink cartridge? and How do I insert an ink cartridge?.

Although it is possible to use refilled or non-HP ink cartridges, either choice has
several serious disadvantages:

● There is some risk of damaging the printer. In this case the printer warranty will
not be valid for any printer repairs that are related to the cartridge, nor for any
problems due to ink contamination.

● You will invalidate the warranty of all printheads of the same color used in the
printer subsequently, unless and until the whole ink system (including ink tubes)
is replaced.

● Print quality may be impaired.
● The printer will be unable to estimate the ink level in the cartridge, and will report

it as empty.

If you decide to use refilled or non-HP ink cartridges, you will need to follow these
instructions to make the printer use a cartridge that it believes to be empty.

1. Install the cartridge in the printer (see How do I insert an ink cartridge?).
2. The front panel will complain that the cartridge is empty, and the cartridge

removal process will start. Press the Cancel key to stop this automatic process.
3. At the front panel, select the  icon, then Ink cartridges.
4. Highlight Replace ink cartridges now, but do not select it.
5. Press the Cancel key and the Up key at the same time, and hold them down for

at least two seconds.
6. The front panel will display a series of warning messages. In response to each

message, press the Cancel key to cancel the process, or the Select key to
confirm that you wish to continue.

When you have pressed Select in response to all warning messages, the front panel
will give the usual ink cartridge status display, but the refilled or non-HP cartridge will
be shown as empty with a warning sign.
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Tell me about printheads 
In order to increase printing speed, two printheads are connected to each ink
cartridge, giving eight printheads in total.

The printheads are extremely durable and do not need to be replaced every time an
ink cartridge is replaced. They will continue giving excellent results even if the ink
cartridges are low in ink.

To maintain optimum print quality, the printheads are automatically tested at regular
intervals, and automatically serviced if necessary. This takes a little time and will
occasionally delay printing.

When a printhead eventually needs to be replaced, the front panel identifies the
printhead with a cross in place of the printhead number:

Caution Whenever you buy a new printhead, you get a new printhead
cleaner with it. When you replace a printhead, always replace the printhead
cleaner at the same time. Leaving the old printhead cleaner in the printer will
shorten the new printhead's life and possibly damage the printer.
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Tell me about printhead cleaners  
Each printhead has its own printhead cleaner, so there are eight printhead cleaners in
the printer. Printhead cleaners are used to clean and maintain the printheads, to
ensure the best possible print quality, and to seal the printheads when they are not in
use to prevent them from drying out.

Caution Whenever you buy a new printhead, you get a new printhead
cleaner with it. When you replace a printhead, always replace the printhead
cleaner at the same time. Leaving the old printhead cleaner in the printer will
shorten the new printhead's life and possibly damage the printer.

Tell me about ink system tips
For best results, always follow these guidelines:

● Install the ink cartridges, printheads, and printhead cleaners before the install-by
date, which is printed on the packaging.

● Install a new printhead cleaner every time you install a new printhead.
● Follow the instructions on the front panel during installation.
● Allow the printer and printhead cleaners to clean the printheads automatically.
● Avoid unnecessary removal of the ink cartridges and printheads.
● The ink cartridges should never be removed while the printer is printing. They

should be removed only when the printer is ready for you to replace them. The
front panel will guide you through the removal and installation procedures (or see
How do I remove an ink cartridge? and How do I insert an ink cartridge?).
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21 Tell me about paper
● Tell me about using paper
● Tell me about drying time

Tell me about using paper 
Choosing the correct paper type for your needs is an essential step in ensuring good
print quality. For best printing results, use only recommended papers (see How do I
select supported paper types?), whose reliability and performance have been
developed and thoroughly tested. All printing components (printer, ink system, and
paper) have been designed to work together to give trouble-free performance and
optimal print quality.

Here are some further tips about paper usage:

● Always keep unused rolls wrapped in the plastic wrap to prevent discoloration.
Rewrap partially used rolls if they are not being used.

● Do not stack rolls.
● Allow all paper types to adapt to room conditions out of the packaging for 24

hours before printing.
● Handle film and glossy paper by the edges or wear cotton gloves. Skin oils can

be transferred to the printing material, leaving fingerprint marks.
● Keep the paper tightly wound on the roll throughout the loading and unloading

procedures. If it starts to unwind, it can become difficult to handle.
● Whenever you load a roll or a sheet, the front panel prompts you to specify the

paper type you are loading. For good print quality, it is essential to specify this
correctly. If paper is already loaded, you can check the paper type at the front
panel by highlighting the  or  icon.

● The quality of some images may be reduced if you use a paper type that is
unsuitable for your image.

● If you load a paper type described on the front panel as Super Heavy Coated
Paper (note: currently there are no recommended papers of this type), you
should turn off the cutter to avoid cutter failure. To do this, select the  icon,
then Paper handling options > Cutter > Off.
Whenever you decide to stop using Super Heavy Coated Paper and load a
different paper type, remember to turn the cutter back on.

● Make sure the appropriate print quality setting (Fast, Normal, or Best) is selected.
You can set the print quality from the driver, from the Embedded Web Server, or
from the front panel. Driver or Embedded Web Server settings override front
panel settings. The combination of paper type and print quality settings tells the
printer how to place the ink on the paper—for example, the ink density, halftoning
method, and number of passes of the printheads. See How do I choose print
quality settings?.

● Although the ink systems supplied with this printer have good light-fastness,
colors will eventually fade or change if exposed to sunlight over a long period of
time.
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Tell me about drying time  
With some printing materials and environmental conditions the ink needs some time to
dry before the printing material is unloaded. The following settings are available.

● Optimal: the printer automatically determines the appropriate drying time, based
on the printing material you have selected and the current temperature and
humidity. If any drying time is required, a “drying time to go” countdown will be
displayed on the front panel.

● Extended: the default drying time is extended. This can be used if you find that
the default drying time is not enough to dry the ink sufficiently in your environment.

● Reduced: the default drying time is reduced. This can be used if you are keen to
get prints as fast as possible, and you find that the reduced drying time causes no
significant problem in your environment.

● None: no drying time is provided. This can be used, for example, if you are
manually removing the prints as fast as the printer is producing them.

To change the drying time, see How do I change the drying time?.
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22 Tell me about printer
specifications
● Tell me about functional specifications
● Tell me about physical specifications
● Tell me about memory specifications
● Tell me about power specifications
● Tell me about ecological specifications
● Tell me about environmental specifications
● Tell me about acoustic specifications

Tell me about functional specifications

HP No. 90 ink supplies         
Printheads Yellow, magenta, black, and cyan (two of each)

Printhead cleaners Yellow, magenta, black, and cyan (two of each)

Ink cartridges Yellow, magenta, and cyan cartridges containing 225
or 400 cm³ of ink, and a black cartridge containing 400
cm³ of ink

Paper sizes  
Minimum Maximum

Width 11 in (279 mm) 42 in (1.066 m)

Length 16.5 in (420 mm) 60 in (1.5 m) for sheet and
300 ft (90 m) for roll
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Print resolution     
Print
quality

Max
detail

Optimized for lines and text Optimized for images

Rendering
resolution
(dpi)

Printing
resolution (dpi)

Rendering
resolution
(dpi)

Printing
resolution (dpi)

Best On 1200×1200 2400×1200
(High-Gloss
Photo Paper,
Canvas)

1200×1200
(other papers)

1200×1200 2400×1200
(Productivity
Photo Gloss,
High-Gloss
Photo Paper,
Canvas)
1200×1200
(other papers)

Off 600×600 1200×1200
(High-Gloss
Photo Paper,
Canvas)

1200×600 (other
papers)

600×600 1200×1200 (High-
Gloss Photo
Paper, Canvas)

1200×600 (other
papers)

Normal On 600×600 1200×1200
(High-Gloss
Photo Paper,
Canvas)

1200×600 (other
paper types)

600×600 1200×1200 (High-
Gloss Photo
Paper, Canvas)
1200×600 (other
paper types)

Off 600×600 1200×1200
(High-Gloss
Photo Paper,
Canvas)

1200×600 (other
paper types)

300×300 1200×1200
(Productivity
Photo Gloss,
High-Gloss
Photo Paper,
Canvas)

1200×600 (other
paper types)

Fast On 600×600 1200×1200
(High-Gloss
Photo Paper)

1200×600 (other
paper types)

600×600 1200×1200 (High-
Gloss Photo
Paper)

600×600 (Max
Speed, Bright
White, Bond
Paper)

1200×600 (other
paper types)
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Print
quality

Max
detail

Optimized for lines and text Optimized for images

Rendering
resolution
(dpi)

Printing
resolution (dpi)

Rendering
resolution
(dpi)

Printing
resolution (dpi)

Off 300×300 1200×1200
(High-Gloss
Photo Paper)

600×600 (Max
Speed)

1200×600 (other
paper types)

300×300 1200×1200 (High-
Gloss Photo
Paper)

600×600 (Max
Speed, Bright
White, Bond
Paper)

1200×600 (other
paper types)

Margins    
Side margins 5 mm (normal)

15 mm (extended)

Top margin (leading edge) 11.5 mm (normal)

55 mm (extended)

Bottom margin (trailing edge) 5 mm (roll)

25 mm (sheet, normal)

55 mm (sheet, extended)

Mechanical accuracy  
±0.1% of the specified vector length or ±0.1 mm (whichever greater) at 23°C (73°F),
50-60% relative humidity, on A0 printing material in Best or Normal mode with HP
Matte Film.

Graphic languages supported  
HP Designjet 4000 and 4000ps Printers HP-GL/2, RTL, TIFF, JPEG, CALS G4

HP Designjet 4000ps Printer only Adobe PostScript level 3, PDF 1.5

Print resolution (continued)
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Tell me about physical specifications  

Weight (including stand) ≈ 115 kg

Width < 1930 mm

Depth < 800 mm

Height ≈ 1350 mm

Tell me about memory specifications      

Memory (DRAM) supplied 256 MB

Memory (DRAM) maximum 512 MB

Hard disk 40 GB

Tell me about power specifications  

Source 100-240 V ac ±10%, autoranging

Frequency 50–60 Hz

Current < 6 A

Consumption < 1 kW

Tell me about ecological specifications   
For the up-to-date ecological specifications of your printer, please go to
http://www.hp.com/ and search for “ecological specifications”.

Tell me about environmental specifications   

Relative humidity range for best print
quality

20 to 80%, depending on paper type

Temperature range for best print quality 15 to 35°C (59 to 95°F), depending on
paper type

Temperature range for printing 5 to 40°C (41 to 104°F)

Temperature range when not in operation -20 to +50°C (-4 to +122°F)

Maximum altitude when printing 3000 m
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Tell me about acoustic specifications  

Idle sound power ≤ 5.7 B (A)

Operating sound power ≤ 7.0 B (A)

Idle sound pressure ≤ 39 dB (A)

Operating sound pressure ≤ 53 dB (A)
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23 Tell me about ordering supplies
and accessories
● Tell me about ordering ink supplies
● Tell me about ordering paper
● Tell me about ordering accessories

Tell me about ordering ink supplies    
The following ink supplies can be ordered for your printer.

Ink cartridges
Cartridge Capacity (cm³) Part number

HP 90 Cyan 225 C5060A

HP 90 Magenta 225 C5062A

HP 90 Yellow 225 C5064A

HP 90 Black 400 C5058A

HP 90 Cyan 400 C5061A

HP 90 Magenta 400 C5063A

HP 90 Yellow 400 C5065A

Printheads and printhead cleaners         
Printhead & cleaner Part number

HP 90 Black C5054A

HP 90 Cyan C5055A

HP 90 Magenta C5056A

HP 90 Yellow C5057A

Tell me about ordering paper          
The following paper types are currently provided for use with your printer.

Note This list is likely to change over the course of time. For the latest
information, see http://www.hp.com/go/designjet.
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Premium Technical
Name g/m² 24 in wide 36 in

wide
42 in
wide

HP Bright White Inkjet Bond Paper 90 C1860A*

C6035A†

C1861A*

C6036A†

none

HP Bright White Inkjet Bond Paper
(long roll)

90 none C6810A none

HP Matte Film 163 51642A 51642B none

HP Clear Film 170 C3876A C3875A none

HP Natural Tracing Paper 90 C3869A C3868A none

HP Translucent Bond 67 C3860A C3859A none

HP Polyester Film Opaque White
Glossy

170 C7955A C7956A C7957A

HP Vellum 75 C3862A C3861A none

HP Coated Paper 91 C6019B C6020B C6559B*

C6567B†

HP Coated Paper (long roll) 91 none C6980A none

HP Heavyweight Coated Paper 133 C6029C C6030C C6569C

HP Heavyweight Coated Paper (long
roll)

130 none none Q1956A†

Premium Photographic
Name g/m² 24 in wide 36 in wide 42 in

wide

HP Productivity Photo Gloss 245 none Q1938A Q1939A

HP Productivity Photo Semi-Gloss 245 none Q1943A Q1944A

HP Photo Paper RC Matte 200 none C7946A none

HP Proofing Paper RC Satin 200 none C7952A none

Universal Line
Name g/m² 24 in

wide
36 in
wide

42 in
wide

HP Universal High-Gloss Photo Paper 179 Q1426A Q1427A Q1428A
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Name g/m² 24 in
wide

36 in
wide

42 in
wide

HP Universal Semi-Gloss Photo
Paper

179 Q1420A Q1421A Q1422A

HP Universal Inkjet Bond Paper 80 Q1396A† Q1397A† Q1398A†

HP Universal Coated Paper 95 Q1404A† Q1405A† Q1406A†

HP Universal Heavyweight Coated
Paper

120 Q1412A† Q1413A† Q1414A†

HP Super Heavyweight Coated Paper 160 C7929A* C7930A* C7931A*

Display Graphics
Name g/m² 24 in

wide
36 in
wide

42 in
wide

HP Banners with Tyvek 140 none C6787A none

HP Colorfast Adhesive Vinyl 328 none C6775A none

HP Backlit Film Reverse Print Matte 160 none C7960A none

HP Studio Canvas 368 none C6771A none

HP Outdoor Billboard Paper Blue
Back

140 none C7949A none

Graphics Arts/Indoor/Fine Art
Name g/m² 24 in

wide
36 in
wide

42 in
wide

HP Canvas Matte 340 C7966A C7967A C7968A

HP Outdoor Paper 145 none Q1730A none

HP Canvas Paper 140 gsm 140 none Q1718A none

HP Canvas Paper 180 gsm 180 none Q1724A none

HP Fine Art Paper Aquarella 240 none Q1703A none

HP Fine Art Paper Cream 140 none Q1709A none

HP Fine Art Paper Sahara 140 none Q1715A none

HP Indoor Paper Self-Adhesive 170 none Q1733A none

* available only in North and South America

† available only in Europe, the Middle East, and Africa

Universal Line (continued)
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Tell me about ordering accessories    
The following accessories can be ordered for your printer.

Name Product number

HP Jetdirect 40d Gigabit Print Server for the Designjet 4000
Printer series (provides the highest capacity network
connection to your printer)

Q5679A

HP Designjet 4000 Printer series High Speed USB 2.0 Card
(provides a high speed direct connection to your printer)

Q5680A

HP Jetdirect 620n Fast Ethernet print server J7934A

HP Designjet 4000 Printer series 256 MB Memory Upgrade (to
increase the memory capacity of your printer to work with
complex files)

Q5673A

HP Designjet Roll Feed Spindle 42” (spare spindles ease the
process of switching between different types of roll paper)

Q5675A
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24 Tell me about getting help
● Tell me about HP Instant Support
● Tell me about HP Customer Care
● Tell me about HP Designjet Online
● Tell me about other sources of information

Tell me about HP Instant Support   
HP Instant Support is HP's suite of troubleshooting tools that collect diagnostic
information from your printer and match it with intelligent solutions from HP's
knowledge bases, allowing you to resolve problems as quickly as possible.

You can start an HP Instant Support session by clicking on the link provided by your
printer's Embedded Web Server. See How do I access the Embedded Web Server?.

To be able to use HP Instant Support:

● You must have a TCP/IP connection to your printer, because HP Instant Support
is accessible only through the Embedded Web Server.

● You must have access to the World Wide Web, because HP Instant Support is a
Web–based service.

HP Instant Support is currently available in English, Korean, Simplified Chinese, and
Traditional Chinese.

Tell me about HP Customer Care   
As your strategic support partner, we make it our business to help keep your business
running smoothly. HP Customer Care offers award-winning support to ensure you get
the most from your HP Designjet.

HP Customer Care provides comprehensive, proven support expertise and leverages
new technologies to give customers unique end-to-end support. Services include
setup and installation, troubleshooting tools, warranty upgrades, repair and exchange
services, phone and Web support, software updates, and self-maintenance services.
To find out more about HP Customer Care, please visit us at:

http://www.hp.com/go/designjet/

or call the phone number in the Customer Service Guide provided with your printer.

What to do before you call:

● Review the “The problem is” troubleshooting suggestions in this guide.
● Review the relevant driver documentation supplied with this printer (for users

sending PostScript files or those using Microsoft Windows).
● If you have installed third-party software drivers and RIPs, refer to their

documentation.
● If the problem appears to be related to your software application, first contact

your software vendor.

249

Tell m
e about getting help

http://www.hp.com/go/designjet/


● If you still have difficulty, refer to the HP Support Services booklet provided with
your printer. This document contains a comprehensive list of various support
services available to help solve printer problems.

● If you call one of the Hewlett-Packard offices, please have the following
information available to help us answer your questions more quickly:
– The printer you are using (the product number and the serial number, found

on the label at the back of the printer)
– The printer's Service ID: select the  icon, and then Information > Show

printer information > Service ID
– If there is an error code on the front panel, note it down; see “Status codes

and error messages”
– The computer you are using
– Any special equipment or software you are using (for example, spoolers,

networks, switch-boxes, modems, or special software drivers)
– The cable you are using (by part number) and where you purchased it
– The type of interface used on your printer (FireWire, USB, or network)
– The software name and version you are currently using
– If the problem is a system error it will have a error number; record the error

number and have it ready
– If possible, print out the following reports; you may be asked to fax them to

the support center helping you: Configuration, Usage Report, and “all pages
above” from Service Information (see Tell me about the printer's internal prints)

Tell me about HP Designjet Online   
Enjoy a world of dedicated services and resources to ensure you always get the best
performance from your HP Designjet products and solutions.

Register at HP Designjet Online, your large-format printing community at
http://www.hp.com/go/designjet/ for unrestricted access to:

● Downloads — the latest printer firmware, drivers, software, media profiles, etc.
● Technical support — online troubleshooting, customer care contacts, and more
● Forums for direct contact with the experts, both HP and your colleagues
● Warranty tracking online, for your peace of mind
● Technical documentation and training videos
● Latest product information — printers, supplies, accessories, software, etc.
● Supplies Center for all you need to know about ink and paper

By customizing your registration for the products you have purchased and your type of
business, and by setting your communication preferences: you decide the information
you need.
Register at HP Designjet Online for the best performance.

HP Designjet Online is available in English, German, French, Italian, Spanish,
Portuguese, Japanese, Korean, Simplified Chinese, and Traditional Chinese.
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Tell me about other sources of information
More information is available from the following sources:

● The Embedded Web Server provides information about your printer status,
technical support, on-line documentation, etc.—see Tell me about the Embedded
Web Server.

● The setup instructions that came with your printer
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25 Legal information
● Worldwide Limited Warranty—HP Designjet 4000 Printer series
● Hewlett-Packard Software License Agreement
● Open source acknowledgments
● Regulatory notices
● DECLARATION OF CONFORMITY

Worldwide Limited Warranty—HP Designjet 4000 Printer
series 

HP product Limited Warranty Period

Printer and related HP hardware 1 year (from the date of purchase by the
customer)

Software 90 days (from the date of purchase by
the customer)

Printhead Until the “end of warranty” date printed
on the product is reached, or 1000 cm³
of HP ink have been cycled through the
printhead, whichever occurs first

Ink cartridge Until the genuine HP ink is depleted as
indicated by the printer, or the “end of
warranty” date printed on the product is
reached, whichever occurs first

A. Extent of HP Limited Warranty
1. This Hewlett-Packard (HP) Limited Warranty gives you, the end-customer,

express limited warranty rights from HP, the manufacturer. In addition, you may
also have other legal rights under the applicable local law or special written
agreement with HP.

2. HP warrants to you that the HP products specified above will be free from defects
in materials and workmanship during the Limited Warranty Period specified
above. The Limited Warranty Period starts on the date of purchase. Your dated
sales or delivery receipt, showing the date of purchase of the product, is your
proof of purchase date. You may be required to provide proof of purchase as a
condition of receiving warranty service. You are entitled to warranty service
according to the terms and conditions of this document if a repair or replacement
of your HP Products is required within the Limited Warranty Period.

3. For software products, HP’s Limited Warranty applies only to a failure to execute
programming instructions. HP does not warrant that the operation of any product
will be uninterrupted or error free.

4. HP’s Limited Warranty covers only those defects that arise as a result of normal
use of the HP products, and does not apply to any:
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a. Improper or inadequate maintenance or modification;
b. Software, interfacing, media, parts, or supplies not provided or supported by

HP; or
c. Operation outside the product’s specifications.
Routine printer maintenance operations in the HP Designjet 4000 Printer series,
such as cleaning and preventive maintenance services (including parts contained
in any preventive maintenance kit and HP service engineer visits), are not
covered by HP’s Limited Warranty, but in some countries may be covered under
a separate support contract.

5. YOU SHOULD MAKE PERIODIC BACKUP COPIES OF THE DATA STORED
ON THE PRINTER'S HARD DISK OR OTHER STORAGE DEVICES AS A
PRECAUTION AGAINST POSSIBLE FAILURES, ALTERATION, OR LOSS OF
THE DATA. BEFORE RETURNING ANY UNIT FOR SERVICE, BE SURE TO
BACK UP DATA AND REMOVE ANY CONFIDENTIAL, PROPRIETARY, OR
PERSONAL INFORMATION. HP IS NOT RESPONSIBLE FOR DAMAGE TO OR
LOSS OF ANY FILES, STORED BY YOU ON THE PRINTER'S HARD DISK OR
OTHER STORAGE DEVICES. HP IS NOT RESPONSIBLE FOR THE
RECOVERY OF LOST FILES OR DATA.

6. For HP printer products, the use of a refilled or non-original HP consumable
product (ink, printhead or ink cartridge) does not affect either HP’s Limited
Warranty to you or any HP support contract with you. However, if printer failure or
damage is attributable to the use of a non-HP or refilled ink cartridge, HP will
charge its standard time and materials charges to service the printer for the
particular failure or damage.

7. Your exclusive remedies for defective HP products are the following:
a. During the Limited Warranty Period, HP will replace any defective HP

software, media, or consumable product which is covered by this Limited
Warranty, and deliver another product to you to replace the defective one.

b. During the Limited Warranty Period, HP, at its sole discretion, shall either
repair on site or replace any defective hardware product or component part.
If HP elects to replace any component part, HP will provide to you (i) a
replacement part, in return of the defective one, and (ii) remote part
installation assistance, if needed.

c. In the unlikely event that HP is unable to repair or replace, as applicable, a
defective product which is covered by this Limited Warranty, HP shall, within
a reasonable time after being notified of the defect, refund the purchase price
for the product.

8. HP shall have no obligation to replace or refund until you return the defective
product or component part to HP. All components, parts, or hardware products
removed under this Limited Warranty become the property of HP.
Notwithstanding the above mentioned, HP may waive the requirement for you to
return the defective part.

9. Unless otherwise stated, and to the extent permitted by local law, HP products
may be manufactured using new materials or new and used materials equivalent
to new in performance and reliability. HP may repair or replace products (i) with
equivalent products to the products being repaired or replaced but which may
have been subject to prior use; or (ii) with an equivalent product to an original
product that has been discontinued.
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10. THIS LIMITED WARRANTY IS APPLICABLE IN ALL COUNTRIES AND MAY BE
ENFORCED IN ANY COUNTRY WHERE HP OR ITS AUTHORIZED SERVICE
PROVIDERS OFFER WARRANTY SERVICE AND HP HAS MARKETED THIS
PRODUCT, SUBJECT TO THE TERMS AND CONDITIONS SET FORTH IN
THIS LIMITED WARRANTY. HOWEVER, WARRANTY SERVICE AVAILABILITY
AND RESPONSE TIME MAY VARY FROM COUNTRY TO COUNTRY. HP WILL
NOT ALTER FORM, FIT, OR FUNCTION OF THE PRODUCT TO MAKE IT
OPERATE IN A COUNTRY FOR WHICH IT WAS NEVER INTENDED TO
FUNCTION FOR LEGAL OR REGULATORY REASONS.

11. Contracts for additional services may be available for any authorized HP service
facility where the listed HP product is distributed by HP or an authorized importer.

12. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT AS EXPRESSLY SET
FORTH IN THIS LIMITED WARRANTY NEITHER HP NOR ITS THIRD PARTY
SUPPLIERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND,
WHETHER EXPRESS OR IMPLIED, WITH RESPECT TO THE HP PRODUCTS,
AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR
CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND
FITNESS FOR A PARTICULAR PURPOSE.

B. Limitations of liability
TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS
SPECIFICALLY SET FORTH IN THIS LIMITED WARRANTY, IN NO EVENT SHALL
HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR DIRECT, INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING ANY
LOSS OF PROFITS OR SAVINGS), WHETHER BASED ON CONTRACT, TORT, OR
ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES.

C. Local law
1. This Limited Warranty gives you specific legal rights. You may also have other

rights which vary from state to state in the United States, from province to
province in Canada, and from country to country elsewhere in the world. You are
advised to consult applicable state, province, or national laws for full
determination of your rights.

2. To the extent that this Warranty Statement is inconsistent with local law, this
Warranty Statement shall be deemed modified to be consistent with such local
law. THE WARRANTY TERMS CONTAINED IN THIS LIMITED WARRANTY,
EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE,
RESTRICT, OR MODIFY AND ARE IN ADDITION TO THE MANDATORY
STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO
YOU.

Revision: August 1st, 2004
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Hewlett-Packard Software License Agreement
ATTENTION: USE OF THE SOFTWARE IS SUBJECT TO THE HP SOFTWARE
LICENSE TERMS SET FORTH BELOW. USING THE SOFTWARE INDICATES
YOUR ACCEPTANCE OF THESE LICENSE TERMS. IF YOU DO NOT ACCEPT
THESE LICENSE TERMS, YOU MUST RETURN THE SOFTWARE FOR A FULL
REFUND. IF THE SOFTWARE IS SUPPLIED WITH ANOTHER PRODUCT, YOU
MAY RETURN THE ENTIRE UNUSED PRODUCT FOR A FULL REFUND.

HP SOFTWARE LICENSE TERMS
The following terms govern your use for the software of your HP Designjet 4000
Printer series unless you have a separate agreement with HP.

Definitions. HP Designjet 4000 Printer series software includes HP software product
(“the Software”) and Open Source Software components.

“Open Source Software” means various open source software components including,
but not limited to, Apache, Tomcat, MySQL, and omniORB, licensed under terms of
applicable open source license agreements included in the materials relating to such
software (please see “Open Source Software” section below).

License Grant. HP grants you a license to Use one copy of the Software pre-installed
in the HP Designjet 4000 Printer series. "Use" means storing, loading, executing or
displaying the Software. You may not modify the Software or disable any licensing or
control features of the Software.

Ownership. The Software is owned and copyrighted by HP or its third party suppliers.
Your license confers no title to, or ownership in, the Software and is not a sale of any
rights in the Software. HP's third party suppliers may protect their rights in the event of
any violation of these License Terms.

Copies and Adaptations. You may only make copies or adaptations of the Software
for archival purposes or when copying or adaptation is an essential step in the
authorized Use of the Software. You must reproduce all copyright notices in the
original Software on all copies or adaptations. You may not copy the Software onto
any public network.

No Disassembly or Decryption. You may not disassemble or decompile the
Software unless HP's prior written consent is obtained. In some jurisdictions, HP's
consent may not be required for limited disassembly or decompilation. Upon request,
you will provide HP with reasonably detailed information regarding any disassembly or
decompilation. You may not decrypt the Software unless decryption is a necessary
part of the operation of the Software.

Transfer. Your license will automatically terminate upon any transfer of the Software.
Upon transfer, you must deliver the Software, including any copies and related
documentation, to the transferee. The transferee must accept these License Terms as
a condition to the transfer.

Termination. HP may terminate your license upon notice for failure to comply with
any of these License Terms. Upon termination, you must immediately destroy the
Software, together with all copies, adaptations and merged portions in any form.

Export Requirements. You may not export or re-export the Software or any copy or
adaptation in violation of any applicable laws or regulations.
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U.S. Government Restricted Rights. The Software and any accmpanying
documentation have been developed entirely at private expense. They are delivered
and licensed as "commercial computer software" as defined in DFARS 252.227-7013
(Oct 1988), DFARS 252.211-7015 (May 1991) or DFARS 252.227-7014 (Jun 1995),
as a "commercial item" as defined in FAR 2.101(a), or as "Restricted computer
software" as defined in FAR 52.227-19 (Jun 1987)(or any equivalent agency
regulation or contract clause), whichever is applicable. You have only those rights
provided for such Software and any accompanying documentation by the applicable
FAR or DFARS clause or the HP standard software agreement for the product
involved.

Open Source Software. The Open Source Software is composed of individual
software components, each of which has its own copyright and its own applicable
license conditions. You must review the licenses within the individual packages to
understand your rights under them. The licenses can be found in the folder called
licenses on the Using your printer CD that came with your printer. Copyrights to the
Open Source Software are held by the copyright holders.

Open source acknowledgments
● This product includes software developed by the Apache Software Foundation

(http://www.apache.org/).
● The source code, object code, and documentation in the com.oreilly.servlet

package is licensed by Hunter Digital Ventures, LLC.
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Regulatory notices
You can obtain current Material Safety Data Sheets for the ink systems used in the
printer by mailing a request to this address: Hewlett-Packard Customer Information
Center, 19310 Pruneridge Avenue, Dept. MSDS, Cupertino, CA 95014, U.S.A.

There is also a Web page: http://www.hp.com/hpinfo/community/environment/
productinfo/psis_inkjet.htm

Regulatory Model Number
For regulatory identification purposes, your product is assigned a Regulatory Model
Number. The Regulatory Model Number for your product is BCLAA-0401. This
regulatory number should not be confused with the marketing name (HP Designjet
4000 Printer series) nor with the product numbers (Q1273X, Q1274X, where X is any
single letter).

ELECTROMAGNETIC COMPATIBILITY (EMC)

Warning This is a class A product. In a domestic environment this product
may cause radio interference, in which case the user may be required to take
adequate measures.

FCC statements (U.S.A.)
The U.S. Federal Communications Commission (in 47 cfr15.105) has specified that
the following notices be brought to the attention of users of this product.

Shielded cables
Use of shielded data cables is required to comply with the Class A limits of Part 15 of
the FCC Rules.

Caution Pursuant to Part 15.21 of the FCC Rules, any changes or
modifications to this equipment not expressly approved by the Hewlett-
Packard Company may cause harmful interference and void the FCC
authorization to operate this equipment.

This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a commercial
environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference, in which case users will be
required to correct the interference at their own expense.

Normes de sécurité (Canada)
Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les
limites applicables aux appareils numériques de Classe A prescrites dans le
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réglement sur le brouillage radioélectrique édicté par le Ministére des
Communications du Canada.

DOC statement (Canada)
This digital apparatus does not exceed the Class A limits for radio noise emissions
from digital apparatus set out in the Radio Interference Regulations of the Canadian
Department of Communications.

Korean EMI statement

VCCI Class A (Japan)

Safety power cord warning

Taiwanese EMI statement
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Chinese EMI statement

Sound
Geräuschemission (Germany) LpA < 70 dB, am Arbeitsplatz, im Normalbetrieb, nach
DIN45635 T. 19.
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DECLARATION OF CONFORMITY
according to ISO/IEC Guide 22 and EN 45014

Supplier’s name: Hewlett-Packard Company

Supplier’s address: Avenida Graells, 501

08174 Sant Cugat del Vallès

Barcelona, Spain

declares that the product

Regulatory Model (3): BCLAA-0401

Product family: HP Designjet 4000 Printer series

Product options: All

conforms to the following product specifications

Safety: IEC 60950-1:2001 / EN 60950–1:2001

EMC: CISPR 22:1997 / EN 55022:1998 Class A (1)

EN 55024:1998 + A1

EN 61000-3-2:2000

EN 61000-3-3:1995 + A1:2001

FCC Title 47 CFR, Part 15 Class A (2)

Additional information
The product herewith complies with the requirements of the Low-Voltage Directive
73/23/EEC and the EMC Directive 89/336/EEC, and carries the CE marking
accordingly.

1. The product was tested in a typical configuration with HP Personal Computer
systems and peripherals.

2. This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions:
– This device may not cause harmful interference.
– This device must accept any interference received, including interference

that may cause undesired operation.
3. The product is assigned a Regulatory Model Number which stays with the

regulatory aspect of the design. The Regulatory Model Number is the main
product identifier in the regulatory documentation and test reports; this number
should not be confused with the marketing name or the product numbers.
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Josep–Maria Pujol
Hardware Quality Manager

Sant Cugat del Vallès (Barcelona)

July 9th, 2004

Local contacts for regulatory topics only
European contact: Hewlett-Packard GmbH, HQ-TRE, Herrenberger Strasse 140,
D-71034 Böblingen, Germany.

United States contact: Hewlett-Packard Company, Corporate Product Regulations
Manager, 3000 Hanover Street, Palo Alto, CA 94304, USA. Tel: (650) 857 1501.

Australian contact: Hewlett-Packard Australia Ltd, Product Regulations Manager,
31–41 Joseph Street, Blackburn, Victoria, 3130, Australia.
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Index

A
accessories

installing 58
ordering 248

acoustic specifications 243
altitude setting 78
ArcGIS 158
assembling the printer 13
AutoCAD 158

B
bin

stacking problems 213
black point compensation 140
blank page 203
blurred lines 197
buzzer on/off 77

C
calibration

color 139
CALS G4 137
cannot load paper 209
carriage lubrication 171
cleaning the platen 169
cleaning the printer 169
clipped image 204
color accuracy

between printers 199
in general 198
PANTONE 198

color calibration 139
color emulation mode

about 225
selecting 141

communication problems 220
components of printer 9
connecting the printer

choosing a method 63
hardware 56
Mac OS 9 direct 71
Mac OS 9 networking 68
Mac OS X direct 70
Mac OS X networking 66
overview 227
Windows direct 69

Windows networking 64
contrast in front panel 77
core adaptors 80
custom page size 127
Customer Care 249

D
Declaration of Conformity 261
Designjet Online 250
diagnostics 175
distorted print 205
downloading media profiles 96
drying time

canceling 96
changing 97
overview 238

E
e-mail alerts 77
ecological specifications 242
Embedded Web Server

accessing 75
canceling a job 164
cannot access 220
e-mail alerts 77
features 231
ink and paper usage 164
ink system status 124
language 76
password 76
printer usage statistics 125
printing a saved job 164
queue management 165
saving a job 164
submitting a job 163

environmental specifications
242
error messages 215
Ethernet connection 56

F
fast printing 132
features of printer 8
FireWire connection 56
firmware update 173
front panel

contrast 77
error messages 215
language 74
units 77

G
Gigabit Ethernet accessory

installing 58
graininess 193
graphic languages 241
guarantee 253

H
hard disk specification 242
HP Customer Care 249
HP Designjet Online 250
HP Instant Support 249
HP-GL/2 137

I
image diagnostics print 175
image problems

blank page 203
clipped image 204
distorted print 205
overlapping images 206
partial print 203
pen settings ineffective 206
small image 204
unexpected mirror image
205
unexpected rotation 205
unintelligible print 205

InDesign 151
ink cartridge

about 233
cannot insert 207
getting information 124
inserting 104
maintenance 172
non-HP 233
ordering 245
refilling 233
removing 99
specification 239

ink system status 124
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ink system tips 236
Instant Support 249
internal prints 228

J
Jetdirect print server

installing 60
JPEG 137

L
landscape orientation 133
language 74
lights at rear 228
loading a sheet 89
loading paper problems 209
loading roll into printer 83
loading roll onto spindle 79
lubricating the carriage 171
lubricating the platen rollers
222

M
maintenance 229
margins

changing 132
specification 241
zero width 133

maximum speed 132
mechanical accuracy 241
media profiles

downloading 96
memory error 221
memory error (AutoCAD) 221
Memory expansion accessory

installing 62
memory specifications 242
Microsoft Office 158
mirror image 134
mirror image unexpected 205
misaligned colors 196
moving the printer 172

N
nesting 167
non-HP ink cartridges 233
non-HP paper 96

O
ordering

accessories 248
ink cartridges 245
paper 245

printhead cleaners 245
printheads 245

orientation 133
out-of-memory error 221
overlapping images 206
overlapping lines 136
oversize page sizes 133

P
page size

custom 127
palette

changing settings 135
paper

cannot load 209
displaying information 95
non-HP 96
orientation 133
tips 237

paper jam 211
paper not flat 193
paper sizes (max & min) 239
paper types

front panel names 94
ordering 245
recommended 94
supported 94
weights 245
widths 245

partial print 203
PDF 137
pen settings ineffective 206
Photoshop

HP-GL/2 & RTL driver 141
PostScript driver 146

physical specifications 242
portrait orientation 133
PostScript 137
power specifications 242
preventive maintenance 229
print job

canceling 164
ink usage 164
nesting 167
paper usage 164
queue management 165
reprinting 164
saving 164
submitting 163

print quality
changing 129
choosing 130

print quality problems

banding 189
blurred lines 197
discontinuous lines 197
general 189
graininess 193
horizontal lines 189
ink bleeding 197
ink marks 194
misaligned colors 196
paper not flat 193
smudging 194
solid bands/lines 192
stepped lines 195
thin lines 190
top of print 195
warped lines 197

print resolution 240
printer does not print 218
printer driver

Mac OS 9 uninstall 72
Windows uninstall 72

printer software 12
printer's main components 9
printer's main features 8
printhead

about 235
aligning 119
cannot insert 207
cleaning 113
cleaning connections 113
getting information 125
inserting 110
monitoring 113
ordering 245
recovery 113
removing 106
reseat, reseat 207
specification 239

printhead cleaner
about 236
cannot insert 207
inserting 122
ordering 245
removing 120
specification 239

printheads are limiting
performance 218

Q
QuarkXPress 155
Quick Reference Guide
holder 29
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rear lights 228
recommended papers 94
refilling ink cartridges 233
regulatory notices 258
rendering intent 140
resolution 240
restarting the printer 74
roll paper

loading into the printer 83
loading onto the spindle 79
unloading 88

roller lubrication 222
rotating an image 134
rotation unexpected 205

S
scaling an image 134
sheet paper

loading 89
unloading 93

sleep mode wait time 77
slow printing 219
small image 204
smudging 194
software 12
software license 256
space required for the printer
14
specifications

acoustic 243
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environmental 242
graphic languages 241
hard disk 242
ink supplies 239
margins 241
mechanical accuracy 241
memory 242
paper size 239
physical 242
power 242
print resolution 240

squeaky rollers 222
stacking problems in bin 213
statistics

ink cartridge 124
printer usage 125
printhead 125

stepped lines 195
storing the printer 172
support services

HP Customer Care 249

HP Designjet Online 250
HP Instant Support 249

supported papers 94
switching the printer on/off 73
symbols on printer boxes 13

T
thin lines 190
TIFF 137
time to assemble the printer 13

U
unintelligible print 205
unloading a sheet 93
unloading roll from printer 88
unpacking the printer 14
USB 2.0 accessory

installing 59
using this guide 7
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waiting for time-out 219
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warranty note 125
warranty statement 253
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